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Chapter 1

spColumn is a software program for the design and investigation of reinforced concrete sections subject to
axial and flexural loads. The section can be rectangular, round or irregular, with any reinforcement layout or

Introduction

pattern. Slenderness effects can be considered.

The program offers investigation of irregularly shaped, reinforced concrete column sections that may contain
openings or boundary elements. Widely used for design of shear walls, bridge piers as well as typical framing
elements in buildings, spColumn can investigate sections that are impossible to find on design charts or do by
hand calculations. You can obtain the P-M interaction diagrams from both uniaxial and biaxial runs, as well
as the M,-M, moment contour plots from biaxial runs for even the most irregular column and shear wall

sections. Slenderness effects producing magnified moments may be included in the investigation.

Program Features

Code support for ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, ACI 318-02
Code support for CSA A23.3-14, CSA A23.3-04, and CSA A23.3-94

English and Sl units

Design and investigation run options

Uniaxial or biaxial flexure combined with axial load

Rectangular, circular, and irregular section geometry

Non-slender and sway or nonsway slender columns

Complete P-M and M,-M, interaction diagrams

Customizable view of interaction diagrams

Superposition of interaction diagram from a different run

Factored, unfactored, axial, and control points loading

Binary (COL) and text (CT]I) input file formats

Graphical input for irregular sections

Imports geometry, reinforcement, and loads from text files

Imports section shape and reinforcement from DXF files

Exports section shape and reinforcement to DXF files

Exports graphical reports (screen printouts) to EMF files

Exports P-M diagrams, M,-M, diagrams, and 3D failure surface to TXT and CSV files
GUI (Graphical User Interface) and batch mode (command prompt) runs

Reports neutral axis location and maximum steel strain corresponding to section capacity

Reports neutral axis location, net tensile steel strain, and strength reduction factors in text output
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Program Capacity

10,000 reinforcing bars within a section.
10,000 exterior points that define the geometric outline of the cross section (spSection module).
10,000 interior points that define an opening in the cross section (spSection module).

10,000 factored load entries, each consisting of an axial load, a moment about the x-axis, and a moment
about the y-axis.

50 service load entries, each consisting of dead, live, wind, earthquake, and snow axial loads, moments at
column top about the x and y axes, and moments at column bottom about the x and y axes.

50 load combinations.

System Requirements

Any computer running Microsoft Windows Vista SP2, Windows 7, Windows 8, or Windows 10 operating
system with 32 or 64 bit processing is sufficient to run the spColumn program. For instructions on how to
troubleshoot system specific installation and licensing issues, please refer to support pages on StructurePoint
website at www.StructurePoint.org.

Terms
The following terms are used throughout this manual. A brief explanation is given to help familiarize you
with them.
Windows refers to the Microsoft Windows environment as listed in System Requirements.
[ indicates metric equivalent
Click on means to position the cursor on top of a designated item or location and press and

release the left-mouse button (unless instructed to use the right-mouse button).

Double-click on  means to position the cursor on top of a designated item or location and press and
release the left-mouse button twice in quick succession.

Conventions
To help you locate and interpret information easily, the spColumn manual adheres to the following text
format.
Italic indicates a glossary item, or emphasizes a given word or phrase.
Bold indicates the name of a menu or a menu item command such as File or Save.
Mono-space indicates something you should enter with the keyboard. For example “c:\*.txt”.
KEY + KEY indicates a key combination. The plus sign indicates that you should press and hold the
first key while pressing the second key, then release both keys. For example, “ALT +
F” indicates that you should press the “ALT” key and hold it while you press the “F”
key. then release both keys.
SMALL CAPS Indicates the name of an object such as a dialog box or a dialog box component. For

example, the oPEN dialog box or the CANCEL or MODIFY buttons.

Introduction 1-2
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Chapter 2

Method of Solution

A - Definitions and Assumptions

1. The analysis of the reinforced concrete section performed by spColumn conforms to the provisions of the
Strength Design Method" and Unified Design Provisions? and is based on the following assumptions.
a) All conditions of strength satisfy the applicable conditions of equilibrium and strain compatibility®

b) Strain in the concrete and in the reinforcement is directly proportional to the distance from the
neutral axis®. In other words, plane sections normal to the axis of bending are assumed to remain
plane after bending.

¢) The maximum usable (ultimate) strain at the extreme concrete compression fiber is assumed equal to
0.003 for ACI codes® and 0.0035 for CSA codes® unless otherwise specified by the user

d) A uniform rectangular concrete stress block is used. For ACI code’, the maximum uniform concrete
compressive stress, f., is 0.85f; by default and the block depth is B,c, where c is the distance

from the extreme compression fiber to the neutral axis and B, is described in item 4 below. For
CSA®, f. is taken as:

f. =(0.85-0.0015f; )f; > 0.67f, , where f_ isin MPa
Both f. and 3, can be modified by the user.

e) Concrete displaced by the reinforcement in compression is deducted from the compression block®
f) For the reinforcing steel, the elastic-plastic stress-strain distribution is used'®. Stress in the
reinforcing steel below the yield strength, f, , is directly proportional to the strain. For strains greater

than that corresponding to the yield strength, the reinforcement stress remains constant and equal
tof, . Reinforcing steel yield strength must be within customary ranges.

g) Tensile strength of concrete in axial and flexural calculations is neglected™.
h) Reinforcement bars are located within section outline.

i) Irregular sections must be composed of a closed polygon without any intersecting sides.

j) Members with very large cross sectional area, multiple openings, and unusual geometry must be
carefully evaluated in light of above assumption for solution stability and reliability of results.

! For CSA A23.3-04 (Ref. [6]) and CSA A23.3-94 (Ref. [7])

2 For ACI 318-14 (Ref. [1]), ACI 318-11 (Ref. [1]), ACI 318-08 (Ref. [2]), ACI 318-05 (Ref. [3]) and ACI 318-02 (Ref. [4]); also see
notes on ACI 318-08, 8.1.2 in Ref. [9] and notes on ACI 318-11, 8.1.2 in Ref. [13]

8 ACI 318-14, 4.5.1, 22.2.1.1, 13.2.6.2; ACI 318-11, 10.2.1; ACI 318-08, 10.2.1; ACI 318-05, 10.2.1; ACI 318-02, 10.2.1; CSA A23.3-
14,10.1.1; CSA A23.3-04, 10.1.1; CSA A23.3-94, 10.1.1

* ACI 318-14, 22.1.2, 22.2.1.2; ACI 318-11, 10.2.2; ACI 318-08, 10.2.2; ACI 318-05, 10.2.2; ACI 318-02, 10.2.2; CSA A23.3-14,
10.1.2; CSA A23.3-04, 10.1.2; CSA A23.3-94,10.1.2

® ACI318-14,22.2.2.1; ACI 318-11, 10.2.3; ACI 318-08, 10.2.3; ACI 318-05, 10.2.3; ACI 318-02, 10.2.3

5 CSA A23.3-14, 10.1.3; CSA A23.3-04, 10.1.3; CSA A23.3-94, 10.1.3

" ACI1318-14, 22.2.2.3; ACI 318-11, 10.2.6; ACI 318-08, 10.2.6, 10.2.7; ACI 318-05, 10.2.6, 10.2.7; ACI 318-02, 10.2.6, 10.2.6

8 CSA A23.3-14, 10.1.1; CSA A23.3-04, 10.1.1; CSA A23.3-94, 10.1.1

® For consistency with Eq. 10-1 and 10-2 in ACI codes (Refs. [1], [3], [4]) and with Eq. 10-10 in CSA codes (Refs. [6], [7])

10 ACI 318-14, 20.2.2.1; ACI 318-11, 10.2.4; ACI 318-08, 10.2.4; ACI 318-05, 10.2.4; ACI 318-02, 10.2.4; CSA A23.3-14, 8.5.3.2; CSA
A23.3-04, 8.5.3.2; CSA A23.3-94,85.3.2

1 ACI 318-14, 22.2.2.2; ACI 318-11, 10.2.5; ACI 318-08, 10.2.5; ACI 318-05, 10.2.5; ACI 318-02, 10.2.5; CSA A23.3-14, 10.1.5; CSA
A23.3-04, 10.1.5; CSA A23.3-94, 10.1.5
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2. The modulus of elasticity of concrete, E., is computed as follows (unless otherwise specified by the
user):

E. =57,000,/f. , for the ACI code'” where f; and E, are in psi,
E. =4,700,/f , for the ACI code™ where . and E, are in MPa.
For the CSA standard™, E, =3,518,/f, +7,355, where f and E, are in MPa.

3. The modulus of elasticity of reinforcing steel®®, E, is taken as 29,000 ksi (200,000 MPa) unless

otherwise specified by the user. The computed compression controlled strain limit cannot exceed 0.005
and is reset to 0.002 for user input fy values in excess of 145 ksi.

yA

Y o!

i

N
=
~

<—— b —>
Section

Res, Ry
ﬁrcggaﬁt *

Figure 2-1 Analysis of Reinforced Section

4. The ratio of the concrete compression block depth to the distance between the extreme compression fiber
and the neutral axis, B, is computed as follows (unless otherwise specified by the user):

0.65< B, =1.05—-0.05f; <0.85, for the ACI code® where fe isin ksi,
0.65<p, = (149—f/)/140<0.85, for the ACI code’ where f_ is in MPa.
For the CSA standard™®, B, =0.97 —0.0025f, > 0.67, where f! is in MPa.

5. Stress in the reinforcement is computed based on the strain at the centroid of each reinforcing bar.

6. All moments are referenced to the geometric centroid of the gross concrete section (neglecting the
reinforcement).

12 ACI 318-14, 19.2.2.1; ACI 318-11, 8.5.1; ACI 318-08, 8.5.1; ACI 318-05, 8.5.1; ACI 318-02, 8.5.1

12 ACI 318M-14, 19.2.2.1; ACI 318M-11, 8.5.1; ACI 318M-08, 8.5.1; ACI 318M-05, 8.5.1; ACI 318M-02, 8.5.1

14 CSA A23.3-14, 8.6.2.2, Eq. 8.1, CSA A23.3-04, 8.6.2.2, Eq. 8.1 and CSA A23.3-94, 8.6.2.3, Eq. 8-6 (with y. = 2400 kg/m®)

15 ACI 318-14, 20.2.2.2; ACI 318-11, 8.5.2; ACI 318-08, 8.5.2; ACI 318-05, 8.5.2; ACI 318-02, 8.5.2; ACI 318M-05, 8.5.2; ACI 318M-
02, 8.5.2; CSA A23.3-14, 8.5.4.1; CSA A23.3-04, 8.5.4.1; CSA A23.3-94, 8.5.4.1

18 ACI 318-14, 22.2.2.4.3; ACI 318-11, 10.2.7.3; ACI 318-08, 10.2.7.3; ACI 318-05, 10.2.7.3; ACI 318-02, 10.2.7.3

7 ACI 318M-14, 22.2.2.4.3; ACI 318M-11, 10.2.7.3; ACI 318M-08, 10.2.7.3; ACI 318M-05, 10.2.7.3; ACI 318M-02, 10.2.7.3

18 CSA A23.3-14, 10.1.7(c); CSA A23.3-04, 10.1.7(c); CSA A23.3-94, 10.1.7(c)
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7. For the ACI codes, the nominal (unreduced) capacity of the section is first computed. Then, the nominal
capacity is reduced to the design capacity using the strength reduction factor, ¢, the value of which is

calculated based on the net tensile steel strain, ¢, , in the following way™:

0.75

For columns with spiral reinforcement per ACI 318-14, ACI 318-11, and ACI 318-08

0.9 if £, >0.005 (tension controlled section)
0.20 (e, —f, /E) N _
0.75+———————= if f,/E, <g, <0.005 (transition section)
0.005-f, /E,
0.75 if e <f,/E, (compression controlled section)

For columns with spiral reinforcement per ACI 318-05 and ACI 318-02

0.9 if &, >0.005 (tension controlled section)
0.20 (e, ~f, /E;) - _
0.70+————————= if f, /E, <g; <0.005 (transition section)
0.005-f, /E,
0.70 if & <f,/E, (compression controlled section)

For other columns per ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-02

0.9 if €, >0.005 (tension controlled section)
0.25 (e, —f, /E,) - _
0.65+———————= iff,/E, <g <0.005 (transition section)
0.005-f, /E,
0.65 if &, <f, /E, (compression controlled section)
p A
(I) Pmax
A (Mnxpn)
¢(Mn,Pn)
0.9 2 Prmax Compression
. -z 0.8P... controlled
or0.74 _S_pEa;l*_,"’ #Pmax
0.65 H(Mn,Pn)
Other Transition
e b T zone
& M
E 0.005 (I)(Mnypn)
s Tension
. ) ®Prmin controlled
Compression Transition zone Tension Prmin
controlled Controlled

Figure 2-2 Reduction factors for Flexural and Axial Capacity per ACI code
* Spiral sections in compression controlled zone: ¢=0.75 per ACI 318-14/11/08 and ¢=0.70 per ACI 318-05/02

9 ACI 318-14, 21.2; ACI 318-11, 9.3.2, 10.3.3, 10.3.4; ACI 318-08, 9.3.2, 10.3.3, 10.3.4; ACI 318-05, 9.3.2, 10.3.3, 10.3.4; ACI 318-02,
9.3.2,10.3.3,10.3.4
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Figure 2-2 illustrates variation of the strength reduction factor with net tensile strain in extreme tension
steel and the impact of the strength reduction factor on the axial and flexural capacity interaction
diagram. It is worth noting that in the transition between compression controlled and tension controlled
zones, the nominal axial capacity, P,, decreases whereas the value of net tensile strain increases and so
does the strength reduction factor, ¢. Consequently, the resulting factored axial capacity (i.e. the product
of nominal axial capacity and the strength reduction factor), ¢P,, may either increase or decrease in the
transition zone depending on the rates of axial force decrease and strength reduction increase for the
section under consideration. Typically, the rate of axial capacity decrease dominates over the rate of
strength reduction increase and thus the factor axial load capacity decreases as well.

For certain classes of sections (e.g. sections having a narrowing in the middle such as hollow core
section, T-shaped, L-shaped, and I-shaped sections), however, the reverse may be true resulting in the
factored axial load capacity increase in the transition zone between compression controlled and tension
controlled zones (see Figure 2-3). This unusual increase in axial load capacity is not illustrated by
interaction diagrams produced by the program and is not considered for design and investigation of
cross-sections. It will be flagged to inform the user, however, when the program is run using Control
Points as the load type.

Where unsymmetrical members (e.g. C-shaped or U-shaped sections) are investigated under biaxial
bending, the Mx-My contour diagram occasionally crosses the X or Y axes more than once. This
presents an unusual situation where a load point may exist outside of the Mx-My contour while
appearing within the P-Mx or P-My contour views. It is suggested the Mx-My contours be investigated
carefully for each factored axial load level.

For the CSA standards, the program calculates the factored resistance directly using the factored
compressive concrete strength”, ¢.f., and the factored forces in reinforcement bars®, ¢S, . The material

resistance factors are:
¢, = 0.60 for CSA A23.3-94

=0.65 for CSA A23.3-04/14 (cast-in-place)
=0.70 for CSA A23.3-04/14 (precast)
¢, = 0.90 for CSA A23.3-94/04/14

For all ACI and CSA A23.3-94/04 standards, the design axial capacity is capped® at 0.85 of the
maximum axial capacity for sections with spiral reinforcement or at 0.80 for sections with tie
reinforcement.

Additionally, for CSA A23.3-14 the design axial capacity is capped® at 0.90 of the maximum axial
capacity for sections with spiral reinforcement or at (0.2+0.002h) < 0.80 for sections with tie
reinforcement where h is the wall thickness or the minimum column dimension.

2 CSA A23.3-14, 8.4.2, 16.1.3; CSA A23.3-04, 8.4.2, 16.1.3; CSA A23.3-94, 8.4.2

21 CSA A23.3-14, 8.4.3; CSA A23.3-04, 8.4.3; CSA A23.3-94, 8.4.3

2 ACI 318-14, 22.4.2.1; ACI 318-11, 10.3.6; ACI 318-08, 10.3.6; ACI 318-05, 10.3.6; ACI 318-02, 10.3.6; CSA A23.3-14, 10.10.4;
CSA A23.3-04, 10.10.4; CSA A23.3-94, 10.10.4

% CSA A23.3-14,10.10.4
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fs=0 Balanced point

fs=0.5fy &=1/E
Typical decrease in
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Figure 2-3 Shapes of P-M interaction diagram in transition zone for ACI codes

8. In the investigation mode the program will calculate capacity for any provided area of reinforcement.
However, if the reinforcement area falls below the code-specified® minimum of 0.01 times the gross
area, A, then two options, Architectural or Structural, are available.

By default Architectural option is selected for which the capacity of the section is reduced. For the ACI
codes, the reduction results from multiplying the maximum concrete stress, f;, by the ratio of
reinforcement area to 0.01A,. This produces the same effect as reducing the effective concrete area® to
achieve ratio of reinforcement area to gross concrete area equal to 0.01. For the CSA standards®, the
factored axial and flexural resistances are multiplied by ratio O.5(1+ pt/0.0l) for the 04 edition and

p;/0.01 for the 94 edition.

For Structural option, the section is treated “as is” without any reductions in capacity. This option is
provided for informational purposes only, since per all codes supported by spColumn, capacity of
compression members with reinforcement area less than 0.01A4 has to be reduced and areas below
0.005A, are not allowed.

2 ACI 318-14, 10.6.1.1; ACI 318-11, 10.9.1; ACI 318-08, 10.9.1; ACI 318-05, 10.9.1; ACI 318-02, 10.9.1; CSA A23.3-14, 10.9.1; CSA
A23.3-04, 10.9.1; CSA A23.3-94, 10.9.1

% ACI 318-14, 10.3.1.2; ACI 318-11, 10.8.4; ACI 318-08, 10.8.4; ACI 318-05, 10.8.4; ACI 318-02, 10.8.4

% CSA A23.3-14, 10.10.5; CSA A23.3-04, 10.10.5; CSA A23.3-94, 10.10.5
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9. Under the Design option, the reinforcement ratio cannot be less than 1.0% if Structural column type is
selected in design criteria and 0.5% in case of Architectural column type. For Architectural type, the
capacity of the designed column is reduced as described above. Additionally, User Defined type is
provided in the design criteria, which allows designs with reinforcement ratios not less than 0.1%. No
reduction in capacity is applied for User Defined column type.

10. Maximum reinforcement ratio?’ for Structural and Architectural options in both Investigation and Design
modes is 8%. For User Defined type in the Design mode the maximum reinforcement ratio is set to 20%.

11. Reinforcement design strength for standard materials is limited to the value permitted for design
calculations®® by ACI to 80 ksi and CSA to 500 MPa.

B - Conventions

1. Positive axial forces are compressive and negative axial forces are tensile.

2. Looking in plan at the section with z-axis pointing outwards, the positive x-axis points to the right and
the positive y-axis points up. For this section, vectors of positive bending moments have the same
orientation as their corresponding axes x and y. Thus, a positive bending moment about the x-axis, My,
produces tension at the top face of the section and compression at the bottom face. A positive bending
moment about the y-axis, My, produces tension at the left face of the section and compression at the right

face.
z
y
2 A
! M y
W
<< < X
v Z
M, P
Top Bottom

Figure 2-4 Positive axial force and bending moments (internal forces)

3. If service loads are input, moment loads at the upper (top) and lower (bottom) ends of the column are
needed. Top and bottom moment loads of opposite signs produce single curvature bending. Top and
bottom moment loads of the same sign produce double curvature bending.

Positive moment loads at the upper end of the column coincide with positive bending moments.
However, at the lower end, positive moment loads produce effects opposite to positive bending moments.
Therefore spColumn changes the sign of the service moment at the lower end to convert it from a
moment load to a bending moment.

Axial load is assumed to be constant so it is input only as for the upper end where positive axial load
coincides with positive axial force.

4. |If factored loads are input, they are considered to be applied at a section pointing upwards so that they
have the same orientations as positive axial force and positive bending moments.

21 ACI 318-14, 10.6.1.1; ACI 318-11, 10.9.1; ACI 318-08, 10.9.1; ACI 318-05, 10.9.1; ACI 318-02, 10.9.1; CSA A23.3-14, 10.9.2; CSA
A23.3-04, 10.9.2; CSA A23.3-94, 10.9.2
%8 ACI 318-14, Table 20.2.2.4a; CSA A23.3-14,8.5.1
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Figure 2-5 Positive moment loads (external forces)

»» M,

5. The convention for the slenderness input of beam and column dimensions and their orientation is
presented in Figure 2-6. Beams above the columns are shown. Same convention applies to beam below
the column.

Left X-Beam

Left Right

/ :
Y-Beam

Right
y J

Figure 2-6 Slenderness Input Convention

Column

C - Section Investigation

1. The computations performed when investigating a section depend on the selected load mode:

a) Factored loads — for the axial load of each load point, the moment capacity and the ratio of design-
to-applied moment are computed. For a biaxial run, the computed M, and M, moment capacities are
at the same angle as that produced by the applied M, and M, moments. In uniaxial case the program
also reports the depth of neutral axis and maximum steel strain corresponding to the calculated
moment capacity. For the ACI code, the value of strength reduction factor is also reported.

spColumn allows defining up to 50 load combinations. The user has full control over the
combinations. The program contains predefined (built into the program) default primary load

Method of Solution 2-7



sfeolumn

combinations for the supported codes. These default combinations are created when starting a new
project. The default load combinations of the Dead (D), Live (L), Wind (W), Earthquake (E) and
Snow (S) loads considered by the program are shown below. For the ACI 318-14, 11, 08, 05, and 02

codes®:

Ul = 1.4D

U2 = 1.2D + 1.6L + 0.5S

U3 = 1.2D +1.0L + 1.6S

U4 = 1.2D + 0.8W + 1.6S

us = 1.2D +1.0L + 1.6W + 0.58
U6 = 0.9D + 1.6W

u7 = 1.2D - 0.8W + 1.6S

us = 1.2D +1.0L — 1.6W + 0.5S
U9 = 0.9D - 1.6W

u10 = 1.2D +1.0L +1.0E — 0.2S
U1l = 0.9D +1.0E

u12 = 1.2D +1.0L — 1.0E + 0.2S
u13 = 0.9D - 1.0E

For the CSA A23.3-94 code®:

Ul = 1.25D

u2 = 1.25D + 1.5L

U3 = 1.25D +1.5L +1.5S

U4 = 1.25D + 1.05L + 1.05W
us = 1.25D + 1.05L + 1.05W + 1.05S
U6 = 1.25D + 1.5W

u7 = 0.85D + 1.5W

us = 1.0D +1.0L + 1.0E

U9 = 1.0D +1.0L + 1.0E + 1.0S
u10 = 1.0D + 1.0E

U1l = 1.25D + 1.05L — 1.05W
u12 = 1.25D + 1.05L — 1.05W + 1.05S
u13 = 1.25D — 1.5W

u14 = 0.85D — 1.5W

u15 = 1.0D + 1.0L — 1.0E

U16 = 1.0D + 1.0L — 1.0E + 1.0S
u17 = 1.0D - 1.0E

For the CSA A23.3-04 code®:

U1l = 1.4D

u2 = 1.25D + 1.5L

u3 = 1.25D + 1.5L + 0.5S

U4 = 1.25D + 1.5L + 0.4W

us = 1.25D + 1.5L — 0.4W

U6 = 0.9D + 1.5L

u7 = 0.9D + 1.5L +0.5S

2 ACI 318-14,5.3; ACI 318-11, 9.2; ACI 318-08, 9.2; ACI 318-05, 9.2; ACI 318-02, 9.2; (assuming W based on service-level wind load
and E based on ultimate-level forces)

% CSA A23.3-94, 8.3.2 (conservatively assuming storage and assembly occupancies)

% CSA A23.3-14, 8.3.2; CSA A23.3-14, Annex C, Table C1; NBCC 2005 [8], Table 4.1.3.2.A; CSA A23.3-04, 8.3.2; CSA A23.3-04,
Annex C, Table C1; NBCC 2005 [8], Table 4.1.3.2
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us

U9

u10
U1l
uiz
ui3
u14
u15
ui6
u17
u1s8
u19
u20
uz21
u22
uz23
u24
u25
u26
u27
u28
u29
u30
U3l
u32
uU33

0.9D +1.5L + 0.4W

0.9D + 15L - 0.4W

1.25D +1.5S

1.25D +0.5L + 1.5S

1.25D + 0.4W + 1.5S
1.25D - 0.4W + 1.5S

0.9D + 1.5S8

0.9D +0.5L + 1.5S

0.9D + 0.4W + 1.5S

0.9D - 0.4W + 1.5S

1.25D + 1.4W

1.25D + 0.5L + 1.4W
1.25D + 1.4W + 0.5S
1.25D - 1.4W

1.25D +0.5L — 1.4W + 0.5S
1.25D - 1.4W + 0.5S

0.9D +0.5L +1.4W

0.9D +0.5L +1.4W

0.9D + 1.4W +0.5S

0.9D - 1.4W

0.9D +0.5L - 1.4W

0.9D - 1.4W + 0.5S

1.0D + 1.0E

1.0D + 0.5L + 1.0E + 0.25S
1.0D - 1.0E

1.0D + 0.5L - 1.0E + 0.25S

For the CSA A23.3-14 code®*:

Ul
U2
U3
U4
U5
u6
u7
us
U9
u10
U1l
Uiz
u13
u14
u15
ui6
u17
u1s8

1.4D

1.25D +1.5L

1.25D + 1.5L +1.0S
1.25D + 1.5L + 0.4W
1.25D + 1.5L — 0.4W
0.9D +1.5L

0.9D +15L +1.0S
0.9D + 15L + 0.4W
0.9D + 1.5L - 0.4W
1.25D + 1.5S8

1.25D +1.0L + 1.5S
1.25D + 0.4W + 1.5S
1.25D - 0.4W + 1.5S
0.9D + 1.5S

09D +10L+15S
0.9D + 0.4W + 155
0.9D - 0.4W + 1.55
1.25D + 1.4W

% CSA A23.3-14 Annex C, Table C1; NBCC 2010 [8], Table 4.1.3.2A; CSA A23.3-04, Annex C, Table C1; NBCC 2005 [8], Table

4132
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u19 = 1.25D + 0.5L + 1.4W

u20 = 1.25D + 1.4W + 0.5S

uz21 = 1.25D - 1.4W

u22 = 1.25D + 0.5L — 1.4W + 0.5S
u23 = 1.25D - 1.4W + 0.5S

u24 = 0.9D + 0.5L + 1.4W

u25 = 0.9D + 0.5L + 1.4W

u26 = 0.9D + 1.4W +0.5S

uz27 = 0.9D -1.4W

u28 = 0.9D + 0.5L - 1.4W

u29 = 0.9D - 1.4W + 0.5S

u30 = 1.0D + 1.0E

U3l = 1.0D +0.5L + 1.0E + 0.25S
u32 = 1.0D -1.0E

uU33 = 1.0D + 0.5L — 1.0E + 0.25S

b) Service loads — the program calculates the factored loads using the input load combinations. If
slenderness effects are to be checked and the column is found to be slender, the applied moments are
magnified according to Procedures E and F. For each calculated factored load, the same
computations described in (a) above are performed.

¢) Control points — for several key points on the interaction diagram, the program calculates axial load
and moment capacity together with the neutral axis depth and maximum steel strain corresponding to
the respective moment capacity. For ACI code, strength reduction factor is also reported. The
following key points are used by the program: maximum compression, allowable compression, point
where steel stress is zero, point where steel stress is 0.5f,, balanced point, pure flexure and

maximum tension. For ACI code, an additional control point is introduced where maximum steel
strain is equal to 0.005 (tension control limit).

d) Axial loads — for each input axial load, the program calculates the positive and negative moment
capacities together with the corresponding neutral axis depths and maximum steel strains. For ACI
code, strength reduction factors are also reported.

2. The program also computes the interaction diagram (uniaxial runs) or the three-dimensional failure
surface (biaxial runs) of the input section. The values of maximum compressive axial load capacity and
maximum tensile load capacity are computed. These two values set the range within which the moment
capacities are computed for a predetermined number of axial load values.

a) For uniaxial runs, positive and negative moment capacities about only the selected axis are
computed. Moment capacities about the orthogonal axis are ignored. To compute the moment
capacity at a certain level of axial load, the neutral axis angle is held constant, parallel to the selected
axis. The neutral axis depth is adjusted to arrive at the desired axial load capacity. This is done for
all the predetermined values of axial load.

b) For biaxial runs, the same predetermined values of axial load are utilized. For each level of axial
load, the section is rotated in 10-degree increments from O degrees to 360 degrees and the M, and M,
moment capacities are computed. Thus for each level of axial load, an M,-M, contour is developed.
Repeating this for the entire range of axial loads, the three-dimensional failure surface is computed.
A three-dimensional visualization of the resulting entire nominal and factored failure surface is
provided to support enhanced understanding of the section capacity.

Also for each point on the interaction diagram or on the three-dimensional failure surface, the program
calculates the location of the neutral axis (expressed in terms of depth and angle of the neutral axis),
maximum steel strain, and (for ACI codes only) the strength reduction factor. These results are reported
for the maximum capacity of the section based on the ultimate limit states and not for the given loading
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input. The information can however be used to draw conclusions or make additional calculations for a

given loading condition.
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(a) Moment slice at constant load P,
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(b) Half of P-M slice at constant angle A

Figure 2-7 Interaction Surface for Combined Axial Load and Biaxial Bending

D - Section Design

1. Based on the specified minimum, maximum and increment specified for the section and the reinforcing
bars, the program selects the smallest section with the least amount of reinforcement for which the load-
moment capacity exceeds the applied loads. If service loads are input, they are factored using the input
load combinations. Depending on the design criteria the user selects, the least amount of reinforcement
the program searches for means either the smallest number of bars or the smallest steel area.

2. The program starts the design by trying the smallest section (minimum dimensions) and the least amount
of reinforcing bars. The program verifies that the ratio of provided reinforcement is always within the
specified minimum and maximum ratios. Furthermore, unless otherwise specified by the user®®, the bar

* The user may select spacing greater than the default value to take into account tolerances for reinforcement placement (see ACI 117-

06, Ref [5]) and other project specific considerations.

Method of Solution
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spacing is always kept greater than or equal to the larger of 1.5 times the bar diameter or 1.5 in. [40 mm]
for ACI®* and 1.4 times the bar diameter or 1.2 in [30 mm] for CSA®.

3. A section fails the design if, for the design axial load, the ratio of design-to-applied moment is less than
1.0 (unless otherwise specified in the Design Criteria dialog box).

4. Once a section passes the design, its capacity is computed and the calculations explained in Procedure C
above are performed.

5. For members with large cross sectional area spColumn sometimes warns the user with the following
message “Cannot achieve desired accuracy”. This results when the program cannot meet the predefined
convergence criteria and the corresponding point on the interaction diagram may be slightly off. The
convergence criteria is more stringent than required in engineering practice, however, the shape of the
interaction diagram should be verified to be relatively smooth and free of unexpected discontinuity.

E - Moment Magnification at Ends of Compression Member

This procedure accounts for moment magnification due to second-order effects at ends of columns in sway

frames™.

1. If properties of framing members are input, spColumn computes the effective length factor, k,, for sway
condition using the following equation®’:

(Z/k v 4 tanﬁ—('/’“%jﬁ:o
36 6 Jk

S S

where v is the ratio of £(EI/¢,) of columns to =(EI/€) of beams in a plane at one end of the column,
v, and yg are the values of v at the upper end and the lower end of the column. For a hinged end, v
is very large. This happens in the case where Z(Elle) of beams is very small (or zero) relative to the
E(EI /Q)of columns at that end. In this case, the program outputs 999.9 for the value of y . The moment
of inertia used in computing vy is the gross moment of inertia multiplied by the cracked section
coefficients® (specified in the Slenderness Factors dialog box).

2. For the ACI code®, slenderness effects will be considered if k¢, /r>22.0. For the CSA standards, all
sway columns are designed for slenderness effects.

3. Iftheratio k¢, /r exceeds 100, slenderness effects cannot be accounted for using moment magnification

procedure®®. A more exact method must be used. In this case, the program issues a warning message and
aborts design or investigation procedure except for calculations per ACI 318-14, ACI 318-11, and ACI
318-08 where limit of k¢, /r <100 does not explicitly apply and the program continues calculations after

showing the warning message.

4. Factored moments, M ,, and M, due to dead, live, and snow loads assumed to cause no
appreciable sidesway*, are calculated at the top and bottom ends of the column.

% ACI1318-14, 25.2.3; ACI 318-11, 7.6.3; ACI 318-08, 7.6.3; ACI 318-05, 7.6.3; ACI 318-02, 7.6.3

% CSA A23.3-14, Annex A, 6.6.5.2; CSA A23.3-04, Annex A, 6.6.5.2; CSA A23.3-94, Annex A, A12.5.2

% ACI 318-14, 6.6.4.6.1; ACI 318-11, 10.10.7; ACI 318-08, 10.10.7; ACI 318-05, 10.13; ACI 318-02, 10.13; CSA A23.3-14, 10.16;
CSA A23.3-04, 10.16; CSA A23.3-94, 10.16

57 Exact formula derived in Ref. [12] pp. 851 for Jackson and Moreland alignment chart

*® ACI 318-14, 6.6.3.1.1, 6.6.4.2, 6.7.1.3, 6.8.1.4; ACI 318-11, 10.10.4.1; ACI 318-08, 10.10.4.1; ACI 318-05, 10.11.1, 10.13.1; ACI
318-02,10.11.1, 10.13.1; CSA A23.3-14, 10.14.1.2, 10.16.1; CSA A23.3-04, 10.14.1.2, 10.16.1; CSA A23.3-94, 10.14.1, 10.16.1

% ACI1318-14, 6.2.5; ACI 318-11, 10.10.1; ACI 318-08, 10.10.1; ACI 318-05, 10.13.2; ACI 318-02, 10.13.2

0 AC1318-05, 10.11.5; ACI 318-02, 10.11.5; CSA A23.3-14, 10.13.2; CSA A23.3-04, 10.13.2; CSA A23.3-94, 10.13.2

1 ACI 318-14, 2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-14, 3.2; CSA A23.3-04, 2.3;
CSA A23.3-94, 10.0
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5. Factored moments, Mo, and M, due to lateral loads (wind and earthquake) assumed to cause
appreciable sidesway*, are calculated at the top and bottom ends of the column.

6. Flexural stiffness El is calculated as®:
o O2Elg +Ell,
1+Bds

where E. is the modulus of elasticity of concrete, E, is the modulus elasticity of steel, I, is the gross

g
moment of inertia of the concrete section, | is the moment of inertia of reinforcement. Assuming that

shear due to lateral loads is not sustained in most frames*, the B is taken as zero (with the exception of
strength and stability of the structure as a whole under factored gravity loads described in Step 11).

7. The critical buckling load, P, , is computed as®:
nEl
(k1, Y

8. The sway moment magnification factor, J, , is computed as*:

c

1.0
6, =——+—210,
s 3 2P,

d)kzpc

where the stiffness reduction factor, ¢, , is equal to 0.75.

2P, is taken as the factored axial load for the load combination under consideration times the
ratio =P, /P, ,i.e.” =P, =P, (=P, /P,).
ZP, is taken as the critical buckling load for the load combination under consideration times the ratio
ISP, /P, i.e. TP, =P, (2P, /P,).
¢, and the ratios =P, /P, and XP,/P, may be modified using the Slenderness Factors input box.
9. The magnified moments at the top and bottom ends of the compression member are computed as*®:
Mtop = Mns,top +8sMs,top )
Mbot = Mns,bot +85 Ms,bot .

10. The smaller and the larger factored end moments are then determined based on absolute values of
magnified top and bottom end moments

2 AC1318-14, 2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

“ ACI 318-14, 6.6.4.4.4, Eq. 6.6.4.4.4b; ACI 318-11, 10.10.6 Eq. 10-14; ACI 318-08, 10.10.6 Eq. 10-14; ACI 318-05, 10.12.3 Eg. 10-
11; ACI 318-02, 10.12.3. Eqg. 10-10; CSA A23.3-14, 10.16.3.2, 10.15.3 Eq. 10-19; CSA A23.3-04, 10.16.3.2, 10.15.3 Eq. 10-18; CSA
A23.3-94,10.16.3.2, 10.15.3.1 Eq. 10-18

“ACI 318-14, R6.6.4.6.2(b); ACI 318-11, R10.10.7.4; ACI 318-08, R10.10.7.4; ACI 318-05, R10.13.4.1, R10.13.4.3; ACI 318-02,
R10.13.4.1, R10.13.4.3; Ref. [10] pp 586 (first paragraph from the bottom)

®ACI 318-14, 6.6.4.4.2, Eq. 6.6.4.4.2; ACI 318-11, 10.10.6 Eqg. 10-13; ACI 318-08, 10.10.6 Eq. 10-13; ACI 318-05, 10.12.3 Eq. 10-10;
ACI 318-02, 10.12.3 Eqg. 10-10; CSA A23.3-14, 10.16.3.2, 10.15.3.1 Eq. 10-18; CSA A23.3-04, 10.16.3.2, 10.15.3.1 Eq. 10-17; CSA
A23.3-94,10.16.3.2, 10.15.3 Eq. 10-17

% ACI 318-14, 6.6.4.6.2, Eq. 6.6.4.6.2b; ACI 318-11, 10.10.7.4 Eq. 10-21; ACI 318-08, 10.10.7.4 Eq. 10-21; ACI 318-05, 10.13.4.3 Eq.
10-18; ACI 318-02, 10.13.4.3 Eq. 10-18; CSA A23.3-14, 10.16.3.2 Eq. 10-24; CSA A23.3-04, 10.16.3.2 Eq. 10-23; CSA A23.3-94,
10.16.3.2 Eqg. 10-23

" To minimize required input, the program uses one value of ratio =P,/ P, for all load combinations. However, the ratio can vary
depending on the combination under consideration. In this case, it will be conservative to use the highest value of the ratio.

8 ACI 318-14, 6.6.4.6.1; ACI 318-11, 10.10.7; ACI 318-08, 10.10.7; ACI 318-05, 10.13.3; ACI 318-02, 10.13.3; CSA A23.3-14,
10.16.2; CSA A23.3-04, 10.16.2; CSA A23.3-94, 10.16.2
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Mbot if |Mtop|Z|Mbot|’
top if |Mtop|<|Mbot|’

top if |Mtop|2|Mbot|*
|\/lbot if |Mtop| <|Mbot|'

While design codes define moment M, as always positive and the sign of moment M, depending on
single or double curvature bending®®, spColumn retains actual signs of moments M; and M,. This
revision ensures proper comparison against negative and positive moment capacities of unsymmetrical
sections (see Figure 2-8).

11. Strength and stability of the structure as a whole under factored gravity loads® is ensured by checking
that the value of the moment magnification factor, &;. is positive and does not exceed 2.5.

The program performs this check for all load combinations that include only gravity loads with the
exception of the ACI 318-14/11/08 codes for which the check is not performed and CSA A23.3-94 where
the check is performed only for the load combination of 1.25 dead load plus 1.5 live load plus (1.5 snow
or 0.0 snow), if this combination is present (default). The B, factor for the load combination under

consideration is equal to the maximum sustained factored axial load to the maximum factored axial load.

F - Moment Magnification along Length of Compression Member

This procedure accounts for moment magnification due to second-order effect along the length of
compression members that are part of either nonsway®* or sway frames®%. In nonsway frames, moment
magnification along length is neglected by the program if the condition in Step 3 below is satisfied.

In sway frames designed per ACI 318-02/05 and CSA A23.3-94/04/14, the magnification along the length is
neglected if**:

6 _ 35

By rearranging and introducing k' = /Pu I(f¢Ag) , this condition can be succinctly expressed as k¢, /r<35.

For columns designed per ACI 318-14, ACI 318-11, and ACI 318-08 codes, moment magnification along
length is to be considered for all slender compression members, i.e. columns in either nonsway or sway
frames regardless of the k'¢,/r ratio. Since various published examples of columns designed per ACI 318-
14, ACI 318-11, and ACI 318-08 do not combine moment magnification at ends and along length of columns
in sway frames™, spColumn optionally allows not considering moment magnification along the length of a
column in a sway frame based on engineering judgment of the user.

When moment magnification along the length of a compression member is considered, the following
procedure is followed:

 ACI 318-14, 2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-14, 3.2; CSA A23.3-04, 2.3;
CSA A23.3-94, 10.0

% ACI318-05, 10.13.6; ACI 318-02, 10.13.6; CSA A23.3-14, 10.16.5; CSA A23.3-04, 10.16.5; CSA A23.3-94, 10.16.5

L ACI 318-14, 6.6.4.4.2, 6.6.4.5.1, 6.6.4.5.2; ACI 318-11, 10.10.6; ACI 318-08, 10.10.6; ACI 318-05, 10.12; ACI 318-02, 10.12; CSA
A23.3-14, 10.15; CSA A23.3-04, 10.15; CSA A23.3-94, 10.15

%2 ACI 318-14, 6.6.1.1; ACI 318-11, 10.10.2.2; ACI 318-08, 10.10.2.2; ACI 318-05, 10.13.5; ACI 318-02, 10.13.5; CSA A23.3-14,
10.16.4; CSA A23.3-04, 10.16.4; CSA A23.3-94, 10.16.4

% ACI 318-05, Eq. 10-19; ACI 318-02, Eq. 10-19; CSA A23.3-04, Eq. 10-26; CSA A23.3-04, Eq. 10-25; CSA A23.3-94, Eq. 10-25

5 See Example 11.2 in Ref. [9], Example 12.4 in Ref. [11], and Example 12.3 in Ref. [10]
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1. The effective length factor, k, is either entered by the user or calculated by the program. The value of k
must be between 0.5 and 1.0 for moment magnification along length and the recommended® value is 1.0.
Smaller values can be used if justified by analysis. If properties of framing members are input, spColumn
computes the effective length factor, k, for nonsway condition from the following equation®:

2
vave | | (vatwe |, _mk ) 2 om
4 | k2 2 tan(n/k)) n/k 2k

Where v is the ratio of £(EI/¢ ) of columns to (El/¢) of beams in a plane at one end of the column,

v, and yg are the values of y at the upper end and the lower end of the column, respectively.
Moments of inertia used in computing y factors are gross moments of inertia multiplied by the cracked
section coefficients® (specified in the Slenderness Factors dialog box).

2. Moments at column ends, M; and M,, are calculated, where M; is the moment with the smaller absolute
value and M, is the moment with the larger absolute value. For columns in nonsway frames, the end
moments will be equal to the factored applied first order moment. For columns in sway frames, the end
moments will be the moments M; and M, calculated in the procedure for moment magnification at ends
of compression member. While design codes define moment M, as always positive and the sign of
moment M, depending on single or double curvature bending®, spColumn retains actual signs of
moments M, and M, to ensure proper comparison of resulting magnified moments against negative and
positive moment capacities of unsymmetrical sections (see Figure 2-8). This revised interpretation does
not affect results of the moment magnification along length procedure because the procedure relies on
the My/M, ratio. spColumn follows the code definition which assumes the ratio to be positive if the
member is bent in single curvature and negative if bent in double curvature. If both moments are equal to
zero, the program conservatively assumes the ratio of M;/M, =1.0 .

3. Second-order effects along length for columns in nonsway frames can be ignored if:

kg < 34—12ﬂ <40 for ACI codes®,
r M,

and

k& 25-10(My/ M) , for the CSA standards®
r P/ (eA)

where ¢, is the unsupported column length, r = /Ig /A is the radius of gyration, and the ratio M;/M,
is always taken as greater than or equal to —0.5.

4. Ifthe ratio k¢, /r exceeds 100, slenderness effects cannot be accounted for using moment magnification

procedure®’. A more exact method must be used. In this case, the program issues a warning message and
aborts design or investigation procedure except for calculations per ACI 318-14, ACI 318-11, and ACI
318-08 where limit of ké,/r <100 does not explicitly apply and the program continues calculations after

showing the warning message.

® ACI 318-14, 6.6.4.4.3, R6.6.4.4.3; ACI 318-11, 10.10.6.3, R10.10.6.3; ACI 318-08, 10.10.6.3, R10.10.6.3; ACI 318-05, 10.12.1; ACI
318-02, 10.12.1; CSA A23.3-14, 10.15.1; CSA A23.3-04, 10.15.1; CSA A23.3-94, 10.15.1

% Exact formula derived in Ref. [12] pp. 848 for Jackson and Moreland alignment chart

" ACI 318-14, 6.6.3.1.1, 6.6.4.2, 6.7.1.3, 6.8.1.4; ACI 318-11, 10.10.4.1; ACI 318-08, 10.10.4.1; ACI 318-05, 10.11.1, 10.12.1; ACI
318-02,10.11.1, 10.12.1; CSA A23.3-14, 10.14.1.2, 10.15.1; CSA A23.3-04, 10.14.1.2, 10.15.1; CSA A23.3-94, 10.14.1, 10.15.1

% ACI 318-14, 2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-14, 3.2; CSA A23.3-04, 2.3;
CSA A23.3-94, 10.0

% ACI 318-14, 6.2.5; ACI 318-11, 10.10.1; ACI 318-08, 10.10.1; ACI 318-05, 10.12.2; ACI 318-02, 10.12.2

%0 CSA A23.3-14,10.15.2; CSA A23.3-04, 10.15.2; CSA A23.3-94, 10.15.2

51 ACI 318-05, 10.11.5; ACI 318-02, 10.11.5; CSA A23.3-14, 10.13.2; CSA A23.3-04, 10.13.2; CSA A23.3-94, 10.13.2
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5. The factor C,, is computed as®:

C.. =06+0.4L,
MZ

and for codes other than ACI 318-14, 318-11, and ACI 318-08, C,, is taken as not less than 0.4.

If M, =M, =0, the program assumes C,, to be equal to® 1.0. This is consistent with the assumption
made above (in Step 2).

6. The sustained load factor B4, is computed as the ratio of maximum factored axial sustained load to the

maximum factored axial load for the load combination under consideration for compression members
either in nonsway® or sway® frames. The value of By, is not taken greater than 1.0.

7. Flexural stiffness El is computed as®:
El_ 0.2E 14 +Elg
1+ Bdns
where E. is the modulus of elasticity of concrete, E,is the modulus of elasticity of steel, I is the gross

moment of inertia of the concrete section, and |, is the moment of inertia of reinforcement.
8. The critical buckling load, P, , is computed as®’:
_ n°El
(k,)*

9. The magnification factor for moment along length, & , is computed as®:

C

§=—m _>10,
1- o
P

where the stiffness reduction factor, ¢, , is equal to 0.75 (may be modified using the Slenderness Factors
input box) and P, is the factored axial load for the load combination under consideration.

10. The moment due to minimum eccentricity, e, , is computed as®:

min

M min = Py €min » Where

min 1

=0.6+0.03 h, with h in inches,

emin

2 ACI 318-14, 6.6.4.5.3; ACI 318-11, 10.10.6.4; ACI 318-08, 10.10.6.4; ACI 318-05, 10.12.3.1; ACI 318-02, 10.12.3.1; CSA A23.3-14,
10.15.3.2; CSA A23.3-04, 10.15.3.2; CSA A23.3-94, 10.15.3.1

63 ACI 318-14, 6.6.4.5.4; ACI 318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318-02, 10.12.3.2

5 ACI 318-14, 6.6.4.4.4; ACI 318-11, 10.10.6.2; ACI 318-08, 10.10.6.2; ACI 318-05, 10.11.1; ACI 318-02, 10.0; CSA A23.3-14, 3.2;
CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

% ACI 318-14, 6.6.1.1; ACI 318-11, 10.10.2.2, 10.10.6.2; ACI 318-08, 10.10.2.2, 10.10.6.2; ACI 318-05, 10.13.5; ACI 318-02, 10.13.5;
CSA A23.3-14, 10.14.1.3(a), 10.16.4; CSA A23.3-04, 10.14.1.3(a), 10.16.4; CSA A23.3-94, B4 definition (a) in 10.0, 10.16.4

% ACI 318-14, 6.6.4.4.4 Eq. 6.6.4.4.4(b); ACI 318-11, 10.10.6.1 Eq. 10-14; ACI 318-08, 10.10.6.1 Eq. 10-14; ACI 318-05, 10.12.3 Eq.
10-11; ACI 318-02, 10.12.3. Eq. 10-10; CSA A23.3-14, 10.15.3 Eq. 10-19; CSA A23.3-04, 10.15.3 Eq. 10-18; CSA A23.3-94, 10.15.3.1
Eq. 10-18

7 ACI 318-14, 6.6.4.4.2, Eq. 6.6.4.4.2; ACI 318-11, 10.10.6 Eq. 10-13; ACI 318-08, 10.10.6 Eq. 10-13; ACI 318-05, 10.12.3 Eq. 10-10;
ACI 318-02, 10.12.3 Eq. 10-10; CSA A23.3-14, 10.15.3.1 Eq. 10-18; CSA A23.3-04, 10.15.3.1 Eq. 10-17; CSA A23.3-94, 10.15.3 Eq
10-17

8 ACI 318-14, 6.6.4.5.2 Eq. 6.6.4.5.2; ACI 318-11, 10.10.6 Eq. 10-12; ACI 318-08, 10.10.6 Eq. 10-12; ACI 318-05, 10.12.3 Eq. 10.9;
ACI 318-02, 10.12.3 Eq. 10.9; CSA A23.3-14, 10.15.3.1 Eq. 10-17; CSA A23.3-04, 10.15.3.1 Eq. 10-16; CSA A23.3-94, 10.15.3 Eq. 10-
16

% ACI 318-14, 6.6.4.5.4; ACI 318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318M-05, 10.12.3.2; ACI 318-02,
10.12.3.2; ACI 318M-02 10.12.3.2; CSA A23.3-14, 10.15.3.1; CSA A23.3-04, 10.15.3.1; CSA A23.3-94, 10.15.3.
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€min =15+0.03 h, with h in mm,
and h is the section dimension (diameter for circular sections) in the direction being considered.

11. The factored magnified moment along the length of a compression member, M_, is the larger® of &M,
and 8M,;, . The program also calculates moment M, based on the smaller end moment, M, to account

for scenario when M; and M, are of different sign (double curvature bending). For an unsymmetrical
section, the smaller moment, M;, may govern the design when the moment capacity on the negative side
of the interaction diagram is smaller than the moment capacity on the positive side (see Figure 2-8).

pA

Figure 2-8 Case of unsymmetrical section bent in double curvature (M, and M, of different sign)
with the smaller end moment, My, governing the design

G - Ratio of Moments Due To Second-Order Effects to Moments Due To First-Order Effects

For calculations in accordance with ACI 318-14, ACI 318-11, and ACI 318-08, the value of total magnified
moment including second-order effects (combined magnification at ends and along length of compression
member) cannot exceed 1.4 times the corresponding moment due to first order effects’. Columns with
second-order moment to first-order moment ratios exceeding 1.4 do not meet requirements of ACI 318-14,
ACI 318-11, and ACI 318-08.

The ratio of second-order moment, My,q, to first-order moment Mg, is calculated for both values (i =1, 2) of
magnified moment along length, M, i.e. based on M; and M:

Mo it My, |2 Mo

Mani _ U;
M M
B C.i if |Mui <|Mmin|
min

Cutoff value of My, is applied to Mui in order to avoid unduly large ratios in cases where Mui moments are
smaller than Myn.
If only magnification at ends is considered (i.e. when user chooses to bypass provision 10.10.2.2 of ACI 318-

14/11/08 and ignores second order effects along the length of a compression member in a sway frame), the
ratio of second-order moment, My, to first-order moment, Mg, is calculated at both ends (i =1, 2) as:

" ACI 318-14, 6.6.4.5.4; ACI 318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318-02, 10.12.3.2; CSA A23.3-14,
10.15.3.1; CSA A23.3-04, 10.15.3.1; CSA A23.3-94, 10.15.3
™ ACI 318-14, 6.2.6; ACI 318-11, 10.10.2.1; ACI 318-08, 10.10.2.1
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Mzndi _ M; _ Mips +3sMjg

Mlst- I\/Iui IVlins + Mis

where M; are the magnified end moments M; and M, and Mui are the corresponding factored applied moment

composed of the part that causes no appreciable sidesway, M;.s, and the part that causes appreciable sidesway,
M;,. If both Mani and Mmi moments are equal to zero, the program will report the ratio equal to 1.0. If only

Mg, moment is equal to zero, the program will report the ratio as a large value.
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Chapter 3

spColumn Interface

Main Window

Most windows have certain elements in common, such as a title bar and menus. Not all windows, however,
have every element. To learn more about how to use window elements, refer to your Microsoft Windows
manual. The following is a list of the spColumn window components.

P spColumn - (Untitied) —[8[x]
Fle Input Sove View Options tiep

10 ] = 1 e 5 5 s e

Control-Menu Box:

The Control-menu box is located in the upper-left corner of the window and includes commands for sizing,
moving, enlarging, restoring, and closing the window, as well as switching to other applications. To access
the Control-menu box using the mouse, click the left mouse button on the box; using the keyboard, press

ALT+* “(space).
Title Bar:
The Title bar displays the name of the application (spColumn in this case), along with the name of the current
data file in use. If the data have not been saved into a file, the word Untitled is displayed in the Title bar.
Menu Bar:
The Menu bar is located directly below the Title bar. It lists the available menus. A menu contains a list of
commands or actions you can execute.
Tool Bar:

The Tool bar is located directly below the Menu bar. It contains a collection of buttons (or icons) that provide
a shortcut to accessing the menu commands. The Tool bar buttons can only be accessed using the mouse.
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Information Bar:

The Information bar is located on the left side of the spColumn window. The top part displays the column
cross section. The bottom part is a list of selected input data echo.

Graphics Area:
The Graphics area covers most of the window. This is where the interaction diagram is shown.

Status Bar:

The Status bar is located along the bottom of the window. It displays important information such as units,
design code, cursor position, and helpful messages.

File Menu

The File menu is used for working with data files, printing results, and exiting the program.

New (CTRL+N)
Clears any input data and returns the data to the default values so thata oo, e
new data file may be input. Save ctrs
Save As..,
Impork ¥
Open (CTRL+O) e '

Opens an existing spColumn data file.

Save (CTRL+S)

Saves the changes you have made to the current data file under that | [P Fiesisinue.. |Examkot col

2 Ci\Pragram Files\Struc, . \Example0z.col

same fl Iename. 3 CiYProgram FilesiStruc,, \Example03.col
4 C:YProgram FilesiStruc,, \Example04.col
Save As Ext

Names or renames a data file.

Import

Reads geometry, reinforcement or loads data from an ASCII (TXT) file, or imports section geometry and
reinforcement from a DXF file.

Export

Exports interaction diagram and 3D failure surface to Comma-Separated Values (CSV) files (readable by
most spreadsheet programs) or Tab-Delimited Text (TXT) files. Exports a column section to Drawing
Exchange Format (DXF) file (readable by most CAD programs). Exports graphical report (screen printout) to
Enhanced Metafile Format (EMF) file (readable by most graphics and word processing programs).

Revert

Discards any changes to the data and returns to the last version of saved data. This option will only be
available if the file has been modified since the last file save.

Print Results
Displays Print dialog box and prints the results in the text form to the selected printer.

Print Screen (CTRL+P)
Displays Print dialog box and prints the results similarly as they appear on the screen.

Recent Data File List
Provides quick access to up to four recently open data files.
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Exit
Quits the spColumn program. If you have made any changes to your data and have not saved them, spColumn
will prompt you whether you want to save or abandon any changes you have made before you exit.

Input Menu

The Input menu includes commands used to input the data needed to define a problem.

General Information
Input labels to identify the input and select from several options that control the run. Material Propeties..

Section
Reinforcement

Material Properties Slenderness

Input the material properties for concrete and reinforcement. Loads
Flip/R.otate Section...

General Information. ..

rvr T T

Section
Rectangular: Input the dimensions of a rectangular section.

Circular: Input the dimension of a circular section.

Irregular: Execute spSection to define an irregularly shaped section. See Chapter 6.

Reinforcement

All Sides Equal: Input a reinforcement pattern in which all the bars are of one size, and the number of bars is
the same on all four sides of a rectangular layout or are equally spaced for a circular layout. Available for
rectangular and circular sections.

Equal Spacing: Input a reinforcement pattern in which all bars are of one size and are uniformly spaced on
all four sides of a rectangular layout. Available for rectangular sections only.

Sides Different: Input a reinforcement pattern in which each one of the four sides of a rectangular section has
a certain number of bars and a certain bar size. Available for rectangular sections only.

Irregular Pattern: Input a reinforcement pattern in such a way that bars of any size can be placed anywhere
within the column section.

Confinement: Input confinement-related data such as the capacity reduction factors and the size of ties
associated with the longitudinal bar size.

Design Criteria: Input parameters that govern the design of the section such as column type, minimum and
maximum reinforcement ratio, bar selection criterion, minimum clear spacing, and design/required ratio.

Slenderness
Design Column: Input data needed for slenderness related to the column being considered.

Column Above/Below: Input data needed for slenderness related to the columns above and below the design
column.

X-Beams: Input data needed for slenderness related to beams perpendicular to the x-axis framing into the
design column.

Y-Beams: Input data needed for slenderness related to beams perpendicular to the y-axis framing into the
design column.

Factors: Input factors that affect slenderness calculations.

Loads
Factored: Input factored axial loads and moments. This command is available for non-slender columns only.
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Service: Input service-level (dead, live, wind, earthquake, and snow) axial loads and moments about the
active axis. Moments are input at the top and at the bottom of the column. This command must be used for
slender columns.

Control Points: If chosen, the program will compute key points on the interaction diagram. In addition, the
splice regions are shown on the interaction diagram. This option is available for short (non-slender) columns
under the investigation option only and for uniaxial runs only.

Axial Loads: Input a group of axial loads with an initial value, a final value, and an increment. This
command is available for uniaxial short (non-slender) columns only.

Load Combinations: Input the load factors and combinations used to combine the service loads.

Flip/Rotate Section
Flip an unsymmetrical section about an axis or rotate an irregular section (created in spSection).

Solve Menu

The Solve menu contains the command used to perform the design or investigation
and options that control inclusion of nominal capacity calculations, tracing through
the design process, and sending the output to a text file.

Execute FS

Include Mominal Diagram

v Results File

Execute (F5)
Executes the solver.

Include Nominal Diagram
Toggles INCLUDE NOMINAL DIAGRAM option on and off.

Design Trace
Toggles DESIGN TRACE option on and off.

Results File
Toggles RESULTS FILE option on and off.

View Menu

The View menu commands used to customize the display screen to suit your viewing needs, view the
interaction diagram at a given angle, view the contour for a given axial load, superimpose an interaction
diagram or a contour from another run, and view the results file.

Redl’aW Redraw
Redraws the displayed diagrams or contours. Copy Diagram to Cliphaard CtrHC
v Information Bar
Copy Diagram to Clipboard (CTRL+C) v ;toot' Baé
v atus oar
Copies the displayed diagram or contour to clipboard so that in can be Grid
pasted in other applications. M-y Diagram

w P-M Diagrarm - Full
P-M Diagram - M positive

I nformatlon Bar P-M Diagram - M negative

Shows or hides the Information bar.

Tool Bar
Shows or hides the Tool bar.  <how Lond Poit Labels
Status bar v Show Mominal Diagram

Superimpose. ..

Results... F&

spColumn Interface 3-4



sfeolumn

Shows or hides the Status bar.

Grid
Shows or hides the grid.

Mx-My Diagram
View a contour of the failure surface sliced at a constant axial load.

P-M Diagram - Full
View an interaction diagram sliced at a constant (M,, M,) angle drawn for both positive and negative
moments.

P-M Diagram - M positive
View an interaction diagram sliced at a constant (M, M,) angle drawn for the positive moments only.

P-M Diagram - M negative
View an interaction diagram sliced at a constant (M, M,) angle drawn for the negative moments only.

P-M Diagram — 3D
View a three dimensional visualization of the complete nominal and factored failure surface for sections
subject to biaxial bending.

Next Load (Ctrl + Arrow Up)

View an M,-M, interaction diagram for the factored load next to the one displayed currently on the
interaction diagram.

Previous Load (Ctrl + Arrow Up)

View an M,-M, interaction diagram for the factored load previous to the one displayed currently on the
interaction diagram.

Next Angle

View a P-M interaction diagram at the (M,, M,) angle corresponding to factored load next to the one
currently in the graphics area.

Previous Angle

View a P-M interaction diagram at the (M,, M,) angle corresponding to factored load previous to the one
currently in the graphics area.

Show Load Point Labels
Show/Hide Load Point labels of factored loads input.

Show Splice Lines
Show the P-M splice lines corresponding to f; = 0 and f; = 0.5f,

Show Nominal Diagram

Show nominal (unfactored) capacity interaction diagram in addition to the design (factored) capacity
interaction diagram. Available only when Include Nominal Diagram option is selected in the Solve menu.

Superimpose
Superimpose a diagram from a previously saved run over the current diagram.
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Results (F6)
View the results file after a successful run has been performed with the Solve | Results File option ON.

Options

The Options menu contains commands used to view or change spColumn’s default |y
settings and reinforcement bar set. Reinforcement. .

Startup Defaults
View or Edit application startup default settings.

Reinforcement
View or Edit reinforcing bar set.

Help Menu
SpCOlUmn Help spColumn Help...
spColumn Manual. ..
Lists all the available help topics about the program. Command Line Help...
Check for Updates...
SpCO|umn Manual About spColurn, ..

Opens spColumn Manual in the default PDF viewer.

Command Line Help
Displays help on how to use command line parameters for running spColumn in batch mode.

Check for Updates
Checks if a newer version of the program is available. Internet connection is required.

About spColumn
Shows the version number of the program, the licensing information, and the copyright information. In the
case of a trial license, the expiration date is given as well as the locking code which is needed to obtain a
standalone license.
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Chapter 4

Operating the Program

This chapter is divided into sections that follow the order in which commands and options appear in the
program.

Creating New Data File

When spColumn is first loaded, the program is ready to obtain input for a new file. The data will not have a
file name associated with it; therefore, Untitled appears in the Title bar.

e Select File | New. This clears the screen and returns to the default settings of the program. If existing data
have been changed prior to selecting the New command, spColumn asks if you want to save the data. At
any time after starting a new file, use the File | Save As command to give the file a name.

Opening Existing Data File

You can open spColumn data files that were previously saved to disk. spColumn reads files that have been
saved in binary format (with COL extension) or text input format (with CT1 extension).

o Select File | Open. A dialog box appears.

o All files with the COL extension contained in the current drive and directory are displayed in the FILE
NAME list box.

e To open a file that exists in another drive or directory, select the drive or directory you want from the
LOOK IN drop-down list.

e To open a file in spColumn Text Input (CT1) format™, use FILE TYPE list box to select this type.
e From the FILE NAME list box, select the file to be opened, or simply type its name in the text box.

e Choose the OK button.

7K
Lok jr: |_} Examples ﬂ & EF-
- | Ll |Exxample0l  cal @examplels.col
L&ﬁ ﬂ Example0z,col @ examplel7?.col

My Recent ﬂ Exampled3.col @ example1d.col
Documents &) £xamplet4, col

?‘_‘_ ﬂ Example0S.col
ﬂ Exampleds.cal
Desktop ﬂ Exarnple0? .col

ﬂ Example0d,col
ﬂ Example0d.col
ﬂ Example1d.col
ﬂ Examplell.col
_ ﬂ Example1Z.col
g!J ﬂ Example13.col
ﬂ example14,col

\\,.'

My Documents

&k;

by Computer
ﬂ examplel5.col
y
My Network File name: |ExampIeD1.col j Open
Places
Filez of type: | splolumn Input Files [* col) j Cancel

2 See Appendix for description of the CTI format
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Saving Data

To save the data with the same file name:

At anytime while editing a data file that has previously been saved under a file name, choose File | Save to
save the changes under the same file name. Selecting the File | Save command before giving the data file a
name displays the Save As dialog box.

To give the data a new or different file name or to change input file format:
o Select File | Save As. A dialog box appears.

e All files with COL extension contained in the current drive and directory are displayed in the FILE NAME
list box.

e To save the file to a drive or directory other than the default, select a different drive or directory drive
from the SAVE IN drop-down list.

e Use FILE TYPE list box to select either spColumn Input File (COL) or spColumn Text Input File (CTI).

¢ In the FILE NAME text box, type a new file name. If no file extension is specified, an extension will be
appended to the specified file name based on the selected file type.

e Choose the OK button.

Save As @@

Save jn: |_} Examples j |‘=_“F v

&

by Recent
Documents

My Computer
’
My Metwark File name: j Save
Flaces
Save as ype: | palColumn Test Input File [*.cti] j Cancel

Importing

Importing Data

Geometry, reinforcement or load data may be imported from a text file. The import file must be saved in pure
ASCII (text) format.”

Import Data (from text file)

e Select File | Import | Import Data... or press CTRL + | keyboard shortcut to o e
display IMPORT DATA dialog box. ; Fieinforcement
Service loads
e Select the type of data you want to import: SERVICE LOADS, FACTORED LOADS, ¢ Factored loads

REINFORCEMENT OR GEOMETRY.

Lancel

e Choose the OK button. The Open Import file box is displayed.

8 See Appendix for description of the import file format
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e All files with the TXT extension contained in the current drive and directory are displayed in the FILE
NAME list box.

e To open a file that exists in another drive or directory, select the drive or directory you want from the
Look IN drop-down list.

o From the File Name list box, select the file to be opened, or simply type its name in the text box.

e Choose the OPEN button.

Importing DXF Files
e Select File | Import | Import DXF.... to display Open Import file box.

e All files with the DXF extension contained in the current drive and directory are displayed in the FILE
NAME list box.

e To open a file that exists in another drive or directory, select the drive or directory you want from the
Look IN drop-down list.

o From the File Name list box, select the file to be opened, or simply type its name in the text box.
e Choose the OPEN button.

e The DXF IMPORT LAYER SELECTION dialog box is displayed.

spColumn - DXF Import Layer Selection

Select layer toimpart the section from,
Click Skip button to select laver automatically.

e Type the layer name (default is “0”) to import the section from and click the OK button. To search the
whole file, press the SKip button or provide an empty name.

If the DXF file (or selected layer) contains a closed polyline entity (either LWPOLYLINE or POLYLINE) it
will be interpreted as the section outline. If multiple closed polylines are present then the fist two will be
automatically recognized as the outline and the opening and the rest will be ignored.

Reinforcing bars are derived from DXF circle entities (CIRCLE). If no closed polylines are present then the
first circle entity will be interpreted as a circular shape of the column and the rest will be interpreted as
reinforcing bars.

Dimensions of imported entities will be automatically converted to current project units based on DXF header
variable $INSUNITS.

Exporting Data

Once a successful run has been performed you may export points from the
interaction diagram or 3D failure surface to a Comma-Separated Values (CSV) file
or to a Tab Delimited Text file (TXT). These files can be read by most spreadsheet ominal Interaction Disgram...
and mathematical programs where data produced by spColumn can be further Nartinal 30 Failure Surface...
analyzed and processed as needed by the user. Coordinates of the points (P, My, Column Section ta DKF Fie...

M,) are saved together with corresponding location of the neutral axis (depth and Graphical Report to EMF File...
angle), maximum steel strain, and (for ACI code) strength reduction factor. The

column section can be exported to a file in Drawing Exchange Format (DXF) format that is readable by most
CAD programs. A graphical report can be exported to a file in Enhanced Metafile Format (EMF) that is
readable by most graphics and word processing programs. The file will include column section, column
information, and the interaction diagram currently displayed on the screen presented the same way as in the
printout created by the default printer using the File | Print Screen command.

Eactored Interaction Diagram. ..
Factored 30 Failure Surface...

e Select File | Export|Factored Interaction Diagram to export P-M or M,-M, diagram currently
displayed on the screen.
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To export 3D failure surface (biaxial runs only) select File | Export | Factored 3D Failure Surface.

Select File | Export | Nominal Interaction Diagram to export nominal (unfactored) P-M or M,-M,
diagram corresponding to the one currently displayed on the screen.

To export nominal (unfactored) 3D failure surface (biaxial runs only) select File | Export| Nominal
3D Failure Surface.

To export column section to DXF file select File | Export | Column Section to DXF File.
To export graphical report to EMF file select File | Export | Graphical Report to EMF File.

For interaction diagrams and 3D failure surface, use FILE TYPE list box to select either Comma-Separated
Values (CSV) file or Tab Delimited Text file (TXT). For sections, only DXF format is available and for
graphical reports, only EMF format is available.

In the FILE NAME text box, type the file name. If no file extension is specified, an extension will be
appended to the specified file name based on the selected file type.

Choose the OK button.

Export Current P-M Diagram

RIX

Save in: |_} Examples j EF v

&

My Recent
Documents

Desktop

\\.'

My Documents

-
!!J
Iy Computer

<

-
by Metwark
Flaces

File name:

j Save
[~

Cancel

i

Save as lype: | Comma-Separated Yalues Files [".cav]

Printing Results

Once a successful run has been performed you may print the displayed diagram using File | Print Screen
command. If the Solve | Results File option was selected you may print the results file using File | Print
Results. spColumn sends the printout to the printer selected in the Print dialog box.

Select File | Print Results or File | Print Screen. A dialog box appears.
Select the printer to send the results to.
Use Print dialog controls to set up the printer options.

Choose the OK button to start the printing or choose the CANCEL to terminate the print job.
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Gereral l

Select Printer

iz Microsoft Office Document Image Writer <23 OKI B4545 Network{OK-E4545-5
iz PaperPort Black & White Image

3:; PaperPort Color Image

< 4

Status: Feady ™ Print tofile  Preferences

Location:  Structure Point Group Offices

Comment: Multifunction printer Find Printer...

FPage Range
oAl Nurnber of copies: |1 Eli
" Selection
e l—
DI

FErrint | Cancel |

General Information

The General Information command allows you to define or change options that

will affect the rest of the input. X
e Select Input | General Information. A dialog box appears. IP'°i3°“

e Enter the PROJECT, COLUMN, and ENGINEER labels. |°°‘““‘”: Sl

e Select the units of measure, ENGLISH or METRIC. S

e Select the axis about which the column capacity is to be computed: ABOUT | |Jaci 31314 =

X-AXIS, ABOUT Y-AXIS, or BIAXIAL.

e Select a design code to conform to: ACI 318-14, ACI 318-11, ACI 318-08, & Engish
ACI 318-05, ACI 318-02, CSA A23.3-14, CSA A23.3-04 or CSA A23.3-94. £ Metic

~ Flun Axi

' |nvestigation

— Lnit Run Option
’7 = Design

e Choose a run option: INVESTIGATION or DESIGN. £ Moutidis € Biorid

: . . " About -
o Specify whether slenderness effects are to be considered or not by checking o
either YES or No under the CONSIDER SLENDERNESS? option. Consider slendemess? (* es & fid
e Choose the OK button. ok | conce

Material Properties

e Select Input | Material Properties. A dialog box appears.

e Enter the concrete compressive strength, £’ under STRENGTH, f’c. The modulus of elasticity, E., under
ELASTICITY, Ec; the constant stress intensity, f. at the maximum usable strain used to calculate the force
on concrete, under MAX STRESS, fc; the factor used to determine the depth of the stress block, under
BETA(1); and the maximum usable strain at the extreme concrete compression fiber, at the ULTIMATE
STRAIN are automatically computed and displayed. Modify any of the values if different than computed.

e For the reinforcing steel, enter the yield strength, f, under STRENGTH, fy. The modulus of elasticity, E,
under the ELASTICITY, Es, as well as Compression-controlled strain limit, Eps_yt are automatically
computed and displayed. Modify any of the values if different than computed.

e Choose the OK button to accept standard or modified values based on user’s judgment.
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x
— Concrete — Reinforcing Steel

Strength, fie: |4— ksi Strength, fi: IED— ksi

Jv Standard Iv Standard

Blasticy, Ee: [5505 ki | | Elasticiy, Es[25000  ksi

b aw stress, fo: I34— ksi

Betall]: 0.es Compression-controlled strain limit,

Ultirmate strain: W Epz gt W

’TI Cancel |

Section / Rectangular

Input for the Investigation Option:
e Select Input | Section | Rectangular. A dialog box appears.

e Enter the width and depth of the rectangular section using WIDTH (ALONG X) and

Rectangular Section E|

‘Width [along =) |10 in
Depth [along ¥]: |20 in

DEPTH (ALONG Y) respectively. Note that width is measured along the x-axis and

depth is measured along the y-axis.
e  Choose the OK button.

Input for the Design Option:
e Select Input | Section | Rectangular. A dialog box appears.

e Enter the starting and ending values for each dimension (width and

s | LCancel |

Rectangular Section

Stant End  Increment

depth) along with an increment for each dimension under START, END | *idth(slongx): 10 J20 ]2 i
and INCREMENT columns along WIDTH (ALONG X) and DEPTH (ALONG | Depth(albora¥) [20 30 2 i

Y). Note that the starting and ending values may be the same (in which
case the increment must be zero).

ak. LCancel |

e Choose the OK button.

Section / Circular

Input for the Investigation Option:
e Select Input | Section | Circular. A dialog box appears.
o  Enter the diameter of the column section.
e Choose the OK button.

Input for the Design Option:
e Select Input | Section | Circular. A dialog box appears.

e Enter the starting and ending values the diameter along with an
increment. Note that the starting and ending values may be the same (in
which case the increment must be zero).

e Choose the OK button.

Circular Section g|

Diameter: in

LCancel

Circular Section

Start End Increment
Diameter: |20 30 2 in
ak LCancel |
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Reinforcement / All Sides Equal

The Input | Reinforcement | All Sides Equal command allows you to enter the total number of bars in the
column section. The program attempts to divide the bars equally between the four sides of a rectangular
layout then equally space them on each side. Corner bars are associated with the top and bottom sides, and if
the total number of bars is not a multiple of four, the top and bottom sides get the extra bars. For a circular
layout, the program attempts to equally space the bars.

Input for the Investigation Option:

Select Input | Reinforcement | All Sides Equal. A dialog box
appears.

Enter the total number of bars in the section. It must be at least 4 and
must be a multiple of 4 for a rectangular layout. For a circular layout it
can be any number not less than 4.

Select the bar size.

Enter the clear cover and specify whether it is to the transverse (ties)
or to the longitudinal bars.

AllL Sides Equal

Mo. of bars: |4

Bar size: #a -

Clear cover: |1.5 in

Caver to

o

)
Bar Layout

* Rectangular

(™ Circular

Longitudinal bars

LCancel |

Select a bar layout, CIRCULAR or RECTANGULAR. The default is Circular for a circular section and

Rectangular for a rectangular section.

Choose the OK button.

Input for the Design Option

Select Input | Reinforcement | All Sides Equal. A dialog box

All'Sides Equal

appears.

Enter the minimum and maximum total number of bars in the
section (must be at least 4 and must be a multiple of 4 for a
rectangular layout).

Select the minimum and maximum bar sizes along with the clear
cover.

Enter the clear cover and specify whether it is to the transverse

Bar size:

Minirmurn b aximum

No. of bars: |4 £0

#3 x| |#18 -

Clear cover: 1.5 in

X

(¢ Transverse bars

Cover to

" Longitudinal bars

Bar Layout
* Rectangular
" Circular

LCancel |

(ties) or to the longitudinal bars.

Select a bar layout, Circular or Rectangular. The default is Circular for a circular section and Rectangular

for a rectangular section.

Reinforcement / Equal Spacing

The Input | Reinforcement | Equal Spacing command allows you to enter the total number of bars in the
column section. The program attempts to place the bars equally spaced on all four sides of a rectangular
layout. Corner bars are associated with the top and bottom sides and if the total number of bars is not a
multiple of 4, the program does not accept the input.

Input for the Investigation Option:

Select Input | Reinforcement | Equal Spacing. A dialog box
appears.

Enter the total number of bars in the section No. OF BARS. (Must be
at least 4 and a multiple of 4).

Select the bar size.

3

Equal Spacing
Caover to
Mo. of bars: |4 [
+ Transverse bars
Bar size: |tt8 ﬂ ™ Longitudinal bars

Clear cover: |1.5 in

oK

LCancel |
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Enter the clear cover and specify whether it is to the transverse (ties) or to the longitudinal bars.

Choose the OK button.

Input for the Design Option:

Select Input | Reinforcement | Equal Spacing. A dialog box appears.

(<)

Equal Spacing

Minimurn — kMasimum — Coyer to

e, il | 1 {+ Transverse bars
#1 | |#18 « || C Longiudingl bars
Clear cover: IT in

Bar size:

0K Lancel |

Enter the minimum and maximum total number of bars in the section under MINIMUM and MAXIMUM

corresponding to NO. OF BARS. (must be a multiple of 4).

Select the minimum and maximum bar sizes.

Enter the clear cover and specify whether it is to the transverse (ties) or to the longitudinal bars.

Choose the OK button.

Reinforcement / Sides Different

Input for the Investigation Option:

Select Input | Reinforcement | Sides Different. A dialog box
appears.

Enter the number of bars to be placed on each of the top, bottom
(on the top and bottom, number of bars needs to be at least 2),
left and right sides (on the left and right, the number of bars may
be any number) of the rectangular section. Note that corner bars
are associated with the top and bottom sides.

Select the bar size and enter the clear cover for each of the top,
bottom, left and right sides of the section.

Specify whether the clear cover entered is to the transverse (ties)
or to the longitudinal bars.

Choose the OK button.

Input for the Design Option:

Select Input | Reinforcement | Sides Different. A dialog box
appears.

In the Top and Bottom group, enter the minimum and maximum
total number of bars to be placed on the top and bottom sides,
along with the bar size and the clear cover. The number of bars
must be greater than 4 and a multiple of 2. Corner bars are
associated with the top and bottom sides.

Select the minimum and maximum bar size and enter the clear
cover.

Repeat the steps above for the Left and Right sides.

X

Sides Different

Top Bottom Left Right
Mo. of bars: |8 |4 |E
[me ~|we ~|[me ] [ms ~]

Clear cover: |1_5 |1.5 |1.5 |1.5 in

Bar size:

Cover to

+ Transverse barz ¢ Longitudinal bars

ok LCancel

X

Sides Different
Top and Bottar Left and Right

Minirnum b asirum Finirmurn M awirum

No. of bars: | B [14 o [10

Bases | [m <][me =] | [ ][ o]

Olearcover | [15  in 16 in
Cover ta

¢ Tranzverse barz  Longitudinal bars

ok LCancel
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e Specify whether the clear cover entered is to the transverse (ties) or to the longitudinal bars.
e Choose the OK button.

Reinforcement / Irregular Pattern

The Input | Reinforcement | Irregular Pattern command allows you to specify any number of bars (up to
10,000) to be placed anywhere within the column section. Each bar may have any cross-sectional area. This
command is available with the Investigation option only.

e Select Input | Reinforcement | Irregular Pattern. If the section is

irregular, The spSection window, where the section reinforcement may

be graphically input, is displayed. Otherwise, a dialog box appears.

Area #-Coord, ‘-Coord,
e Enter the bar area, along with its x- and y-coordinates. E"z |i:5 |i':'5
e Choose the INSERT button. The data are added to the list box. [[(set | Modiy | Delets |
e Repeat the steps above for each entry. | No. Area X v
e To edit an entry, select it from the list box, modify its values in the text 1§ % “:5: 3425

boxes, and choose the MoDIFY button. To change the area for several
bars at once, select those bars from the list box, enter the new area in the
AREA text box, and choose MODIFY.

e To delete a bar entry, select it from the list box and choose the DELETE
button. ju]8 LCancel

e Choose the OK button.

Reinforcement / Confinement

e Select Input | Reinforcement | Confinement. A dialog box appears.

o Select the type of bar confinement: TiED (default), SPIRAL, or Other. The capacity reduction factors
change depending on the selection.

e To modify the capacity reduction factors, choose OTHER for confinement type.

For the ACI code: :
Confinement E]

Confinement: h

Capacity Reduction Factors, Phi

Phi(a) is the reduction factor for allowable compression,
Phi(b) is the strength reduction factor for tension controlled failure,
Phi(c) is the reduction factor for compression controlled failure. T IO N
Tension-controlled Failure (b): l_
For the CSA COde: Compression-controlled Failure [c): l_
Phi(a) is the reduction factor for allowable compression,

Tie Sizes
Phi(s) is the material resistance factor for steel, #3 x| tieswith |#10 | bars or smaller
R . . R #4 = |t ith | bars.
Phi(c) is the material resistance factor for concrete. e i EmerRa
e Specify the tie size associated with the particular longitudinal bar oK | concel |

sizes. The code requirements are used as defaults.
e Choose the OK button.

Note that if confinement is selected as TIED or SPIRAL then the program will automatically adjust the factors
when the user changes the design code. However, if OTHER confinement is selected, the factors will not be
adjusted.

For CSA A23.3-14, the reduction factor for allowable compression is variable (shown as VAR) and for
irregular sections the wall thickness or minimum column dimension must also be specified.
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Reinforcement / Design Criteria

Select Input | Reinforcement | Design Criteria. A dialog box appears. This command is available with
the Design option only.

Specify whether the column is to be considered STRUCTURAL (default), REEEEUEE X
ARCHITECTURAL, or OTHER. Notice that the minimum and maximum Column Type Reinforcement Fiatio
reinforcement ratios change depending on the selection. & Stuctural Minimum: [T %
Choose whether bar selection is to be based on MINIMUM NUMBER OF :ﬁ'::"::;:;a; et ||
BARS (default) or on MINIMUM AREA OF STEEL.

Bar Selection

To modify the limiting reinforcement ratios, choose OTHER. Enter the
minimum and maximum reinforcement ratios in the corresponding text
boxes.

" Minimurm number of bars

™ Minimumn area of steel

.. . . . ) Minimum clear spacing between bars: |15 in
Enter the minimum clear bar spacing and the design-to-required ratio.

Desigh/Required ratio; ,T
e Choose the OK button.
ok LCancel |
Slenderness / Factors
e Select Input | Slenderness | Factors. A dialog box appears. Note: this

Slenderness / Design Column

) . Slenderness Factors ]
command is available for slender columns only. J

™ Code defaults & ]

The default values, per the design code, for the stiffness reduction factor (used
to compute the moment magnification factors) and the cracked section
coefficients for beams and columns are displayed. To modify these values,

Stiffness reduction factor:  |0.75

Cracked-section coefficients

select the USER-DEFINED option and enter your values. Beams (clbl 35
Columns [clc): 0y
Choose the OK button.
ok Lancel |

Select Input | Slenderness | Design Column. A dialog box appears. The x-axis or y-axis data groups
may be disabled depending on the active run axis. Note: this command is available for slender columns
only.

Enter the clear column height in the corresponding text box.

Specify whether the column is braced against sidesway or not by selecting or clearing the NONSWAY
FRAME option.

Design Column g]
ez Az

For a sway column, enter the ratio of the sum of the
critical load of all story columns to the critical load

of the column under consideration, (Sum PC)/PcC.
Also, enter the ratio of the sum of the factored axial
load of all story columns to the factored axial load
of the column under consideration, (Sum Pu)/Pu.
Check 2"° ORDER EFFECTS ALONG LENGTH
option to consider 2™ order effects along length.
Note: this option is available for ACI 318-14, ACI
318-11, and ACI 318-08 codes only. For more
information, see discussion in section F — Moment
Magnification along Length of Compression

Clear height: 225 1t
" Monsway frame
+ Sway frame

Sway criteria
[Sum Pe)/[Pc): |1
[Sum Pul/[Pul: |1

v 2'nd order effects along length

Effective length factors
" Compute k' factors

+ |nput 'k factors:

Clear height: 225 It
" Monsway frame
+ Sway frame

Sway criteria
[Sum Pe)/Pc): |1
[Sum Pul/[Pul: |1

¥ 2'nd order effects along length

Effective length factors
" Compute k' factors

@+ |nput 'k factors:

Member in Chapter 2— Method of Solution. Wk [T kisp [T Wsk [T kisp 1
e In the EFFECTIVE LENGTH FACTORS group, specify ET T
whether the k factor(s) are to be user-input or - —
Ok LCancel |
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computed by the program, by selecting the corresponding option.

If you chose INPUT K FACTORS, enter the effective length factors for nonsway and sway conditions, k(ns)
and k(s), respectively.

Repeat the steps above for each active axis.
Choose the OK button.

Slenderness / Columns Above and Below

Select Input | Slenderness | Columns Above/Below. A dialog box appears. Note: this command is
available for slender columns only for which the CoMPUTE k FACTORS option is selected in the DESIGN
CoLUMN dialog box.

Columns Above and Below g]
Colurnn Above Calumi Below
™ Mo column specified ™ Mo column specified

Height(e/el  [13 ¢ Height(e/el  [13 ¢
Width (albng %) [12 4y Width (albng %) [12 4y
Depth [along ) ’T i Depth [along ) ’T i
Concrete,  fc ’4— ksi Concrete, e ’4— ksi

Ec: 3605 g4 Ec: [3605 g
Copy to Column Below | Copy to Column Above |
QK Lancel |

In the CoLUMN ABOVE group, specify whether or not a column above the design column exists, by
selecting or clearing the NO COLUMN SPECIFIED OPTION.

If a column above exists; enter the center-to-center height, the width (along the x-axis), the depth (along
the y-axis), the concrete compressive strength, and the concrete modulus of elasticity of the column
above in the corresponding text boxes. For circular sections, enter zero for the DEPTH and input the
section diameter in the WIDTH box. If zero is entered for both Width and Depth, the dimensions of the
design column will be automatically used.

Repeat the same for the column below or, if the column above and the column below are the same,
choose the Copy TO COLUMN BELOW button.

Choose the OK button.

Slenderness / X-Beams

Select Input | Slenderness | X-Beams. A dialog box appears. Beams :
defined using this command span perpendicular to the x-axis. Note: [RSEuCEELIETEIRTES) X
this command is available for slender columns only for which the
COMPUTE K FACTORS option is selected in the DESIGN COLUMN
dialog box and the RUN AXIS is BIAXIAL or uniaxial ABOUT X-AXIS.

Beam Location:
* Above Left " Above Right
" Below Left " Below Right

From the BEAM LOCATION group, choose the appropriate option. The | -BeamAbove Lef
data group below updates depending on the selection. I Ha beam specified M

For the selected beam, specify whether or not a beam exists, by | ** D

selecting or clearing the No BEAM SPECIFIED OPTION. ol 12__|LIREE 50 B

i - Depth: 15 i lnetix [3375
If a beam exists; enter the center-to-center span length, width, depth, a s ti [3375  in"d

concrete compressive strength, concrete modulus of elasticity, and — el |
Lancel
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moment of inertia (if different than computed) of the beam.

e Repeat the steps above for the beams ABOVE RIGHT, BELOW LEFT, and BELOW RIGHT.

e Choose the OK button.

Slenderness / Y-Beams

e Select Input | Slenderness | Y-Beams. A dialog box appears. Beams defined using this command span
perpendicular to the y-axis. Note: this command is available for slender columns only for which the
COMPUTE K FACTORS option is selected in the DESIGN COLUMN dialog box and the RUN AXIS is BIAXIAL

or uniaxial ABOUT Y-AXIS.

e From the BEAM LOCATION group, choose the appropriate option.
The data group below updates depending on the selection.

e For the selected beam, specify whether or not a beam exists, by
selecting or clearing the NO BEAM SPECIFIED OPTION.

o If a beam exists; enter the center-to-center span length, width,
depth, concrete compressive strength,
elasticity, and moment of inertia (if different than computed) of the

beam.

e Repeat the steps above for the beams ABOVE RIGHT, BELOW LEFT,

and BELOW RIGHT.

e Choose the OK button.

Loads / Factored

concrete  modulus of

¥ -Beams (perpendicular to Y) g]
Beam Location:
+ Above Left " Above Right
" Below Left " Below Right

Beam Above Left

[~ Mo beam speciied  Copy Fram Beam Right
Span [cdc]: 18 ft f'e: |4 ksi

“wfidth: 12 in Ec: 3605 ksi

Depth: 15 in  Inertia; [3375 w4

ok LCancel |

Whether designing or investigating a short (non-slender) column, factored loads consisting of applied axial

loads and moments about the active axis may be input.

e Select Input | Loads | Factored. A dialog box appears. Factored Loads X
- - #-homent b oment
e Enter the factored axial load in the LOAD text box. o [
e Based on the active axis, enter the factored moment about the x-axis, X- | &4 (] (kNm)
MOMENT, the factored moment about the y-axis, Y-MOMENT, or both. inset | Modiy | Delete |
e Choose the INSERT button. The data are added to the list box. Ne. P M My
1 1780 B0 100

e Repeat the steps above for each factored load entry.

e To edit an entry, select it from the list box, modify its values in the text
boxes, and choose the MODIFY button.

e To delete an entry, select it from the list box and choose the DELETE

button.
e Choose the OK button.

Loads / Service

2 2000 52 200

ok Lancel

When designing or investigating a short or slender column, service level loads consisting of dead, live, lateral
(wind and earthquake), and snow axial loads and moments at both column ends about the active axis may be
input. These loads are then factored and combined based on the load combinations.

e Select Input | Loads | Service. A dialog box appears.

e For each of the load cases: Dead, Live, Wind, Earthquake (EQ), and Snow, enter the axial load and the

applicable moment (about x or y) at the column top and bottom.

Operating the Program
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Enter the percentage of the sustained part of the load in each load case (by default only Dead Load is
assumed to be 100% sustained). These percentages will be used to arrive at sustained axial load ratio Bgns
to calculate moment magnification factor along length of the column™.

Choose the INSERT button. The data are added to the list box.
Repeat the steps above for each entry.

To edit an entry, select it from the list box, modify its values in the text boxes, and choose the MoDIFY
button.

To delete an entry, choose it from the list box and choose the DELETE button.
Choose the OK button.

Service Loads g|
Awial Load [kip]—— *-Moments [k-ft] *r-koments [k-ft] Sustained Load [%)
@ Top @ Bot @ Top @ Bot
Dead: | [350 |32 |-54 [ [ [100
Live: | [140 |20 |-36 [ [ o
Wwind: | |0 |50 |-50 [ [ o
e | o o o | | o
Snow: | [0 o o [ [ o
Inzert | Modify | Delete |

|N0. [P, b=t Mxb, Myt, Mub] for each case

Qg Lancel

Load / Control Points

A non-slender column may be investigated without inputting any loads. The capacity of the section is
computed along with other section capacity parameters. This command is not available for slender columns
or under the Design option.

Select Input | Loads | Control Points.

In the output file, key points (e.g. balanced point and pure bending) on the interaction diagram are listed.
For each point, the axial load and bending moment capacities, along with the corresponding neutral axis
depth, distance from extreme compression fiber to centroid of extreme layer of longitudinal tension steel,
net tensile strain in extreme layer of longitudinal tension steel at nominal strength, and strength reduction
factor (ACI only) are listed. For a biaxial run, these points are listed for bending about positive and
negative X and Y axes.

For ACI code, the program flags the unusual increase in axial load capacity in transition zone between
the balanced point and the tension control point (see Figure 2-3).

For uniaxial runs, the bar splice requirements for columns’ are indicated on the interaction diagram.

"For moment magnification at ends of a column in a sway frame, the value of By is assumed to be zero and is not affected by sustained
load factors (see Chapter 2, Page 2-10, Footnote 44)
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Loads / Axial Loads

When investigating a short column (uniaxial runs only), grouped factored applied axial loads may be input.
The corresponding moment capacity for each load is computed and output. This command is not available
under the DESIGN option, for biaxial runs, or if the column is slender.

Select Input | Loads | Axial Loads. A dialog box appears.

To input a range of axial loads, enter the initial, final and increment
values in the corresponding text boxes. To input a discrete (single) axial
load, enter its value in the INITIAL text box, and enter zero in the FINAL
and INCREMENT text boxes.

Choose the INSERT button. The data are added to the list box.
Repeat the steps above for each axial load entry you may have.

To edit an entry, select it from the list box, modify its values in the text
boxes, and choose the MODIFY button.

To delete an entry, choose it from the list box and choose the DELETE
button.

Choose the OK button.

Axial Loads X
Initial load Final load Inizrement
i —
[kip] [kip] [kip]
[Cinset | Modiy | Delete |
|N0. Initial Final Inz

1 B47.5 0 0

2 280

200 10

LCancel

Loads / Load Combinations

spColumn allows you to specify up to 50 load combinations. The
service load input under the load cases (dead, live, wind, earthquake,
and snow) are combined based on these combinations. A minimum of
one combination must be input.

e Select Input | Loads | Load Combinations. A dialog box appears.
For a new file, the default combinations per the selected code are

X

Load Combinations

Dead Live ‘wind EQ Sniow

[fla « 0 +o +Jo  «o
Insertl

| Cornbo Dead wiind EQ

b odify | Delete | Defau\ts|

Live Sniow

Flipping / Rotating the Section

4

shown in the list box. ﬂ% 15 1'5 5 5 it
U4 12 o [IR:] 1] 16

To add a new combination, enter the load factors or multipliers for ||[0e o2 & 18 0§ o

each load case, DEAD, LIVE, WIND, Earthquake (EQ), and SNOW. TR S oS B -
u3 03 1] 16 a 1]

Choose the INSERT button. The data are added to the list box. R
iz 1.2 1 a Bl 0z
ui3 049 1] a Bl 1]

Repeat the steps above for each load combination. Up to fifty
combinations may be defined.

To edit an entry, select it from the list box, modify its values in the
text boxes, and choose the MODIFY button.

To delete an entry, choose it from the list box and choose the
DELETE button.

Choose OK when done.

Cancel |

This command is available for Irregular sections and for sections with Sides Different or Irregular
reinforcement.

Select Input | Flip/Rotate Section. A dialog box appears.

® ACI 318-14, Fig. R10.7.5.2; ACI 318-11, Fig. R12.17; ACI 318-08, Fig. R12.17; ACI 318-05, Fig. R12.17; ACI 318-02, Fig. R12.17;
CSA A23.3-14,12.17.3; CSA A23.3-04, 12.17.3; CSA A23.3-94,12.17.3

Operating the Program
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Select one of the options: FLIP SECTION ABOUT X-AXIS, FLIP SECTION ABOUT

Y-AXIS, or ROTATE SECTION. The last option is available for irregular
sections only.

" Flip section about -awis

If ROTATE SECTION is selected, enter the angle of rotation (clockwise is | ¢ Batats sestion

pOSitiVE). i] degrees measured clockwize,
Choose the OK button. Cancel

Executing a Run

From the program

Select Solve | Results File. This is an option that may be turned ON or OFF by choosing it again. With
this option ON, an output file will be created while the program is solving. The output file is a text file
that contains an echo of the input along with slenderness calculation output, load combinations, and the
critical points on the interaction diagram.

Select Solve | Include Nominal Diagram. This is an option that may be turned ON or OFF by choosing
it again. With this option ON, calculations of nominal (unfactored) capacity interaction diagram will also
be included in the calculations so that the nominal diagram can be viewed and exported in addition to the
design (factored) capacity diagram.

Select Solve | Design Trace (design option only). This is an option that may by turned ON or OFF be
choosing it again. With this option ON, if designing a column section, the program will pause at each
cross section and reinforcement layout it tries, and display the cross section with its bars in the
Information bar.

Select Solve | Execute. If more data are needed to solve the
problem, an error box appears and you will be prompted for the
required data. If all the needed data are input, the solver portion of
spColumn will start executing. The Solving box appears with a
progress indicator. Click Cancel to terminate the solution process. _'B%
After a successful run, the interaction diagram or the contour plot

is displayed in the Graphics area of the window.

Deriving Interaction Diagram

From command prompt
spColumn run can also be executed in batch mode from the command line prompt. Input data file, output data
file, and run options can be passed to the program via parameters. For instance typing spColumn
/i:Examples\Example0l.col will run spColumn and solve the column defined in input file
Example01.col.

oo C:\WINDOWS\system32\cmd. exe

NProgran Filezss\StructurePoints\zpCo lumn >z pCo lumn oxe ZizExanplesSexanple®) . col B
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Multiple cross-sections can be designed and analyzed by executing spColumn with multiple input files using
batch (BAT) files (see Examples.bat in the spColumn program folder). Combined with Column Text Input
files (CTI), this feature can be used for automation spColumn runs for projects involving large numbers of
Ccross-sections.

Help on how to use command line parameters can be obtained by typing spColumn /2 at the command

prompt.
spColumn Command Line Help E]
i spiZolumn [ fizinput_file] [fo:output_file] [jarch|fstru] [fwind|eq] [fiad] [/csv|ft=t] [fnom] [fdxf] [femf[:eachp|:eachm|:each|:pall] :mall:all]]
L) [ie1ihelplr]
Parameters:
fi: Input data file name
o Oukput data file name
farch IF reinforcement ratio is below 196, consider column as architectural
Istru If reinforcement ratio is below 1%, consider colurn as struckural
fwind IF input File version prior to 3.50 is detected, consider lateral loads as wind loads
leq IF input File version prior ko 3.50 is detecked, consider lateral loads as earthquake laads
fiad Expart interaction diagram to IAD file that can be supetimposed in spCalumn
feay Expott interaction diagram ko Comma-Separated values file that can be imported into spreadsheet program
Jexk Expart interaction diagram to Tab-Delimited Text File that can be imparted into spreadsheet program
fmom Include nominal interaction diagram in export
Jd=f Expart calurn section to DXF file that can be imparted inko CAD program
Jemf Expart graphical reparts ko EMF files that can be imported inta graphics and waord processing software
For uniaxial runs, single P-4 diagram is exporked, For biaxial, one P-M and one Mx-My diagrams are exported.
:eachm  P-M diagrams separately for each factored load paint
ieachp  Mx-My diagrams separately for each Factored load point
ieach  P-M and Mx-My diagrams separately For each Factored load paint
mall P-M diagrams for all sorted and grouped angles of Factared resulkant moment
:pal IM:-My diagrams For all sorted and grouped levels of Factored axial load
sl P-M and Mx-My diagrams for all sorted and grouped resulkant moments and axial loads
fcti Expott input data to spColumn Text Input file
Ihelp Show this help
I Show this help
Examples:
spiZalumn fisinput. col
spColumn fiiinput. col fo:output, out fiad fdxf fosw
spiZalumn fi:Z:projiinput.cal fo:D:\projloutput. out femf
spiZalumn fisinput.col foroutput. out fiad femf:all fwind farch
Viewing Results
Once a successful run has been performed with the Solve | Results File option ON, you may view the results
file.
L]

Select View | Results. spColumn executes the spView program, an applet that enables viewing of text-

based files.

Use the scroll bars or the cursor keys to navigate through the file.

Select Exit to quit spView and return to spColumn. Changing the Startup Defaults

Changing Startup Defaults

You can change some default settings that spColumn uses when it is started or when the File | New command
is executed.

x

e Select Options | Startup Defaults. A dialog box appears. Data diractory:
e Enter the full path of the directory to which spColumn defaults when frogtan fes (8 sucturepointsColun
Opening a data file Syztem of units: IEninsh 'I
A ) A Degign code: IAEI 31814 VI
e Select the system of units, design code, and reinforcement to be used as - N S
defaults whenever a new file is started. eniercement:
Teut file viewer: Ispview
e Enter the name of the program to be used by spColumn when Viewing | wo of ines per printed page: e
results. By default, spColumn uses spView.
o Enter the number of lines per page to be used in formatting the results file. save | Concel |
e Choose the SAVE button to save these options in the registry.
Operating the Program 4-16




sfeolumn

Changing Reinforcement Bar Set

e Select Options | Reinforcement. A dialog box appears.

To select a different set:

e From the BAR SET drop-down list, select the set to be used.

Reinf t '
e Choose the OK button. e'eme" X
P Save...
To create or modify a user-defined set — —
¢ From the BAR SET drop-down list, select USER-DEFINED. The AbD, |~~~
DELETE and MODIFY buttons are enabled. o R [ e -
. . . . . in in"2 plf
e To edit an entry, select it from the list box, modify its values, and choose v oty | Dokt |
the MODIFY button. T = =
e To delete an entry, select it from the list box and choose the DELETE 01l 036
button. 05 Tow
0.44 1.502
e To add an entry, enter the bar size, diameter, area and unit weight in the REL 2
corresponding text box, and choose the ADD button. The data are added to . M.
the list box. 1222 ?12153
o A user-defined set may be saved to disk for use in other files. To do so, - =
choose the SAVE button after inputting the bars. The bar set is saved to the
file specified by the user. To retrieve a saved set, choose the READ button.
e Choose the OK button. oK Cancel

Superimposing Diagrams

After executing a run and selecting the File | Save command, the program saves the diagram data in a
separate file that has the same file name as the input file, with an IAD extension. If calculations of nominal
interaction diagram are included, the program stores also the nominal diagram data in an additional 1AD file
named as the input file name suffixed with “-nominal.iad”.

The IAD interaction diagram file may be later read by the program and two diagrams (of different files) may
be superimposed for the purpose of comparison. Note that the RUN AXIS (uniaxial or biaxial) of the two files
must be the same.

e Select View | Superimpose option. The open dialog box appears.

o All files with the IAD extension contained in the current drive and directory are displayed in the FILE
NAME list box. To open a file that exists in another drive or directory, select a different drive or directory
drive from the LOOK IN drop-down list.

e From the FILE NAME list box, select the file to be opened, or simply type its name in the text box.

e Choose the OK button. If the data is successfully read, the diagram from the IAD file (shown dotted) is
superimposed over the currently displayed diagram.

e To clear the superimposed diagram, uncheck the View | Superimpose option.

Viewing Diagrams

By default, the program displays diagrams based on the design (factored) section capacity. Display of
diagrams based on the nominal (unfactored) strength is controlled by the View | Show Nominal Diagram
option which is available when calculations of nominal diagram are activated using the Solve | Include
Nominal Diagram option.
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For a uniaxial run, the program computes and displays the P-M interaction diagram. For a biaxial run, the
program computes the three-dimensional failure surface (P, My, My). The failure surface can be viewed in one
of two ways:

a) P-M interaction diagram (vertical slice at an angle measured from Mx)
b) M,-M, contour curve (horizontal slice at a constant axial load).

Whenever the mouse cursor moves over the Graph area, the axial load, moment, and eccentricity are
displayed in the Status bar.

Viewing Interaction Diagram

Select View | P-M Diagram - Full. A dialog box appears. .
View Interaction g]

You may also select View | P-M Diagram — M positive or View | P-
M Diagram — M negative to view the interaction diagram only for
positive or negative moments.

* Angle (M, My): " Moments:
0 degrees 389 e
#1 5@ - keft

#2 43

Specify whether you want to enter an angle or the values of the # & My
moments that produce a view angle by selecting either the ANGLE or T Kkt
MOMENTS option, respectively.

If the ANGLE option was selected, select an angle from the list, use the ?

scroll bar to pick an angle, or simply enter the value in the text box. ¥ List Duplicate Paints

If the MOMENTS option was selected, enter the values of M, and M, Cancel

which define the view angle. The value of that view angle is computed
and shown in the ANGLE text box.

To display all load points and their numbers check the LIST POINT NUMBERS option. To display unique
angle values only, leave the option unchecked.

e  Choose the OK button.

e You may browse through the angles by using View | Next angle and View | [l X
Previous angle respectively. Digslyn el

0 kp 1026
Viewing Contour oo -l

o Select View | Mx-My Diagram. A dialog box appears. A

e Select an axial load from the list, use the scroll bar to pick a load, or simply enter _
the value in the text box. r

-2A9
Iv List Duplizate Points

Cancel

You may browse through the loads by using View | Next Load and View | Previous Load respectively.

To display all load points and their numbers check the LIST POINT NUMBERS
option. To display unique axial load values only, leave the option unchecked.

Choose the OK button.

Viewing 3D Failure Surface

Select View | P-M Diagram - 3D. A dialog window appears launching the spColumn 3D viewer.

Select options from the view menu or the View Controls panel to translate or rotate the failure surface as
needed. To translate, use the arrows or the corresponding shortcut of ALT and right-mouse button. To
rotate, use the rotate arrows or the corresponding shortcut of CTRL and right-mouse button.

The View menu or the View Controls Panel provides options to display the nominal surface, factored
surface, or both including several other helpful options such as planes, axes, coordinate system, load
points, zoom slider, and restore.

View Controls Panel can be collapsed or moved based on user preference from the drop down menu in
the title bar. It can also be turned off completely from the View menu.
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e Atool box provides options to cut the failure surface in the horizontal Mx-My plane and in the vertical P-
M plane for added clarity. Predefined axial load levels and surface angles are also provided for
convenience.

e Restore button will reset the 3D surface view.
e  Options menu provides setting dialog window with color, size, and opacity preferences.

e The status bar located at the bottom of the screen displays important information about the section and
relevant properties.

e Image can be exported from the main menu as a PNG file to supplement calculation or reports.

I View controls v

/ ?

/1]

[

Mx

(3

105 %

Zoom to: L

v Factored surface
V] Nominal surface
[0 Mx-My plane
[ P-Mx plane
O P-My plane

v Main axes

<

Coordinate system

<

Load points

=300

300
Dimensions: 15.375 x 11.375 [in] Concrete area: 0.000 [in’] Reinf. area: 4.800 [in’]

spColumn 3D View
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* OB 1000
Options
Horizontal cross section M-y cut above

® Custom axial load Predefined avial load

300000 P 1Kipl

' Snap to height

cut Restore

Section preview

L] L] (]

L] L]

o
L) (] [ ]

v 20
Lok

Mx = 145570 T My =203443 e P=221989 feip]

spColumn 3D View — Failure surface horizontal cross section

bl )

Vertical cross section P-M cut clockwise

Custom angle ® Prodefined angle
0,000 * aldeg)
cut Restore

0 . .
. .
. 0 .

v

T

Mx = 228453

f) My = -108766 [ty P=s27223 el

spColumn 3D View —Failure surface vertical cross section
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Dimensions: 15,375 x 11.375 fin]

By

Dimensions: 15,375 x 11.375 fin]

Concrete area: 0.000 fin’}
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ax
Zoom e (&

v Factored surface
v Nominal surface
] MMy plane
1 P-Mx plane.
CJ p-My plane

v Mainaxes

<

Coordinat system
Load points

Reinf_ares: 4800 [in']

+ +
«0% «0»
\ 4 L4
e

Zoomtor (&

v Factored surface
v Nominal surface
£ Mx-My plane
£1 p-Mx plane
£1 p-My plane
Main axes
Coordinate system
Load points

Reint.ares: 4800 [in’]
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Chapter 5

Examples

Example 1 - Capacity of a Square Column

For a column section’® which is 16” x 16” and reinforced with 4-#8 bars, calculate the load moment
capacities for the following load conditions:

x
Case 1: Bar stress near tension face of member equal to zero, (f; = 0). e
. - _ Praject:
Case 2: Bar stress near tension face of member equal to 0.5f, (f; = 0.5f,) [spColam Haruia Evarple
Case 3: At limit for compression controlled sections. (g; = 0.002) el ERETTEE
|PCaMates 6.4 5P
Case 4: At limit for tension controlled sections. (g = 0.005)
Given a concrete of 4000 psi and reinforcing steel of 60,000 psi. _IDES@” o .
ACl 318-14 A
1. From the File menu, choose New. Any input data is cleared and the
default values are restored. Units——  Run Optian
2. From the Input menu, choose General Information. (" English " Investigation
 Metric = Design
e Input the PROJECT header.
— Run Axi
e Select English units and ACI 318-14 code. & AboutMdss € Biwkal
e Select About X-axis for run axis, Investigation for run option and | | © #BoutY#ss
No for Consider slenderness? Consider slendemess?  Yes & Mo
e Choose OK. x| Cancel

3. From the Input menu, choose Material Properties.
e Accept the default properties as they match those in the problem statement

e Choose OK.

x
— Concrete — Reinfarcing Stesl
Strength, f'c: ksi Strength, fu IED ks

¥ Standard v Standard

|4
Elasticity. Ec: |3su5 ksi EIasticily,Es:|29EIDU ksi
Max shress, fo: |3.4 ksi
| 5

Beta[1]: 0.8 Compression-contralled strain limit,

Ultimate strain: (0003 Eps_ut: ID.DDZDBBS?

%

LCancel |

4. From the Input menu, choose Section | Rectangular.
e  For the section WIDTH (ALONG X), input 16

e  For the section DEPTH (ALONG Y), input 16.

® Based on Example 6.4, pp 6-33 from Notes on ACI 318-11 Building Requirements for Structural Concrete with Design Applications,
Edited by Mahmoud E. Kamara and Lawrence C. Novak, Twelfth Edition, 2013, Portland Cement Association.




sfeolumn

10.

e Choose OK.

Al Sides Equal X

Mo, of bars: Bl Lyt

& Rectangular

) Bar size: -
Rectangular Section g| 4 ! Circular
Clear cover: |1.5 in
‘width [along X): in
Cover to

Depth [along ). |16 in

+ Transverse bars ¢ Longitudinal bars

ak. LCancel | ok LCancel

From the Input menu, choose Reinforcement | All Sides Equal.

e Input 4-#8 bars under NO. OF BARS.

e Input 1.5 in for the CLEAR COVER and select TRANSVERSE BARS. under COVER TO.
e Choose OK.

From the Input menu, choose Loads | Control Points.
From the Solve menu, choose Execute.
e The P-My contour is displayed in the Graphics area.

From the View menu, choose Results.
e Page through the results file.

e Choose File | Exit to quit the spView program and get back to spColumn.

From the File menu, choose Print Results.
e Select the printer to send the text results to.

e Choose PRINT.

From the File menu, choose Print Screen.
e  Select the printer to send the graphical results to.

e Choose PRINT.

Examples
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16 x 16 in

Code: ACI 318-14

Units: English

Run axis: About X-axis

Run option: Investigation
Slenderness: Not considered
Column type: Structural
Bars: ASTM A615

Date: 12/18/15

Time: 15:38:08

P (kip)
1200
////77 \\\\
///' 1 \\\
‘\‘\‘ /‘/
/
\\\ ///
., S
\‘\ //
\\ /,//
| | \‘\I | | \/f’/ | | |
T I\\ T T //f T T 1
N e 250
N g
o Mx (k-ft)
\\\ // '/
(Pmin) -200 ¥ (Pmin)

spColumn v5.00. Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-23E97

Column: PCANotes 6.4
f'c = 4 ksi

Ec = 3605 ksi

fc = 3.4 ksi

e u=0003infn
Beta1=0.85

Confinement: Tied

Project: spColumn Manual Example 1

fy =60ksi
Es =29000 ksi
e_yt = 0.00206897 in/in

phia) = 0.8, phi(b) = 0.9, phi(c) = 0.65

Engineer: SP

Ag = 256 in"2

As =3.16In"2

Xo =0.00in

Yo =0.00in

Min clear spacing = 10.25 in

File: C:\Program Files (x86)\StructurePoint\spColumnExamples\Examples-ManualExample01.col

4 #8 bars

rho =1.23%

Ix = 5461.33 in"4
ly = 5461.33 in™4

Clear cover = 1.88 in

Examples
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STRUCTUREPOINT - spColumn v5.00 (TM) Page 2
Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-23E97 12/18/15
C:\Program Files (x86)\StructurePointispColumn\Examples\Examples-ManualiExampleOl.col 03:36 PM

General Information:

File Name: C:\Program Files (x86)\StructurePoint\spColumn’\Examples\Examples-Manual\ExampleOQl.col
Project: spColumn Manual Example 1

Column: PCANotes 6.4 Engineer: SP

Code: ACTI 318-14 Units: English

Run Option: Investigation Slenderness: Not considered
Run Axis: X-axis Column Type: Structural

Material Froperties:

Concrete: Standard Steel: Standard

f'e = 4 ksi fy = 60 ksi

Ec = 3005 ksi Es = 29000 ksi

fc = 3.4 ksi Eps_yt = 0.00206897 in/in

Eps_u = 0.003 in/in
Betal = 0.85

Section:
Rectangular: Width = 16 in Depth = 16 in
Gross section area, Ag = 256 in"Z
Iz = 5461.33 in~4 Iy = 5461.33 in~4
rz = 4.6188 in ry = 4.6188 in
Xo = 0 in Yo = 0 in
Reinforcement:

Bar Set: ASTM A61S

Size Diam (in) Area (in"~2) Size Diam (in) Area (in"2) Size Diam (in) Area (in"2)
# 3 0.38 0.11 # 4 0.50 0.20 # 5 0.63 0.31
# 6 0.75 0.44 # 7 0.88 0.60 # 8 1.00 a.79
# 09 1.13 1.00 # 10 1.27 1.27 # 11 1.41 1.56
# 14 1.69 2.25 # 18 2.26 4.00

Confinement: Tied; #3 ties with #10 bars, #4 with larger bars.
phi{a} = 0.8, phith) = 0.9, phi{c} = 0.65

Layout: Rectangular

Pattern: All Sides Egual (Cover to transverse reinforcement)
Total steel area: As = 3.16 in"2 at rho = 1.23%

Minimum clear spacing = 10.25 in

4 #8 Cover = 1.5 in

Control Polnts:

Axial Load P X-Moment Y-Moment NA depth Dt depth eps_t Phi
Bending about kip k-ft k-ft in in
X B Max compression 682.0 0.00 0.00 43,90 13.63 -0.00207 0.650
B Allowable comp. 545.6 72.20 0.00 15.81 13.63 -0.00041 0.650
@ fs = 0.0 467.6 10Z2.64 0.00 13.63 13.63 -0.00000 0.650
@ fs = 0.5*%fy 331.8 135.43 0.00 10.13 13.63 0.00103 0.650
@ Balanced point 236.9 146.49 0.00 §.06 13.63 0.00207 0.650
B Tension control 186.7 172.04 0.00 5.11 13.63 0.00500 0.800
B Pure bending -0.0 91.03 0.00 2.24 13.63 0.01528 0.800
B Max tension -170.0 0.00 0.00 0.00 13.63 9.99899 0.800
-¥ @ Max compression 682.0 0.00 0.00 43,90 13.63 -0.00207 0.650
@ Allowable comp. 545.6 -7z.20 -0.00 15.81 13.63 -0.00041 0.650
B fs = 0.0 467.6 -10z2.64 -0.00 13.63 13.63 -0.00000 0.650
B fs = 0.5*fy 331.8 -135.43 -0.00 10.13 13.63 0.00103 0.650
B Balanced point 236.9 -146.49 -0.00 8.06 13.63 0.00207 0.650
B Tension control 188.7 -172.04 -0.00 5.11 13.63 0.00500 0.800
@ Pure bending -0.0 -91.03 -0.00 2.24 13.63 0.01528 0.800
B Max tension -170.6 0.00 0.00 0.00 13.63 9.99899 0.500

**+ End of ocutput ***
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Example 2 - Investigation of a Slender Nonsway Column

Determine the adequacy of a 4” x 20” column’’ with 3-#11 bars on each 14” side in a nonsway frame with a

clear height of 22°6”. Use k=1.0.
The concrete used is 6000 psi and the reinforcing steel is 60,000 psi.

The factored load values for the column under consideration are as follows:

P (kip) 115 kips
Top My, (Kip-ft) 279 ft-kips
Bottom M,y (kip-ft) -279 ft-kips

From the File menu, choose New. Any input data is cleared and the default
values are restored.

1.

2.

From the Input menu, choose General Information.
e Input the PROJECT header.

e Select ENGLISH units and ACI 318-14 code.

e Select Biaxial for run axis, Investigation for run option and Yes for
Consider Slenderness?

e Choose OK.

From the Input menu, choose Material Properties.

e Input 4.5 for the CONCRETE STRENGTH. Change the REINFORCING
STEEL STRENGTH to 50. Other properties are computed and will be

accepted.
e Choose Ok.

x

— Concrete — Reinforcing Steel
Strength, f'c: I-'15— ksi Strength, fy: ISD— ksi
I¥ Standard Iv Standard
Blasticiy. Ec: [582368  ksi | | Elastioty. Es/[25000  ksi
Max stress, fo: IW ksi
Beta[1]): W Compression-controlled strain limit,
Ultimate strain: W Eps vt IW

ITI LCancel |

E
r— Label
Project:
IspEqumn M anual Example 2
Column; Engineer:
[warg 15185 ]
— Design Code
|ac 31814 =l
— Units Fiun Option
' English ' |nvestigation
" Metic " Design
— Run &
7 About Kbz *' Biavial
7 About iz

Consider slenderness? % Yes Mo

LCancel

From the Input menu, choose Section | Rectangular.

e Input 20 and 14 for the section width (along X) and depth (along Y).

e Choose OK.

" Based on Example 15.8.5 from Reinforced Concrete Design by Chu-Kia Wang, Charles G. Salmon, and Jose A. Pincheira, Seventh
Edition, 2007, John Wiley and Sons, Inc.

Examples
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x
Top  Bottom  Left Right

No. of bars: |2 E f1 |

Barsize: |11 x| [#11 x| [#11 =] 411 =]

Clear cover. [1.5 1.5 1.5 1.5 in

Rectangular, Section E|

width (slong ) B in "Eover ta

" Tiansverse bars % Longitudinal bars

Depth [along Y] |14 in

ak | Cancel | ak. I Cancel |

3. From the Input menu, choose Reinforcement | Sides Different.

e Input 2-#11 bars for Top and BoTTOM and 1-#11 for LEFT and RIGHT. Input 1. 5 in for the cover
and select LONGITUDINAL BARS.

e Choose OK.

4. From the Input menu, choose Slenderness | Design Column.
e Input 22.5 for the column CLEAR HEIGHT.

e Check NoNsWAY FRAME and select INPUT ‘K’ FACTORS.

e Choose OK.

Design Column g|
bz r-Ais
Clear height: Clear height: 225 ft
% Monsway frame + Monsway frame
" Sway frame " Sway frame
Sway criteria Sway criteria
{SumPe)iPer [ [SumPeliPel [I
(SumPuiPur [ SumPulAPuL [I
= V
Effective length factors Effective length factors
" Compute k' factars " Compute 'k’ factars
& |nput k' factars: @+ |nput k' Factors:

kins): 1 k[z): kins): 1 k[s):
Copy to 'Y-dxiz Copy to z-duis

oK LCancel |

5. From the Input menu, choose Loads | Service.

e Under LIVE, input 71.875 for the AXIAL LOAD, 0 for the X-MOMENTS @Tor, 0 for the X-
MOMENTS @BoOT, 174.375 for the Y-MOMENTS @TopP and -174.375 for the Y-MOMENTS
@BOTTOM, respectively.

e In column SUSTAINED LOAD keep default setting for dead load equal 100%.
e Choose INSERT to add the entry to the list box.

e Choose OK .

Examples 5-6
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6.

7.

8.

X

Service Loads
Aivial Load [kip)— - =-Moments [k-ft] *r-Moments [kft) Sustained Load [%]
@ Top @ Bot @ Top @ Bot
Dead | [0 o [ o o 100
Live: | [71.875 o o [174375  |174375 o
wind | [0 o [ o o o
EQ: o 0 o o o o
Snow: | [0 o [ o o o
Inzert | Modify | Delete ‘

|NU. [P, bdat, Mub, Myt, Myb] for each caze

ak. LCancel |

From the Input menu, choose Loads | Load Combinations.

If the list displays thirteen combinations, choose only the second load combination U2 and delete all
the others by selecting them and using DELETE. Choose OK.

Load Combinations El
Dead Live “ind EQ Show

1.2 + 1B + |0 + |0 + |05
Inzert | I odify | Delete | Defaults|

| ComboDead  Live wind  EQ Shaw

L1 1.2

aK Cancel

From the Solve menu, choose Execute.

The solver of the program is started and, upon completion, displays the interaction diagram of the
section with the load point plotted within the diagram.

From the View menu, choose Results.

Page through the results file.

Examples
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e Choose FILE | EXIT to quit the spView program and get back to spColumn.
9. From the File menu, choose Print Results.

e Select the printer to send the text results to.

e Choose PRINT.
10. From the File menu, choose Print Screen.

e  Select the printer to send the graphical results to.

e Choose PRINT.

Examples 5-8
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Confinement: Tied
phifa) = 0.8, phi(b) = 0.9, phi(c) = 0.65

kx(nonsway) = 1

ky(nonsway) =1

/// L‘\\\
y - | ™,
7 )
+-x /
/’/
/(F/’max)
C
,/
/
//
/’
20 x 14in
Code: ACI 318-14 . /
Units: English \‘x\
Run axis: Biaxial N
a B ——
Run opticn: Investigation -600 N 600
Slenderness: Considered N / M (88°) (k-f)
Column type: Structural
Bars: ASTM AG15 RN
(Pmin) e (Pmin)

Date: 12/18/15
Time: 15:45:53 -600 -

spColumn v5.00. Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-23E97

File: C:\Program Files (x86)\StructurePoint\ispColumn\Examples\Examples-ManualExample02.col

Project: spColumn Manual Example 2

Column: Wang 15.18.5 Engineer: 8P

fc = 4.5 ksi fy =50 ksi Ag=280in"2 6 #11 bars

Ec = 3824 ksi Es =29000 ksi As =9.36in"2 rho = 3.34%

fc = 3.825 ksi e_yt=0.00172414infin  Xo =0.00in Ix = 4573.33 in*4

e_u=0.003 infin Yo =0.00in ly = 9333.33 in"4

Beta1 = 0.825 Min clear spacing =3.39 in  Clear cover = 1.50 in

kx(sway) = N/A
ky(sway) = N/A

Examples
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600 —

My (k-ft)

Mx (k-ft)
20x14in 1 1 1 1 1 1 1 1 I
-600 600
Code: ACI 318-14
Units: English
Run axis: Biaxial "\
Run option: Investigation \
Slenderness: Considered \
Column type: Structural o 1
Bars: ASTM A615
Date: 12/18/15 T
Time: 15:46:13
-600 -
P =115 kip
spColumn v5.00. Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-23E97
File: C:\Program Files (x86)\StructurePoint\spColummExamples\Examples-Manual\Example02.col
Project: spColumn Manual Example 2
Column: Wang 15.18.5 Engineer: SP
f'c=45ksi fy =50 ksi Ag =280 in"2 6 #11 bars
Ec = 3824 ksi Es =29000 ksi As =9.36in"2 rho =3.34%
fc = 3.825 ksi e_yt=0.00172414 infin  Xo =0.00in [x = 4573.33 in"4
e_u=0.003infin Yo =0.001in ly=9333.33in"4
Betal = 0.825 Min clear spacing=3.39in  Clear cover = 1.50 in
Confinement: Tied kx(nonsway) =1 kx(sway) = NFA
phi(a) = 0.8, phi(b) = 0.9, phi(c) =0.65 ky(nonsway) = 1 ky(sway) = N/A
Examples 5-10
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STRUCTUREPOINT - spColumn v5.00 (TM) Page 2
Licensed to: StructurePoint. License ID: 00000-0000000-4-2R05D-23E97 12/18/15
C:\Program Files (x86)\StructurePointispColumn\Examples\Examples-ManuallExampled2.col 03:45 PM
General Information:
File Name: C:\Program Files (x8¢)‘\StructurePoint)\spColumn\Examples\Examples-Manual\Examplet2.col
Project: spColumn Manual Example 2
Column: Wang 15.18.5 Engineer: SP
Code: ACTI 318-14 Units: English
Run Optieon: Investigation Slenderness: Considered
Run Axis: Biaxial Column Type: Structural
Material Properties:
Concrete: Standard Steel: Standard
f'e = 4.5 ksi fy = 50 ksi
Ec = 3823.68 ksi Es = 29000 ksi
fc = 3.825 ksi Eps_yt = 0.00172414 in/in
Eps u = 0.003 in/in
Betal = 0.825
Section:
Rectangular: Width = Z0 in Depth = 14 in
Gross section area, Bg = 280 in~2
Iz = 4573.33 in™4 Iy = 9333.33 in"~4
rz = 4.04145 in ry = 5.,7735 in
X¥o = 0 in Yo = 0 in
Reinforcement:
Bar Set: ASTM A615
Size Diam {in) Area (in"2) Size Diam (in) Area (in"2) Size Diam (in) Area (in~2)
# 3 0.38 0.11 # 4 0.50 0.20 # 5 0.63 0.31
# 6 0.75 0.44 # 7 0.88 0.60 # 8 1.00 0.79
# 9 1.13 1.00 # 10 1.27 1.27 # 11 1.41 1.56
# 14 1.69 2.25 # 18 2.26 4.00
Confinement: Tied; #3 ties with #11 bars, #4 with larger bars.
phifa) = 0.8, phi{bk) = 0.9, phiic) = 0.65
Layout: Rectangular
Pattern: Sides Different (Cover to longitudinal reinforcement)
Total steel area: As = 9.36 in"™2 at rho = 3.34%
Minimum clear spacing = 3.39 in
Top Bottom Left Right
Bars 2 #11 2 #11 1 #11 1 #11
Cover (in) 1.5 1.5 1.5 1.5
Service Leads:
Load Axial Load Mz B Top Mx B Bot My B Top My B Bot
No. Case kip k-ft k-ft k-ft k-ft
1 Dead 0.00 0.00 0.00 0.00 0.00
Live 71.88 0.00 0.00 174.38 -174.38
Wind 0.00 0.00 0.00 0.00 0.00
EQ 0.00 0.00 0.00 0.00 0.00
Snow 0.00 0.00 0.00 0.00 0.00
Sustained Load Factors:
Load Factor
Case (%)
Dead 100
Live 0
Wind 0
EQ o]
Snow o]
Ul 1.200*Dead + 1.600*Live + 0.000*Wind + 0.000*EarthQuake + 0.500*Snow
Examples 5-11
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STRUCTUREPCINT - spColumn v5.00 (TM) Page 3
Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-23E97 12/18/15
C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example02.col 03:45 PM
Slenderness:
Sway Criteria:
X-axis: Nonsway column.
Y-axis: Nonsway column.
Height Width Depth I fre Ec
Column Axis ft in in in~4 ksi k=i
Design X 22.5 zZ0 14 4573.33 4.5 3823.¢68
Y 22.5 20 14 9333.33 4.5 3823.68
Above X (no column specified...)
Y {no column specified...
Below X {no column specified...)
Y {no column specified...
X-Beams Length Width Depth I f'c Ec
Location fr in in in™4 ksi ksi
Above Left (no beam specified...)
Above Right (no beam specified...)
Pelow Left (no beam specified...)
Below Right (no beam specified...)
Y-Beams Length Width Depth I fre Ec
Location ft in in in~4 ksi ksi
Above Left (no beam specified...)
Above Right (no beam specified...)
Below Left (no beam specified...)
Below Right (no beam specified...)
Effective Length Factors:
Axis Psi(top) Psi(bot) k (Nonsway) k(Sway) klu/r
X 0.000 0.000 1.000 (N/R) 66.81
T 0.000 0.000 1.000 (N/R) 46.77
Moment Magnification Factors:
Stiffness reduction factor, phi(K) = 0.75
Cracked-section coefficients: c¢I{beams) = 0.35; cI{columns) = 0.7
0.2*Ec*Ig + Es*Isgse (X-axis) = 7.66e+006 kip-in~2
0.2*Ec*Ig + Es*Ise (Y-axis) = 2.36e+007 kip-in~2
X-axis - At Ends —-——------——-—-—--- oo Along Length --——-----------—-
Ld/Comb SumPu(kip) Pc(kip) SumPc(kip) Betads Deltas Pu(kip) k'lu/r Pcikip) Betad Cm Delta
171 (N/A) (N/A) (N/A) (N/A) (HM/R) 115.00  (N/A) 1036.7% 0.000 1.000 1.174
Y-axis - At Ends -——------————————— Along Length -—————---—---———-

(N/RY  (N/RB) (N/R) 115.00

Pcl(kip) SumPci{kip) Betads Deltas

Factored Moments due to First-Order and Second-Order Effects:

Minimum eccentricity,
Minimum eccentricity,

Ex,min = 1.
Ey,min = 1.

02 in
2 in

NOTE: Each loading combination includes the following cases:

First line - at column top
Second line - at column bottom
X-axis -----——---———- 1st Order
Load Mns Ms
Combo k-ft k-ft
1 01 0.00 (N/R)
-0.00 {1/ A)
Y-axis —----—----—-—- 1st Order
Load Mns Ms
Combo k-ft k-ft
1 01 279.00 (N/B)
279.00 (N/R)

Mu Mmin
k-ft k-ft
0.00 9.78 M1
-0.00 9.78 MZ=
Mu Mmin
k-ft k-ft
279.00 11.50 Ml=
2759.00 11.50 M2

Pc(kip) Betad Cm Delta

(N/R) 3199.

27 0.000 1.000 1.050

77777777 - Ratio -
M 2nd/1lst
k-ft
11.47 1.174
11.47 1.174
77777777 - Ratio -
Mo 2nd/1st
k-ft
283.04 1.050
263.04 1.050

Examples
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STRUCTUREBOINT - spColumn v5.00 (TM) Page 4
Licensed to: StructurePoint. License ID: 00000-0000000-4-2AQ5D-23E97 12/18/15
C:\Program Files (x86)\StructurePointispColumni\Exanplesi\Examples-ManualiExample02 . .col 03:45 PM
Factored Loads and Moments with Corresponding Capacities:
NOTE: Each lcading combination includes the following cases:
First line - at column top
Second line - at column bottom
Load Pu Mux Muy PhiMnsx PhiMny PhiMn/Mu NA depth Dt depth eps_t Phi
No. Combo kip k-ft k-ft k-ft k-ft in in
1 17Ul 115.00 11.47 293.04 13.83 353.32 1.206 5.19 18.77 0.00810 0.900
2 115.00 11.47 293.04 13.83 353.32 1.206 5.19 18.77 0.00810 0.900

*** End of output ***

5-13
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Example 3 - Design of a Slender Column in a Sway Frame

Design a square column’® with a clear height of 16 ft. The column is sway and subjected to dead, live and

wind loads as shown below.

Dead Live
P (kip) 380 140
Top My (Kip-ft) 32 20
Bottom My (Kkip-ft) 54 36

Wind
0

50

50

The column is to be checked for the following load combinations:

Ul=12D+16L
U2=12D+05L+16W

The calculations in the reference are done based on the load combination U2.

In practice, the ratio P,/ P, would have to be calculated before the problem
can be attempted, using a trial value of XP./P.. Here, the value of P /P, used
is 28.67 based on the reference value of P.. There are 14 interior columns, 18

exterior columns and 4 corner columns.

Therefore,

the value of

YP/P =14 +18*2/3+4*1/3 =27.33 irrespective of the load combination

being used.

1. From the File menu, choose New. Any input data is cleared and the

default values are restored.

2. From the Input menu, choose General Information.

e Input the PROJECT header.
e  Select English units and ACI 318-14 code.

e Select About X-Axis for run axis, Design for run option and Yes for

Consider slenderness?

e Choose OK.

3. From the Input menu, pick Material Properties.

General Information |

 Labels
Froject:

IspEqumn M anual Example 3
Colurmn: Engineer:

IHassoun 124 SP

— Deszign Code

Jaci 31814 =l

Fun Option
’7 7 Irvestigation

& Desigh

— Units
@ English
" Mehic

r Run A
% Ahout Kbz " Biawial

1 About Y-eis

Consider slendemess? & Yes £ No

LCancel

e Input 5 for the concrete strength. Other properties are computed and will be accepted.

e Choose OK.

x
— Concrete — Reinforcing Steel

Strength, f'c: |5— ksi Strength, fy: IBD— ki

¥ Standard ¥ Standard

Elastisiy Ec: [J03051  ksi | | Elastioly. Ex[20000  ksi

Max stress, fo: |425— ks

Beta(1): E Compression-controlled strain limit,

Ultirnate: strair: W Epz yt: W

Lancel |

" Based on Example 12.4, pp 409, from Structural Concrete: Theory and Design by M. Nadim Hassoun and Akthem Al-Manaseer,

Fourth Edition, 2008, John Wiley and Sons, Inc.

Examples
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4. From the Input menu, pick Section | Rectangular.

e Input 18 and 18 for the WIDTH (ALONG X) and DEPTH (ALONG Y) under both START and END
options.

e Choose OK.

Rectangular Section

Start End  Increment

‘width [along »): 18 0 in
Depth [along Y] |18 18 0 in

Ok Lancel |

5. From the Input menu, choose Reinforcement | All Sides Equal

e Input 4-#10 bars for Minimum, and 40-#10 bars for Maximum and 1. 5 in for the cover, and select
TRANSVERSE BARS and RECTANGULAR Bar Layout.

e Choose OK.

All Sides Equal X

Cover ta
Minirnurn b awimum
(* Transverse barg

Ho. of bars: 40 ™ Longitudinal bars

Bar size: # :l' m Bar Layout
Iy
Clear cover: 1.5 in Rectangular

™ Circular

ok LCancel |

6. From the Input menu, choose Slenderness | Design Column.
e Input 16 for the column CLEAR HEIGHT.

e Check SwAY FRAME

e Under SWAY CRITERIA, input 28. 67 and 27 . 33 for the ZPc/Pc and ZPu/Pu, respectively.
e Leave 2"° ORDER EFFECT ALONG LENGTH option checked (default)

e Select COMPUTE ‘K’ FACTORS.

e Choose OK.

Examples 5-15
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7.

Design Column &
Hediiz s —
Clear height: ft Clear height: ,_ ft
" Monsway frame o
+ Sway frame {+
Sway criteria Sway criteria
{Sum Pc)/(Pe) [2867 {Sum PPl [2065
{Sum Pul/{Pu: [27.33 {Sum PujPu [21 74
v 2'nd order effects along length I
Effective length factors Effective length factors
+ Compute 'k' factors -
" Input 'k’ factors: {+
kfnak [0005 K(sk 1405 kinsl [0 kisp [0
_ comoiens | _ comioiians |
Ok LCancel |

From the Input menu, choose Slenderness | Columns Above/Below.

Clear the NO COLUMN SPECIFIED option.

Input 11 for the column height (center-to-center) under HEIGHT (C/C) and leave the other data as is.

Choose Copy to Column Below.
Choose OK.

Columns Above and Below

Column &bove Column B elow

™ Nocalumn specified

Height [/c): '11_ t Height [c/c): '11_ t

Width (along %1 [18 iy Width (along %1 [18 s
Depth [along ) ’T i Depth [along ) ’T i
Concrete,  fo '5— ksi Concrete,  fo '5— ksi

Ec: |4030. 4 Ec: [4030. g
Copy to Column Below | Copy to Column Above |
ok LCancel |

X

From the Input menu, choose Slenderness | X-Beams.

Choose ABOVE LEFT.

Clear the NO BEAM SPECIFIED option.

Input 20 for the span (center-to-center) under SPAN(C/C).
Input 0.00 and 0. 00 for the WIDTH and DEPTH, respectively.
Input 21436. 6 for the moment of inertia under INERTIA.
Leave the other data as it is.

Choose ABOVE RIGHT and click on CoPy FROM BEAM LEFT.
Choose BELow LEFT and click on CopY FROM BEAM ABOVE.

Choose BELOW RIGHT and click on CorY FROM BEAM ABOVE.

Examples
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9.

Choose OK.

%-Beams (perpendicular to X)

" Below Left

Span [cfc):
didth:

Depth:

Beam Location:

" Abave Right
" Below Right

Bieam &bove Left

[~ Mobeam specified  Copy From Beam Right

ki

20 & fe: |5

0 in Ec: [4030.57 ksi
1] in  Inertia; |21436.6 "4

u] 4 LCancel

3

From the Input menu, choose Loads | Service.
Under DEAD, input 380, 32 and -54 for the AXIAL LOAD, X-MOMENTS and Y-MOMENTS

respectively.

Under LIVE, input 140, 20 and -36 for the AXIAL LOAD, X-MOMENTS and Y-MOMENTS,

respectively.

Under WIND, input 0, 50 and -50 for the AXIAL LOAD, X-MOMENTS and Y-MOMENTS,

respectively.

Service Loads

Live:
Wind:
EQ:

Snow

Dead:

Axial Load (kip] —— #-Maments [k-ft] -Moments (k-ft] Sustained Load [%]
@ Top (3 Bat @ Top (@ Bat

280 |22 |54 | [ [100

[120 20 |36 [ [ [o

o |50 |50 [ [ o

o o o \ | [0

o o o \ | [0

Inzert ‘ Modify | Delete |

|No. [P. Mt Mxb, Myt, Mpb] for each case

ag Lancel |

Under SUSTAINED LOAD keep the default settings of 100% for dead and 0% for all other load cases.

Choose INSERT to add the entry to the list box.

Choose OK.

10. From the Input menu, choose Loads | Load Combinations.

If the list displays thirteen combinations, leave the first and second as they are. Delete the remaining
combinations using DELETE.

Examples
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Load Combinations |
11. From the Solve menu, choose Execute. : : —
Dead Live Wind EQ Show

e The solver of the program is started and, upon « o5 + e+ «[os
completion, displays the interaction diagram of the

section with the load points plotted within the diagram. roen | _wodty | Dete | etats |
) | Combo Dead Live “Wind EQ Shiow
12. From the View menu, choose Results. T = - n o

e Page through the results file.

e Choose Exit to quit the spView program and get back to
spColumn.

13. From the File menu, choose Print Results.
e Select the printer to send the text results to.
e Choose PRINT.
14. From the File menu, choose Print Screen.
e  Select the printer to send the graphical results to.
e Choose PRINT.

ak Cancel
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Confinement: Tied

phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65

kx(nonsway) = 0.802212

ko¢(sway) = 1.38998

O O O O
o y O
O O ,,/ // \\\\
fs=0 //’ (Pmax) 1 (Pmax) ‘\\ fs=0
A
© 0O O ©
// \ /,/ \\
S / \\\ /'/ 5,
f8=05fy '/'/ fs=0 B fs=0 "‘\ f8=05fy
‘L?i\k ,/>(\/
/ A L e \
18 % 18 in fs=0.5fy —+rt2 fs=0.5fy A
Code: ACI 318-14 \ ]
Units: English
Run axis: About X-axis o ‘ ‘ | ‘ ‘ ‘ P
I LI T T T T T T T T ST 1
Run option: Design -600 \\ // 600
-~ < MIx (k-ft
Slenderness: Considered S s ()
. e
Column type: Structural S i e
Bars: ASTM A615 ‘\\\ //
Date: 12/18/15 (Pmln) ~. o - (Pmln)
Time: 15:47.41 -1000 -
spColumn v5.00. Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-23E97
File: C:\Program Files (x86)\StructurePoint\sspColummExamples\Examples-Manua\Example03.col
Project: spColumn Manual Example 3
Column: Hassoun 12.4 Engineer: SP
f'c =5 ksi fy =60ksi Ag =324 in"2 12 #10 bars
Ec = 4031 ksi Es =29000 ksi As =15.24in"2 rho = 4.70%
fc = 4.25 ksi e_yt=0.00206897 infin  Xo =0.00in Ix = 8748 in*4
e u=0.003infin Yo =0.00in ly = 8748 in"4
Beta1=0.8 Min clear spacing = 3.06 in  Clear cover =1.88 in

Examples
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STRUCTUREPOINT - spColumn v5.00 (TM) Page 2
Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-23E97 12/18/15
C:\Program Files (x86)\StructurePointispColumn\Examples\Examples-ManualiExample03.col 03:47 PM
General Information:
File Name: C:\Program Files (x86)\StructurePoint\spColumn’\Examples\Examples-Manual\Example03.col
Project: spColumn Manual Example 3
Column: Hassoun 12.4 Engineer: SP
Code: ACTI 318-14 Units: English
Run Option: Design Slenderness: Considered
Run Axis: X-axis Column Type: Structural
Material Properties:
Concrete: Standard Steel: Standard
f'e = 5 k=i fyv = 60 ksi
Ec = 4030.51 ksi Es = 29000 ksi
fc = 4.25 ksi Eps_yt = 0.00206897 in/in
Eps u = 0.003 in/in
Betal = 0.8
Section:
Rectangular: Width = 18 in Depth = 18 in
Gross section area, Ag = 324 in~2
Iz = 8748 in~4 Iy = 8748 in~4
rz = 5.19615 in ry = 5.19615 in
Xo = 0 in Yo = 0 in
Reinforcement:
Bar Set: ASTM A615
Size Diam (in) Area (in~2) Size Diam (in) Area (in~2) Size Diam (in) Area (in~2)
# 3 0.38 0.11 # 4 0.50 0.20 # 5 0.63 0.31
¥ 6 0.75 0.44 # 7 0.88 0.60 # 8 1.00 0.79
# 09 1.13 1.00 # 10 1.27 1.27 # 11 1.41 1.5¢6
# 14 1.69 2.25 # 18 2.26 4.00
Bar selection: Minimum number of bars
Asmin = 0.01 * Ag = 3.24 in"Z2, Asmax = 0.08 * Ag = 25.92 in"2
Confinement: Tied; #3 ties with #10 bars, #4 with larger bars.
phi{a) = 0.8, phif(b) = 0.9, phi{c} = 0.65
Layout: Rectangular
Pattern: All Sides Egual (Cover to transverse reinforcement)
Total steel area: As = 15.24 in"Z at rho = 4.70%
Minimum clear spacing = 3.06 in
12 #10 Cover = 1.5 in
Service Loads:
Load Axial Load Mz B Top Mx @ Bot My B Top My B Bot
No. Case kip k-ft k-ft k-ft k-ft
1 Dead 380.00 32.00 -54.00 0.00 0.00
Live 140.00 20.00 -36.00 0.00 0.00
Wind 0.00 50.00 -50.00 0.00 0.00
EQ 0.00 0.00 0.00 0.00 0.00
Snow 0.00 0.00 0.00 0.00 0.00
Sustained Load Factors:
Load Factor
Case (%)
Dead 100
Live 0
Wind 0
EQ 0
Snow 0
Load Combinations:
Ul 1.200*Dead + 1.600*%Live + 0.000*Wind + 0.000*EarthgQuake + 0.500*Snow
Uz2 = 1.200%Dead + 0.500%Live + 1.600*Wind + 0.000*EarthQuake + 0.500*Snow
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STRUCTUREPOINT - spColumn v5.00 (TM) Page 3
Licensed to: StructurePcint. License ID: 00000-0000000-4-ZA05D-23E97 12/18/15
C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example03.col 03:47 PM
Slenderness:
Sway Criteria:
X-axis: 8Bway column. SumPc = 28.67 * Pc SumPu = 27.33 * Pu
Second-order effects along length considered
Height Width Depth I f'c EcC
Column Axis ft in in in™4 ksi ksi
Design X 16 18 18 8748 5 4030.51
Above X 11 18 18 §748 5 4030.51
Below X 11 18 18 8748 5 4030.51
X-Beams Length Width Depth I f'c Ec
Location ft in in in~4 ksi ksi
Above Left 20 0 0 2143¢6.6 5 4030.51
Above Right 20 0.0001 0.0001 21436.6 5 4030.51
Below Left 20 0.0001 0.0001 21436.6 5 4030.51
Below Right 20 0.0001 0.0001 2143¢6.6 5 4030.51
Effective Length Factors:
Axis Psi{top) Psi (bot) k (Nonsway) k (Sway) klu/r
X 1.252 1.252 0.802 1.390 51.36
Moment Magnification Factors:
Stiffness reduction factor, phi(K) = 0.75
Cracked-section coefficients: cI{beams) = 0.35; cI{columngs) = 0.7
0.2*Ec*Ig + Es*Ise (X-axis) = 2.02e+007 kip-in~2
X-axis -———---—-——————————— At Ends -——--—-----------— oo Along Length --——------------—
Ld/Comb SumPu (kip) Pcikip) SumPc(kip) Betads Deltas Puikip) k'lu/r Pc(kip) RBetad Cm Delta
1 U1 18564.40 2792.45 80059.54 0.000 1.448 680.00 (N/A) 5018.30 0.671 0.830 1.013
Uz 14375.58 2792.45 80059.54 0.000 1.315 526.00 (N/R) 44%0.56 0.867 0.927 1.098
Factored Moments due to First-Order and Second-Order Effects:
Minimum eccentricity, Ex,min = 1.14 in
NOTE: Each loading combination includes the following cases:
First line - at column top
Second line - at column bottom
X-axis -—-----—-----—— lst Order --------=---—-  ———————— 2nd Order -------- - Ratic -
Load Mns Ms Mu Mmin Mi Mc Znd/1lst
Combo k-ft k-t k-t k-t k-ft k-ft
1 U1 70.40 0.00 70.40 64.60 Ml= 70.40 71.32 1.013
122.40 -0.00 122.40 64.60 M2= 122.40 124.00 1.013
102 48.40 80.00 128.40 49.97 Ml= 153.58 168.69 1.314
82.80 80.00 162.80 49.97 MZ= 187.98 206.47 1.268
Factored Loads and Moments with Corresponding Capacities:
Design/Required ratio PhiMn/Mu »= 1.00
NOTE: Each loading combination includes the fellowing cases:
First line - at column top
Second line - at column bottom
Load Pu Mux PhiMnx PhiMn/Mu NA depth Dt depth eps t Phi
No. Combo kip k-ft k-ft in in
1 1ul 660.00 71.32 311.55 4.368 12.43 15.49 0.00074 0.650
z 680.00 124.00 311.55 2.512 12.43 15.4% 0.00074 0Q.650
3 1 U2 526.00 168.69 344 .47 2.042 10.76 15.49 0.00132 0.650
4 526.00 206.47 344 .47 1.668 10.76 15.49 0.00132 0.650
**+% End of output ***
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Example 4 - Investigation of Concrete Shear Wall

Investigate the axial load and moment capacity of a shear wal

I”® for a given location of the neutral axis. Use

4-ksi concrete and 60-ksi reinforcing steel.

ﬂ 15in i‘k 144 in >i 15in %
Center

o h=12n ;
h=15in line Neu_tral
axis
— - X4— | —PX
A o .o. 0 ° ° ° ° ° :o. :
J’ o .. [ (] f [ [ L] () o ° o
G 0 0 0
) 10 10 o I~ o o) ~ o ) 100
xingzgg 9 R R T 238
N ~
PSR % 8 3 88 Bob
sty o N IS IS IS IS) IS s} o NN
®
o
__—18
T o
1 Fc=24in4

0.015 :
‘ Strain Diagram

From the Start Menu, go to All Programs | StructurePoint | spColumn and run Design Assistant®.

Design Assistant uses macros to export data to text files. If a macro warning is displayed when opening
Design Assistant, make sure macros are enabled in order for the exporting function to work properly.

Choose Example 4 Tab in the spreadsheet.
Input the data shown below:
e Under OVERALL SECTION WIDTH IN X, input 15.

e Under OVERALL SECTION HEIGHT IN Y, input 144,

e Under WEB WIDTH, input 12.

e  Under WEB HEIGHT, input 114.

e Under NUMBER OF BOUNDARY BARS IN X, input 3.

e Under NUMBER OF BOUNDARY BARS IN Y, input 3.

e Under NUMBER OF WEB BARS PER LAYER, input 8.

e Under WEB BAR SPACING, input 18.

e Under COVER, input 2.5.

e Under REINFORCEMENT AREA PER BOUNDARY BAR, input 0.79.

e Under REINFORCEMENT AREA PER WEB BAR, input 0.31.

™ Based on Example 4-4, pp 333, from Seismic and Wind Forces Structural Design Examples by Alan Williams, Third Edition, 2007,
International Code Council.

% Design Assistant is a Microsoft Excel spreadsheet that can be used to facilitate creation of spColumn text import files for a variety of
sections including dumbbell shaped and C-shaped shear walls.
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5.

6.

B2 Microsoft Excel - Templates
@_] File Edit Miew Insert Formak  Took Data  Window Help  Adobe PDF
NEEHRG0 e B i B 2 U
mEEg
- &
A | B | C [ o T e [ F [ & [ H T ] g [k [ T M M 0 [~
1 Input | Output |
| 2 | Mote: 1Nounits are used. Itis the user's respansibiity to maintain the cansistency of units.
3 2. D0 not delete or move output data cells. Otherwise the exported data might be incorrect.
4
5
3 Ouerall Sestion Widthin %] 15 Export Geometry Geometry Fisinfarcement
7 Ouerall Section Height in T 144 3 Eoundan| & eb 3 ¥
B Web width| 12 TR0 | 2000 [ 5000 | 6300 1 3500 | 63.000
3 Wb Height]  1i¢ {Export Reinforcems 7500 | 72000 2 5000 | 53500 3500 | 45000
in Humber of Boundam Barsin |3 7500 [0 57000 3 0000 | 63500 3 3500 | 27000
1t Humber of Boundar Barsin |3 " soo0 | s7o00 4 0000 | 53500 4 300 | a0m0
3 Humber of Web Bars per Layer| 8 8000 | 57.000 5 5000 | B3500 5 3500 | -a.000
” Web Bar Spacing] 18 7500 | 57.000 6 5000 | 9500 6 300 | -zro00
1 Couer| 285 7500 | 7zo00 7 5000 | 64500 7 3500 | -45.000
% | Reinforcement Ares per Boundsry Bar] 079 7500 | 72000 8 5000 | 64500 8 3500 | 63000
3 Fieinoreement Area per Web Bar] 041 7500 [ 57.000 9 5000 | 69500 9 2500 | 3000
[ 17 | " o000 | 57000 il 5000 | 53500 " 3500 | 45000
| 6000 | 57000 1t 0000 | 63500 1 3500 | z7.000
(19 | 7500 | 57000 12 0000 | 53500 © <3500 | 9000
|20 | 7500 | 72000 12 5000 | 69500 I 2500 | w000
21 | " 5000 | 53500 1 3500 | -27.000
Ea 15 5000 | 54500 5 3500 | -45.000
[ 23| 15 5000 | 64500 1 3500 | 52000
|24 | 7 ”
|25 | ] ®
26 | 19 ]
A 20 20
| 2a | a1 21
|23 | 2 22
| a0 | Fxd 2
ER 2 24
[ 92 | 25 25
3 E 25
=5 0 dz B4 36 B B s T2 7 4
| 35 | = 2
3 23 2
[ o7 | 0 0
B3 il a
= ] 2
|40 | Exl 33
a1 | ) a
4z | 35 5
42 ® * b
W 4 ¢ M Read Me Y Exampled J Examples f Exampled £ Example10 f Sxamph | < >
Ready

Press Export Geometry Button and Save Geometry File box appears. Save the file as Example4d-

Geo.txt

Save Geometry File

x| e®merE-

1

My Recent
Documents

F

Deskiop
My Documents

5

My Computer

Places

Savein: | |3 Examples

.‘:‘] File name |
-
My Network,  Save as upe: |Texl Files [*.tst]

El
=]

Save
Cancel

Press Export Reinforcement button and Save Reinforcement File dialog box appears. Save the file as

Example4-Reinf.txt
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5-23



sfcolumn

Save in |Lf) Examples ﬂ &% B
‘3 2] Exampled-Gea
My Recent
Documents
€
Deskiop

My Documents

My Computer
- File name: |Examp\e4ﬂe\nf j Save
My Network  Save as lype: |Text Files [* txt] j Cancal

Flaces

7. Save and close the Design Assistant spreadsheet.
8. From the Start Menu, go to All Programs | StructurePoint | spColumn and run spColumn
9. From the File menu, choose New. Any input data is cleared and the default values are restored.

10. From the File menu, choose Import | Import Data. Import Data (from text file) dialog box appears.
Make sure that Geometry radio button is checked, choose OK

Import Data {from text file)

™ Service loads
" Factored loads

LCancel

11. Open Import File box appears. Select Exampled-Geo.txt file and choose Open. The shear wall
geometry appears on the spColumn screen.

Open Import file ‘Elgl
Look in. [ Examples -l =« EBefE-
A E Exzample4-Geo
;3' 1) Example4-Rainf

My Recent
Documents

S

Desktop

\

My Documents

©

My Computer

My Network  File name: |Exampled-Geo =] Open
Places
Files of type [ Test Fles ") =] Cancel

12. From the File menu, choose Import | Import Data. Import Data (from text file) box appears. Press
Reinforcement radio button, then Choose OK

Import Data {from text file)

(
5

™ Factored loads
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13. Open Import File box appears. Select Example4-Reinf. txt file and choose Open. The shear wall
reinforcement appears on the spColumn screen as well.

Open Import file

D

My Recent
Documents
(€

Desktop

2

My Documents

My Computer
My Metwork
Places

L)

Look in: [ 15 Examples | c¥ EB-

PIX

File name: ‘Exampletl-F\e\nl

[

Files of lype: [ Test Files )

El

Open

Cancel

14. From the Input menu, choose General Information Tab

options in their default settings of ACI 318-14 design code. Choose OK

x4
— Label
Praject:
|spEOIumn Manual Example 4
Colurmn: Engineer:
Al Ex 4.4 5P
—Design Code
faci ;1814 =l
—Units————— ~ Run Option
& Englizh % |rwvestigation
" Metic ) Design
— Riur A
% About X-fxis " Biaxial
 About Y-Axis
Consider slendemess? ‘ez & Mo
ok LCancel |

. Input Project Information and leave all other

15. From the Input menu, choose the Material Properties tab. VERIFY CONCRETE STRENGTH, f¢’, and
REINFORCING STEEL STRENGTH, fy, values are entered as 4 ksi, and 60 ksi respectively. Leave all other
options in their default settings. Choose OK

x
— Concrete — Reinforcing Steel
Strength, f'o: |4— ksi Strength, fy: IBD— ki
¥ Standard ¥ Standard
Blastioty. Ee: [3605 kei | | Elestichy. Ex[25000  ksi
Max stress, fo: |34— ksi
Beta(1]: IDBE— Compression-controlled strain limit,
Ultirate strair: W Epz yt: lm
,TI LCancel |

16. From the Input menu, choose Reinforcement | Confinement Tab.
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17.

18.

19.

20.

21,

From the CONFINEMENT drop-down menu choose OTHER.
Input AXIAL COMPRESSION (a) as 0.85.

Input COMPRESSION CONTROLLED FAILURE (c) as 0.7.
Leave all other options in their default settings. Choose OK

Confinement E|

Canfinement: | Other -

Capacity R eduction Factors, Phi

Axial compression (a]: 0.85
Tenzsion-controlled failure [b): 059

Compreszion-controlled failure [c]: |07

Tie Sizes

#3 | ties with |#10 | bars or smaller.
H4 | ties with larger bars.

Lancel

From the Input menu, choose Loads | Axial Loads Tab.

Input 649.5 for the INITIAL LOAD. The initial axial load was selected
through trial and error procedure in order to match neutral axis depth
of 24 in. given in the example.

Choose INSERT. Then, choose OK

From the Solve menu, choose Execute.

Click No when the warning message is displayed saying
“Reinforcement ratio is less than 1%. Consider column as
architectural (i.e. fc is reduced by reinforcement ratio?)”.

The solver of the program is started and, upon completion, displays
the interaction diagram of the section.

From the View menu, choose Results.

Page through the results file.

Choose Exit to quit the spView program and get back to spColumn.

From the File menu, choose Print Results.

Select the printer to send the text results to.

Choose PRINT.

From the File menu, choose Print Screen.

Select the printer to send the graphical results to.

Choose PRINT

Initial load

Final load Increment

O C—

[kip] [kip] [kip]

Inzert |

| Mo

Modiy | Delete |

Initial Final Inz

ak. LCancel

Examples

5-26



sfeolumn

. o0
. e

15 x1441in

Code: ACI 318-14

Units: English

Run axis: About X-axis

Run option: Investigation
Slenderness: Not considered
Column type: Structural
Bars: ASTM A615

Date: 12/18/15

Time: 15:48:43

(Pmin)

-2000 -

spColumn v5.00. Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-23E97

Column: Alan Ex 4.4
f'c= 4 ksi

Ec = 3605 ksi

fo = 3.4 ksi

e u=0.003in/n
Beta1 =0.85

Confinement: Other

Project: spColumn Manual Example 4

fy =60 ksi
Es =29000 ksi
e_yt=0.00206897 in/in

phi(a) = 0.85, phib) = 0.9, phi(c) = 0.7

Engineer: SP
Ag = 1818 in"2
As =17.60in"2
Xo =-0.001in
Yo =0.00in

Min clear spacing = 1.31in

File: C:\Program Files (x86)\StructurePointispColumniExamples\Examples-ManualhExample04.col

32 bars

rho =0.97%

IX = 3.36209e+006 in*4
ly = 24853.5 in™4

Clear cover = N/A

Examples
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STRUCTUREPOINT - spCclumn v5.00 (TM) Page 2
Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-23E97 12/18/15
C:\Program Files (x86)\S8tructurePcinti\spColumniExamples\Examples-ManualiExampledd.col 03:48 PM
General Information:
File Name: C:\Program Files (x86)\S8tructurePoint\spColumn\Examples\Examples-Manual‘\Examplel4.col
Project: spColumn Manual Example 4
Column: Alan Ex 4.4 Engineer: SP
Code: ACT 318-14 Units: English
Run Option: Investigation Slenderness: Not considered
Run Axis: K-axis Column Type: Structural
Material Properties:
Concrete: Standard Steel: Standard
f'ec =4 ksi fy = 60 ksi
Ec = 3605 ksi Es = 29000 ksi
fc = 3.4 ksi Eps yt = 0.00206897 in/in
Eps_u = 0.003 in/in
Betal = 0.85
Section:
Exterior Points
No. X (in) Y {in) No. X (in) Y (in) No. X (in) Y (in
3 7.5 57.0
3] 7.5 -57.0
9 -7.5 -57.0
12 -7.5 57.0
Gross section area, Ag = 1818 in"2
Ix = 3.36209e+006 in~4 Iy = 24853.5 in"4
rg = 43.003% in ry = 3.6974 in
Xo = -0 in Yo = 0 in
Reinforcement:
Bar Set: ASTM A6l5
Size Diam {(in) Area {(in"2) Size Diam (in) Area (in"2) Size Diam (in) Area (in™2
# 3 0.38 0.11 # 4 0.50 0.20 # 5 0.63 0.31
# 6 0.75 0.44 # 7 0.88 0.60 # 8 1.00 0.79
# 9 1.13 1.00 # 10 1.27 1.27 # 11 1.41 1.56
# 14 1.69 2.25 # 18 2.26 4.00
Confinement: Other; #3 ties with #10 bars, #4 with larger hars.
phi{a) = 0.85, phi{(b} = 0.2, phi(c) = 0.7
Pattern: Irregular
Total steel area: As = 17.60 in"2 at rho = 0.97% (Note: rho < 1.0%
Minimum clear spacing = 1.31 in
Area in"2 ¥ (in) Y {in) Area in~2 X (in) ¥ (in) Area in~2 X (in) Y (in)
0.79 5.0 69.5 0.79 5.0 59.5 0.79 0.0 69.5
0.79 0.0 59.5 0.79 -5.0 69.5 0.79 -5.0 59.5
0.79 5.0 64.5 0.79 -5.0 64.5 0.79 5.0 -68.5
0.79 5.0 -59.5 0.79 0.0 -69.5 0.79 0.0 -58.5
0.79 -5.0 -69.5 0.79 -5.0 -59.5 0.79 5.0 -64.5
0.79 -5.0 -64.5 0.31 3.5 63.0 0.31 3.5 45.0
0.31 3.5 27.0 0.31 3.5 3.0 0.31 3.5 -54.0
0.31 3.5 -27.0 0.31 3.5 -45.0 0.31 3.5 -63.0
0.31 -3.5 63.0 0.31 -3.5 45.0 0.31 -3.5 27.0
0.31 -3.5 9.0 0.31 -3.5 -9.0 0.31 -3.5 -27.0
0.31 -3.5 -45.0 0.31 -3.5 -63.0
Axial Load and Corresponding Moment Capacities:
Load PhiPn PhiMnx NA depth Dt depth eps _t Phi
No kip k-ft in in
1 649.5 8395.14 24.00 141.50 0.01469 0Q.900
-8395.14 24.00 141.50 0.01469 0.900
**+ End of output ***
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Example 6 - Investigation of a Rectangular Short Column

Determine the adequacy of a 200 mm x 350 mm column® with 6-15M bars. Note that since the least column
dimension is less than 300mm, the maximum section axial design capacity is capped in CSA A23.3-14 as

required by clause 10.10.4.

The concrete used is 30 MPa and the reinforcing steel is 400 MPa.

The factored load values for the column under consideration are as follows:
P (kN) 500 kN
My (KN-m) 37.5 kN-m

From the File menu, choose New. Any input data is cleared and the default
values are restored.

1. Fromthe Input menu, choose General Information.
e Input the PROJECT header.

e Select METRIC units and CSA A23.3-14 code.

e Select About X-Axis for run axis, Investigation for run option and No
for Consider Slenderness?

e Choose OK.

2. From the Input menu, choose Material Properties.

e Input 30 for the CONCRETE STRENGTH, and 400 for the REINFORCING
STEEL STRENGTH. Other properties are computed and will be accepted.

e Choose OK.

From the Input menu, choose Section | Rectangular.
e Input 350 and 200 for the section width (along X) and depth (along Y).

e Choose OK.

Rectangular Section b4
“width [along ) |350  mm
Depth [alongY): (200 mm

ok | LCancel |

3. From the Input menu, choose Reinforcement | Sides Different.

General Information X

Labels
Project:

|spColumn tanual Example &

Calurmn: Engineer.

|Rect-2005350 5P

Design Code

|Csan23314 |
Unitz Fiun Option

" Endglish + |nvestigation
+ Metic " Design

Run Axiz

(+ About H-buis " Biaxial

" About ¥-hais
Consider slenderness?  Yes ™ No

LCancel

e Input 3-#15 bars for Top and BoTTOM and 0-#15 for LEFT and RIGHT. Input 50 in for the cover

and select LONGITUDINAL BARS.

e Choose OK.

8 Based on STRUCTUREPOINT Hand Verification Example based on CSA A23.3-14 Concrete Design Handbook

Examples
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4,

Sides Different *
Top Bottorm  Left Right
Mo, of bars: |3 |3 |E| |E|
Barsize:  [m15 ~| [m15 ~|[ms ~| [m5 ~]
Clear covver: |5IJ |5IJ |5EI |5E| mm
Cover to

" Transverse barz  * Longitudinal bars

0K | Cancel

From the Input menu, choose Loads | Factored.

e Input 500 forthe AXIAL LOAD, 37 .5 for the X-MOMENTS.
e Choose INSERT to add the entry to the list box.

e Choose OK.

Factored Loads bt
Load #-Moment M oment
500 |37.5 o
[kM) [kMrn) [kMm)

Inzert | Hodify | Delete |
| Mo, P I My
oK | LCancel

From the Solve menu, choose Execute.

e The solver of the program is started and, upon completion, displays the interaction diagram of the

section with the load point plotted within the diagram.

From the View menu, choose Results.
e Page through the results file.

e Choose FILE | EXIT to quit the spView program and get back to spColumn.

From the File menu, choose Print Results.

e Select the printer to send the text results to.
e Choose PRINT.

From the File menu, choose Print Screen.

e  Select the printer to send the graphical results to.

e Choose PRINT.

Examples

5-30



sfeolumn

(o} (1)) (o]
+x
(o} Q o]
350 x 200 mm

Code: CSA A23.3-14

Units: Metric \

P (kN)

2500 -

\ S /
\ N 4 )
Run axis: About X-axis S /
Run option: Investigation ‘\\
Slenderness: Not considered \‘\‘
| | * | | | | | | |
Column type: Structural ' ' R ‘ ‘ ‘ ‘ ‘ ‘
¥P -80 60
Bars: CSA G30.18 S . Mx ( kNm)
Date: 04/13/16 T e
Pmin e Pmin

Time: 17:41:04 (Pmin) -500 - (Pmin)

spColumnv5.10 - Apr 52016. Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-23E97

File: c:\program files (x86)\structurepoint\spcolumniexamples\examples-manualiexample08.col

Project: spColumn Manual Example 6

Column: Rect-200x350 Engineer: SP

f'c =30 MPa fy =400 MPa Ag = 70000 mm”"2 6 #15 bars

Ec = 26621 MPa Es =200000 MPa As =1200 mm”"2 rho =1.71%

fc = 24.15 MPa e_yt=0.002 mm/mm Xo =0mm Ix = 2.33e+008 mm~4

e_u=0.0035 mm/mm Yo =0mm ly = 7.15e+008 mm”"4

Beta1 = 0.895 Min clear spacing = 68 mm  Clear cover = 50 mm

Confinement: Tied

phi(a) = 0.8, phi(s) = 0.85, phi(c) = 0.6, phi(rho) = 1.00, Min. Dimension(h) = 200 mm
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STRUCTUREPOINT - spColumn v5.10 - BRpr 5 2016 (TM)
Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-23E97
ci\program files (xB86)\structurepointispcolumniexamplesiexamples-manual’examnple0s.col

General Information:
File Name: c:\program files (x86)\structurepoint\spcolumn)examples\examples-manuallexampledé.col
Project: spCeolumn Manual Example &

Column: Rect-200x350 Engineer: SP

Code: CSA A23.3-14 Units: Metric

Run Option: Investigation Slenderness: Not considered
Run Axis: X-axis Column Type: Structural

Material Propertie

Concrete: Standard Steel: Standard

f'e = 30 MPa fy = 400 MPa

Ec = Z6621.1 MPa Es = 200000 MPa
fc = 24.15 MPa Eps_yt = 0.002 mm/mm
Eps_u 0,003% mm/mm

Betal = 0.895

Section:

Rectangular: Width = 350 mm Depth = 200 mm

Gross section area, Ag = 70000 mm~2
Ix = 2.33333e+008 mm"4 Iy = 7.14583e+008 mm*4
rx = 57.735 mm ry = 101.036 mm
Xo = 0 mm Yo = 0 mm

Reinforcement:
Bar Set: CSA G30.18
Size Diam (mm) Area (mm*2) Size Diam (mm) Area (mm"2) Size Diam (mm) Area (mm"2)
# 10 11 100 # 15 16 200 # 20 20 300
# 25 25 500 # 30 30 700 # 35 36 1000
# 45 44 1500 # 55 56 2500

Confinement: Tied; #10 ties with #55 bars, #10 with larger bars.
phi{a) = 0.6, phi(s) = 0.85, phi{c) = 0.65, phi{rho) = 1.00, Min. Dimension(h) = 200 mm

Layout: Rectangular
Pattern: Sides Different (Cover to longitudinal reinforcement)
Total steel area: As = 1200 mm"2 at rho = 1.71%

Minimum clear spacing = 68 mm
Top Bottom Left Right
Bars 3 #15 3 #15 0 #l15 0 #15
Cover (mm) 50 50 50 50

Factored Loads and Moments with Corresponding Capacities:

PE MEx Mrx Mr/MEf NA depth Dt depth eps_s
No kN kNm ¥Nm mm m
1 500.00 37.50 39.25 1.047 101 142 0.00140

*** End of output ***

Page 2
04/13/1¢
05:40 PM
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Chapter 6

spSection Module

spSection is an add-on module to the spColumn program. It enables the user to investigate irregularly shaped
reinforced concrete sections subject to a combination of loadings. spSection considers a polygonal section
reinforced with bars located at any location. The section may contain one opening. In addition, spSection
allows easy modification of a circular section by converting it into an approximate polygon.

spSection is accessed from within spColumn. Once spColumn is started, you can activate spSection by
selecting the Section | Irregular command from the Input menu. This starts spSection, minimizes and locks
the spColumn window and maximizes the spSection window. The section geometry may then be defined by
drawing it on the screen or by inputting the coordinates of the polygon nodes. Once the section definition is
complete, return to spColumn by selecting Save and Exit from the Main menu.

Once the irregular section is defined, its reinforcement is input using spSection as well. This is done by
selecting the Reinforcement | Irregular command from the Input menu of spColumn. The section
reinforcement may also be defined graphically.

Main Menu

Drawing Area

Set the limits for the drawing area and control the grid and snap settings.

Save and Exit

Accept the input and/or modifications made in spSection and return to spColumn.

Exit without Saving

Discard the input and/or modifications made in spSection and return to spColumn.

Edit Menu

Section

Toggles the input/editing session to the section.

Opening

Toggles the input/editing session to the section opening.

Reinforcement

Add

Delete

Toggles the input/editing session to the section reinforcement.

Switches to the Add mode to graphically insert section or opening nodes or reinforcing bars.

Switches to the Delete mode to graphically delete section or opening nodes or reinforcing bars.




sfeolumn

Move
Switches to the Move mode to graphically move section or opening nodes or reinforcing bars.

Modify
Allows manual editing of the section or opening node coordinates or the reinforcing bar area and coordinates.

View Menu

Zoom
Magnifies or reduces the graphical image.

Pan
Translates or moves the graphical image.

Redraw
Redraws the displayed section and resets the Zoom and Pan actions.

Grid
Shows or hides the grid.

Snap
Toggles the Snap On and Off. With the SNAP ON, the cursor snaps (sticks) to exact locations.

Labels
Shows or hides the internal numbering of section (or opening) nodes and bars.

Status bar
Shows or hides the Status bar.

Help Menu

spSection Help
Lists all the available help topics about the program.

spColumn Manual Drawing Area 3
Opens spColumn Manual in the default PDF viewer. Limits

= N
Miirnurn: (B -50 in
M aximum: |50 50 in

About

Displays copyright information and the version humber of the program. =

x v
Defining the Drawing Area Step: 10 0 i
Iv Show Gid

e Select Main | Drawing Area. A dialog box appears. This step is not
needed the first time spSection is started wusing spColumn’s snap - y
Section | Irregular command. The box is automatically displayed. s [ F  in

e Input the limits (MINIMUM and MAXIMUM) of the area within which the ¥ Snap On
section is to be drawn in both directions.

¢ Input the interval (step) for the grid system. The grid is used as a guideline oK Cancel |
when drawing.

spSection Module 6-2
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Select or clear the SHow GRID option to show or hide the grid.

Input the interval (STEP) for the snhap. The snap settings may be different than the grid settings and may
be different in each direction (x and y).

Select or clear the SNAP ON option to activate or disable the Snap.
Choose the OK button.

Graphical Editing of the Section or Opening

In spSection, the section (or opening) must be a closed polygon. It is defined by inputting the nodes at each
corner or vertex of the polygon. No two segments (sides) may overlap or cross and no two nodes may
coincide. An opening must lie completely within the section.

The coordinates that correspond to the cursor location are always displayed in the Status bar. To force the
cursor to “stick” to exact locations, turn the SNAP option on. The program will snap to locations whose
coordinates are multiples of the snap steps.

To add section or opening nodes:

Switch the input session to Section (or Opening) by selecting Edit | Section (or Edit | Opening).
Switch the input mode to ADD by selecting Edit | Add.

If you are editing a section (or opening), you must first click on an existing node. Once this is done, you
can insert subsequent nodes.

Adding a node is done by moving the cursor to a desired location within the Graphics area and clicking
the left-mouse button.

After inserting a node, a line extending from the last added node follows the cursor. Click at another
location to insert subsequent nodes. A line connecting the two nodes is drawn.

To end the drawing, click the right-mouse button or press the ESC key. The first and last nodes are
connected to close the section. Also note that while in the ADD mode, moving the cursor outside the
Graphics area ends the drawing.

To delete section or opening nodes:

Switch the input session to Section (or Opening) by selecting Edit | Section (or Edit | Opening).
Switch the input mode to DELETE by selecting Edit | Delete.

Marquee select the node (or nodes) to be deleted. This is done by moving the cursor to one location,
pressing the left-mouse button and while holding the button down, moving to another location. While
moving, a dotted rectangle (called the marquee) is drawn. Releasing the left-mouse button end the
marquee. All nodes that are enclosed with the marquee are deleted and the section (or opening) is
redrawn. To cancel a marquee action while holding down the left-mouse button, press the ESC key or
click the right-mouse button. Also, leaving the Graphics area cancels the marquee operation.

To move section or opening nodes:

Switch the input session to Section (or Opening) by selecting Edit | Section (or Edit | Opening).
Switch the input mode to Move by selecting Edit | Move.

Place the cursor over the node to be moved then press and hold the left-mouse button. As long as the
button is held down, moving the cursor moves the selected node to the cursor location. Once the node is
at the new desired location, release the mouse button. To cancel a move action while holding down the
left-mouse button, press the ESC key or click the right-mouse button. Also, leaving the Graphics area
cancels the move operation.
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Graphical Editing of the Reinforcement

In spSection, the reinforcing bars may be located anywhere. The only restriction imposed in the program is
that no two bars may overlap. The coordinates that correspond to the cursor location are always displayed in
the Status bar. To force the cursor to “stick” to exact locations, turn the Snap option on. The program will
snap to locations whose coordinates are multiples of the snap steps. While in the Reinforcement session, you
cannot switch to the Section or Opening sessions without returning to spColumn. Therefore, the
Edit | Reinforcement command will have a check mark to its left. You use the command to specify the bar
size or area and the number of bars to be added.

To add one single bar at a time:

Switch the input mode to Add by selecting Edit | Add.

Select Reinforcement from the Edit menu. A dialog box appears. Mumber of bars:
In the Number of bars box, input 1. & Barsizer |WT ¥
" Bar area: l_ in

Choose the Size option and select the size of the bar or choose the Area
option and input the bar area in the edit box.

Choose the OK button.

0K | Cancel |

In the Graphics area, point to the desired location and click. A bar is inserted.

Repeat the step above to insert more bars.

To generate multiple bars:

Switch the input mode to Add by selecting Edit | Add. The command must have a check mark left of it.
Select Reinforcement from the Edit menu. A dialog box appears.
Input the number of bars to be generated (should be greater than 1).

Choose the Size option and select the size of the bar or choose the Area option and input the bar area in
the edit box.

Choose the OK button.

In the Graphics area, click at a location (let us call it point A), move the cursor to another location and
click (let us call it Point B). The specified number of equally-spaced bars is added, along the line
connecting the points A and B. For subsequent generations, point B becomes A and you only need to
click at the second point (B) to generate more bars.

To end the multiple bar generation or move to another location (without adding bars), click the right-
mouse button or press the ESC key. Also note that while in the multiple bar generation of the Add mode,
moving the cursor outside the Graphics area aborts the generation.

To delete bars:

Switch the input mode to DELETE by selecting Edit | Delete.

Marquee select the bar(s) to be deleted. This is done by moving the cursor to one location, pressing the
left-mouse button and while holding the button down, moving to another location. While moving, a
dotted rectangle (called the marquee) is drawn. Releasing the left-mouse button end the marquee. All
bars that are enclosed with the marquee are deleted. To cancel a marquee action while holding down the
left-mouse button, press the ESC key or click the right-mouse button. Also, leaving the Graphics area
cancels the marquee operation.

To move a bar:

Switch the input mode to Move by selecting Edit | Move.
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Manual Editing of the Section or Opening |

Place the cursor over the bar to be moved then press and hold the left-mouse button. As long as the

button is held down, moving the cursor moves the selected bar with it. Opening X
Once the bar is at the new desired location, release the mouse button. =
To cancel a move action while holding down the left-mouse button, woood [ in

press the ESC key or click the right-mouse button. Also, leaving the

Graphics area cancels the move operation. Y-coard: |15 in

Inzert | Modify | Delete

Switch the input session to Section (or Opening) by selecting
Edit | Section (or Edit | Opening).

Select Edit | Modify. A dialog box appears. If you have already
defined a section (or opening), the coordinates of its nodes are shown
in the list.

To add a node, enter its x and y coordinates and choose the INSERT
button. The entry is inserted in the list box following the selected ax | Cancel |
entry.

To edit an entry, select it from the list box, modify its values in the text boxes, and choose the MODIFY
button.

To delete an entry, choose it from the list box and choose the DELETE button.

e Choose the OK button. - EP— @]
Manual Editing of the Reinforcement s [ in°2
®-coord: |-45 in

Zooming and Panning the Image

Select Edit | Modify. A dialog box appears.

-coord: ,45— i
To edit an entry, select it from the list box, modify its values in the text
boxes, and choose the MoDIFY button. You can change the area of a nsat_|  odty | Delete
group of bars by selecting them from the list, enter the new area and | |

3 0B 10 10 ~
choose MODIFY. ione 1 1
. . 5 0B i] 20
To delete an entry, choose it from the list box and choose the DELETE E 0Ef a0 20
7 0B -0 30
button. Lone i e
9 0B 10 an

Choose the OK button.

Zooming is the enlargement or reduction of the graphical image. Panning is

0K LCancel

the translation or movement of the image.

Zooming:

Panning:

Select View | Zoom.

To enlarge the view (zoom-in): using the left-mouse button, click anywhere within the Graphics area.
Click again for further magnification.

To reduce the view (zoom-out): using the right-mouse button, click anywhere within the Graphics area.
Click again for further reduction.

To reset the Zoom and return to the default, select View | Redraw.

Select View | Pan.
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e Place the cursor over the Graphics area. Press the left-mouse button and, while still holding the button,
move the cursor in the direction you wish to pan. A line showing the amount and direction of panning is
drawn.

o Release the mouse button. The view is panned and the image is redrawn.
e Toreset the Pan and return to the default, select View | Redraw.

Keyboard shortcuts:
The following keyboard assignments are always active:

Key combination Action

Ctrl + Page Up Zoom-in

Ctrl + Page Down Zoom-out

Ctrl + Cursor key Pan

Enter Reset zoom/pan (Redraw)

Example 5 - Capacity of an Irregular Section

Compute horizontal moment capacity Mx of the unsymmetrical beam cross section® shown below. Use 3-ksi

concrete and 60-ksi reinforcing steel.
x

— Label
24" Project:

IspCqumn M arual Exarnple 5

"
4 Column: Enginesr:

$ |MacGregor4.? SP

24" — Design Code

|aci 31814 =l

(2)-#8 |
(1)_#9 ,,,,,‘ ° — Units

Run Option
Y : ' English ' |nvestigation
2.142"—» '4» 200" = Metic ) Desian

 Flun Axi

. "y
12 1 About Habais £ Biawial

7 Ahout iz

Consider slendemess?  Yes & Nao

Note: when instructed to move to a location (15, 25), move the cursor until the

cells in the Status bar show “x=15" and “y=25". oK | concel |
From the File menu, choose New. Any input data is cleared and the default
values are restored. X
. r— Concrete — Reinforcing Steel
1. From the Input menu, choose General Information. | SRS
. ) Strength, f'o: |3 %] Strength, fi: IED %]
e  Select English units and ACI 318-14 code.
¥ Standard v Standard
e Select BiaxiaL for RUN AXIS, Investigation for Elasticity, Ec: [37501 ksi | | Elasticity, Es:[25000 ksi
run option and NoO for CONSIDER SLENDERNESS. Man stess,fc: 285 ke
° Choose OK Beta(1]: 0.85 Compression-controlled strain limit,
) ) Ultirnate strain; (0003 Eps_yt: ID.DD2DBSS?
2. From the Input menu, choose Material Properties.

e Under CONCRETE, input 3 for the STRENGTH. Concel_|
Other properties are computed and will be
accepted.

8 Based on Example 4.7, pp 161 from Reinforced Concrete: Mechanics and Design by James G. Wight and James K. MacGregor, Fifth
Edition, 2009, Pearson Prentice Hall, Pearson Education Inc.
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+  Choose Ok, x
3. From the Input menu, choose Section | Irregular. The spSection module [ Limits ¥ v
is loaded, its window occupies the desktop, and the DRAWING AREA box Minmum: |40 40 in
appears.
e Under Limits, input 0 and 20 for the MINIMUM X and MINIMUM Y, | Masmum [0 T o T
respectively. “Grid

" ¥
e Under limits, input 24 and 4 for the MAXIMUM X and MAXIMUM Y, S ¢ J&  in

respectively.
¥ Show Grid

e Under GRID, input 4 and 4 for X and Y grid STEP, respectively and
check the SHow GRID option.

—Snap

ol ¥
. s |
e Under SNAP, input 4 and 4 for X and Y STEP, respectively and check | =™ "
the SNAP ON option. % SnepOn

Ok I LCancel |

e Choose OK.

4. The default input session is Section and the default input mode is Add
(the Edit | Section and Edit | Add options are checked).

¢ Inthe Graphics area, move the cursor to the location (0, 0) and click the left mouse button. A node is
inserted.

e Move to (12, 0) and click the left mouse button.
e Move to (12, -20) and click the left mouse button.
e Move to (24, -20) and click the left mouse button.
e Move to (24, 4) and click the left mouse button.

e Moveto (0, 4) and click the left mouse button.
Reinfarcement g|

Mumber of bars: ’1_

(+ Bar size: <

5. From the Main menu, choose Save and Exit. You are returned to spColumn and the | © Baraez [T in
section is shown in the Information bar.

6. From the Input menu, choose Reinforcement | Irregular. The spSection module is Lancel
loaded, its window occupies the desktop.

7. The default input session is Reinforcement and the default input mode is Add (the Edit | Reinforcement
and Edit | Add options are checked).

e Move to (0, 0) and click the left mouse button.

e  Click the right-mouse button to end drawing the section.

8. Define some bars using multiple bar generation: Reinforcement 3
e From the Edit menu, choose Reinforcement. Input 1 for the NUMBER OF | pea [i i
BARS and select #9 for the BAR Size. Choose OK. scomd: 14142 in
e Move the cursor to any location and click the left mouse button. ifersid | SR

e From the Edit menu, choose Modify. Input 14.142 for X-coorD and -17.5 nsett | Modiy | Delete
for Y-cooRrbp. Click MoDIFY and then OK. I

e From the Edit menu, choose Reinforcement. Input 1 for the NUMBER OF
BARS and select #8 from BAR size. Choose OK.

e Move the cursor to any location and click the left mouse button. A #8 bar is
generated at that location.

e  From the Edit menu choose Modify. Input 18 for X-CooRD and -17.5 for Y-

. 0K LC |
COORD. Click MoDIFY and then OK. —
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e From the Edit menu, choose Reinforcement. Input 1 for the NUMBER OF BARS and select #8 from
BAR sIzE. Choose OK.

e Move the cursor to any location and click the left mouse button. A #8 bar is generated at that
location.

e From the Edit menu choose Modify. Input 22 for X-coorD and -17.5 for Y-coorD. Click Modify
and then Ok

5P spSection Q@IE‘

Main Edit View Help

#=17.48in p=712in Zoomin: click left button, hold, diag, and release, Use right button to zoom out.

9.  From the Main menu, choose Save and Exit. You are returned to spColumn and the section is shown in
the Information bar.

10. From the Input menu, choose Input | Loads | .Factored

11. Enter LOAD as 0 (zero), X-MOMENT as -225 ft-kips and Y-MOMENT as 0.  |RGECICIREETE 3
12. From the Solve menu, choose Execute. Le=d Pt YAl
L . . . 0 2% 0
e A message is displayed saying “Reinforcement ratio is less than 1% |[kip] l[k_m l[k_m

Consider column as architectural (i.e. fc is reduced by reinforcement

. . - . Irnzert Modif Delet
ratio?)”. Click No for this option. et o | ot |

|N0. F b= by
e The solver of the program is started and, upon completion, displays
the interaction diagram of the section.

13. From the View menu, choose Results.
e Page through the results file.

e Choose Exit to quit the spView program and get back to spColumn.

14. From the File menu, choose Print Results.

e  Select the printer to send the text results to.
e Choose PRINT.

15. From the File menu, choose Print Screen.
e  Select the printer to send the graphical results to.

e Choose PRINT

e Change the interaction diagram to show the P-M diagram at 180° using the |4/ icon.
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24 x 241in

Code: ACI 318-14

Units: English

Run axis: Biaxial

Run option: Investigation
Slenderness: Not considered
Column type: Structural
Bars: ASTM AB15

Date: 12/18/15

Time: 15:49:37

400

My (k-ft)

Mx (k-ft)

P =0kip

400 1

|
1
400

spColumn v5.00. Licensed to: StructurePoint. License 1D: 00000-0000000-4-2A05D-23E97

Project: spColumn Manual Example 5

Column: MacGregord.7

Confinement: Tied
phi(a) = 0.8, phi(b) = 0.9, phi(c) =0.65

flc =3 ksi fy =860ksi

Ec = 3122 ksi Es =29000 ksi

fo =255 ksi e_yt = 0.00206897 infin
e Uu=0.003 infin

Beta1 =0.85

File: C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example05.col

Engineer: SP
Ag = 336 in"2
As =258in"2
Xo =16.29in
Yo =-6.57in

Min clear spacing =2.791in

3 bars

rho =0.77%

Ix = 18002.3 in"4
ly = 9956.56 in"4

Clear cover = N/A

spSection Module
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P (kip)
1200 +

24 % 24in 4

Code: ACI 318-14
Units: English N
Run axis: Biaxial

Run option: Investigation

Slenderness: Not considered

Column type: Structural | | |

T T T T (K T 1
e 350
Bars: ASTM A8615 s

] ~7" M (180°) (k-fi)
Date: 12/18/15 . E
(Pmin) (Pmin)
Time: 15:49:57 -200 —

spColumn v5.00. Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-23E97

File: C:\Program Files (x86)\StructurePoint\spColummExamples\Examples-Manual\Example05.col
Project: spColumn Manual Example 5

Column: MacGregord.7 Engineer: SP

f'c =3 ksi fy =60ksi Ag =336 in"2 3 bars

Ec = 3122 ksi Es =29000 ksi As =258in"2 rho =0.77%

fc = 2.55 ksi e_yt=0.00206897 infin  Xo =16.29in Ix =18002.3 in*4
e_u=0.003infin Yo =-6.57in ly = 9956.56 in*4
Beta1 =0.85

Min clear spacing=2.79in  Clear cover = N/A
Confinement: Tied

phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65
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STRUCTUREPOINT - spColumn v5.00 (TM) Page 2
Licensed to: StructurePeint. License ID: 00000-0000000-4-2R05D-23E97 12/18/15
C:\Program Files (x86¢)\sStructurePoint\spColumn\Examples\Examples-Manual\Example05.col 03:49 PM
General Information:
File Name: C:‘\Program Files (x86)\StructurePointispColumn’ExamplesiExamples-Mannal\Exampled5.col
Project: spColumn Manual Example 5
Column: MacGregor4.?7 Engineer: SP
Code: ACI 318-14 Units: English
Run Option: Investigation Slenderness: Not congidered
Run Axis: Biaxial Column Type: Structural
Material Properties:
Concrete: Standard Steel: Standard
f'c = 3 ksi £y = 60 ksi
Ec = 3122.02 ksi Es = 29000 ksi
fc = 2.55 ksi Eps_yt = 0.00206897 in/in
Eps_u = 0.003 in/in
Betal = 0.85
Section:
No. X (in) T (in) No. X (in) T (in) No. X (in) Y (in
1 0.0 0.0 2 12.0 a.0 3 12.0 -20.0
4 24.0 -20.0 5 24.0 4.0 6 a.0 4.0
Gross section area, RBRg = 336 in"2
Ix = 18002.3 in~4 Iy = 9956.56 in*4
rx = 7.31972 in ry = 5.44359 in
Xo = 16.2857 in Yo = -6.57143 in
Bar Se ASTM AglD
Size Diam (in) Area (in"2}) Size Diam (in} Area (in"2) Size Diam (in) Area (in"2
# 3 0.38 11 # 4 0.50 0.20 # 5 0.63 0.31
4 6 0.75 .44 7 0.88 0.60 # 8 1.00 0.79
409 1.13 00 # 10 1.27 1.27 # 11 1.41 1.56
4 14 1.69 25 # 18 2.26 4.00
Confinement: Tied; #3 ties with #10 bars, #4 with larger bars.
phifa) = 0.8, phi(b) 0.9, phi{c) = 0.65
Pattern: Irregular
Total gteel area: Az = 2.58 in"2 at rho = 0.77% (Note: rho <« 1.0%
Minimum clear spacing 2.79 in
Area in"2Z X (inm) Y (in) Area in"2 X {inm) Y {in) Area in~2 X (inm) Y (in)
1.00 14.1 -17.5 0.79 158.0 -17.5 0.79 22.0 -17.5
Factored Loads and Moments with Corresponding Capacities:
Pu Mux Muy PhiMnx PhiMny PhiMn/Mu NA depth Dt depth eps_t Phi
in
23.53 0.00685 0,900
# Section capacity exceeded. Revise design!
#** End of output ***
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Appendix

Import File Formats

Geometry, reinforcement or load data may be imported from a text file. The import file must be saved in pure
ASCII (text) format. Data fields on each line should be separated by spaces or TABs. Comments or blank
lines should not be placed within the import file.

Service Loads Data:
No Of Load Points
P1 D Mlx DT Mlx DB Mly DB Mly DB
Pl L Mlx LT Mlx LB Mly LT Mly LB
Pl W Mlx WT Mlx WB Mly WT Mly WB
Pl EQ Mlx EQT Mlx EQB Mly EQT Mly EOB
Pl S Mlx ST Mlx SB Mly ST Mly SB

Pn D Mnx DT Mnx DB Mny DB Mny DB
Pn L Mnx LT Mnx LB Mny LT Mny LB
Pn W Mnx WT Mnx WB Mny WT Mny WB
Pn EQ Mnx EQT Mnx EQB Mny EQT Mny EQB
Pn S Mnx ST Mnx SB Mny ST Mny SB

Each service load point has five lines of data (one line for each load case, i.e. Dead, Live, Wind, Earthquake,
and Snow). Each data line has five values. For a service load point i, Pi D, Mix DT, Mix DB, Miy DT,
and Miy DB are the axial load, M, at top, My at bottom, M, at top and M, at bottom, respectively. The
notation D, L, W, EQ, and S designate the Dead, Live, Wind, Earthquake, and Snhow load cases,
respectively.

Factored Loads Data:

No Of Load Points
Pl Mlx Mly
P2 M2x M2y

Pn Mnx Mny

For a factored load point i, P1i is the factored axial load, Mix is the factored moment about x and Miy is the
factored moment about y.

Reinforcement Data:

No Of Bars
Al X1 Y1

An Xn Yn
For abar i, A1 isthe bar area, X1 is its x-coordinate, and Y1 is its y-coordinate.

Geometry Data:
No Of Section Nodes
Xsl Ysl
Xs2 Ys2
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Xsn Ysn
No Of Opening Nodes
Xol Yol
Xo2 Yoz

Xon Yon
For a section node s1i, Xsi is the x-coordinate of the node and Ys1i is its y-coordinate.

For an opening node oi, Xo1i is the x-coordinate of the node and Yo1 is its y-coordinate.

If the section does not contain an opening, you must have a zero for the value of No_ Of Opening Nodes.
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spColumn Text Input (CTI) file format

spColumn is able to read and save its input data into two file formats, COL file or CTI file. CTI files are plain
text files that can be edited by any text editing software.

Caution must be used when editing a CTI file because some values may be interrelated. If one of these values
is changed, then other interrelated values should be changed accordingly. While this is done automatically
when a model is edited in the spColumn user graphic user interface (GUI), one must update all the related
values in a CTI file manually in order to obtain correct results. For example, if units are changed from
English to Metric in GUI, all the related input values are updated automatically. If this is done by editing a
CTI file, however, not only the unit flag but also all the related input values must be updated manually.

The best way to create a CTI file is by using the spColumn GUI and selecting CTI file type in the Save As
menu command. Then, any necessary modifications to the CTI file can be applied with any text editor.
However, it is recommended that users always verify modified CTI files by loading them in the spColumn
GUI to ensure that the modifications are correct before running manually revised CTI files in batch mode.

The CTI file is organized by sections. Each section contains a title in square brackets, followed by values
required by the section. The CTI file contains the following sections.

[spColumn Version]
[Project]

[Column ID]
[Engineer]
[Investigation Run Flag]
[Design Run Flag]
[Slenderness Flag]
[User Options]
[Irregular Options]
[Ties]
[Investigation Reinforcement]
[Design Reinforcement]
[Investigation Section Dimensions]
[Design Section Dimensions]
[Material Properties]
[Reduction Factors]
[Design Criteria]
[External Points]

[Internal Points]

[Reinforcement Bars]

[Factored Loads]

[Slenderness: Column]

[Slenderness: Column Above And Below]
[Slenderness: Beams]

[ET]

[S1dOptFact]

[Phi Delta]

[Cracked I]

[Service Loads]

[Load Combinations]

[BarGroupType]

[User Defined Bars]

[Sustained Load Factors]

Each section of a CTI file and allowable values of each parameter are described in details below.
Corresponding GUI commands are presented in parenthesis.

#spColumn Text Input (CTI) File
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The number sign, #, at the beginning of a line of text indicates that the line of text is a comment. The # sign
must be located at the beginning of a line. Comments may be added anywhere necessary in a CTl file to make
the file more readable. If a comment appears in multiple lines, each line must be started with a # sign.

[spColumn Version]
Reserved. Do not edit.

[Project]
There is one line of text in this section.

Project name (menu Input | General Information...)

[Column ID]
There is one line of text in this section.

Column ID (menu Input | General Information...)

[Engineer]
There is one line of text in this section.

Engineer name (Menu Input | General Information...)

[Investigation Run Flag]
Reserved. Do not edit.

[Design Run Flag]
Reserved. Do not edit.

[Slenderness Flag]
Reserved. Do not edit.

[User Options]

There are 26 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right.

1.
2.
3.

2

©®

10.

11.

12.

13.

0-Investigation Mode; 1-Design Mode; (Run Option on menu Input | General Information...)

0-English Unit; 1-Metric Units; (Units on menu Input | General Information...)

0-ACI 318-02; 1- CSA A23.3-94; 2-ACl 318-05; 3-CSA A23.3-04; 4-ACl 318-08; 5-ACI 318-11; 6-
ACI 318-14; 7-CSA A23.3-14 (Design Code on menu Input | General Information...)

0-X Axis Run; 1-Y Axis Run; 2-Biaxial Run; (Run Axis on menu Input | General Information...)
Reserved. Do not edit.

0-Slenderness is not considered; 1-Slenderness in considered; (Consider slenderness? on menu Input |
General Information...)

0-Design for minimum number of bars; 1-Design for minimum area of reinforcement; (Bar selection
on menu Input | Reinforcement | Design Criteria...)

Reserved. Do not edit.

0-Rectangular Column Section; 1-Circular Column Section; 2-Irregular Column Section; (menu Input |
Section)

0-Rectangular reinforcing bar layout; 1-Circular reinforcing bar layout; (Bar Layout on menu Input |
Reinforcement | All Sides Equal)

0-Structural Column Section; 1-Architectural Column Section; 2-User Defined Column Section;
(Column Type on menu Input | Reinforcement | Design Criteria...)

0-Tied Confinement; 1-Spiral Confinement; 2-Other Confinement; (Confinement drop-down list on
menu Input | Reinforcement | Confinement...)

Load type for investigation mode: (menu Input | Loads)

Appendix



sfeolumn

0-Factored; 1-Service; 2-Control Points; 3-Axial Loads
14.  Load type for design mode: (menu Input | Loads)
0-Factored; 1-Service; 2-Control Points; 3-Axial Loads
15.  Reinforcement layout for investigation mode: (menu Input | Reinforcement)
0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern
16.  Reinforcement layout for design mode: (menu Input | Reinforcement)
0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern
17.  Reserved. Do not edit.
18.  Number of factored loads (menu Input | Loads | Factored...)
19.  Number of service loads (menu Input | Loads | Service...)
20.  Number of points on exterior column section
21.  Number of points on interior section opening
22.  Reserved. Do not edit.
23.  Reserved. Do not edit.
24.  Cover type for investigation mode: (menu Input | Reinforcement)
0-To transverse bar; 1-To longitudinal bar
25.  Cover type for design mode: (menu Input | Reinforcement)
0-To transverse bar; 1-To longitudinal bar
26.  Number of load combinations; (menu Input | Load | Load Combinations...)

[Irregular Options]

There are 13 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right. (menu Input | Section | Irregular | Section Editor menu Main | Drawing
Area)

1 Reserved. Do not edit.

2 Reserved. Do not edit.

3 Reserved. Do not edit.

4, Reserved. Do not edit.

5. Avrea of reinforcing bar that is to be added through irregular section editor
6 Maximum X value of drawing area of irregular section editor
7 Maximum Y value of drawing area of irregular section editor
8 Minimum X value of drawing area of irregular section editor
9. Minimum Y value of drawing area of irregular section editor
10.  Grid step in X of irregular section editor

11.  Grid step in Y of irregular section editor

12.  Grid snap step in X of irregular section editor

13.  Grid snap step in Y of irregular section editor

[Ties]

There are 3 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right. (Menu Input | Reinforcement | Confinement...)

1. Index (0 based) of tie bars for longitudinal bars smaller that the one specified in the 3" item in this
section in the drop-down list

2. Index (0 based) of tie bars for longitudinal bars bigger that the one specified in the 3" item in this
section in the drop-down list

3. Index (0 based) of longitudinal bar in the drop-down list

[Investigation Reinforcement]

This section applies to investigation mode only. There are 12 values separated by commas in one line in this
section. These values are described below in the order they appear from left to right.

If Side Different (Menu Input | Reinforcement | Side Different...) is selected:

1. Number of top bars
2. Number of bottom bars
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Number of left bars

Number of right bars

Index (0 based) of top bars (Top Bar Size drop-download list)

Index (0 based) of bottom bars (Bottom Bar Size drop-download list)
Index (0 based) of left bars (Left Bar Size drop-download list)

Index (0 based) of right bars (Right Bar Size drop-download list)
Clear cover to top bars

Clear cover to bottom bars

Clear cover to left bars

Clear cover to right bars

If All Sides Equal (Menu Input | Reinforcement | All Sides Equal...) or Equal Spacing (Menu Input |
Reinforcement | Equal Spacing...) is selected:

COoNoOR~WNE

10.
11.
12.

Number of bars (No. of Bars text box)
Reserved. Do not edit.

Reserved. Do not edit.

Reserved. Do not edit.

Index (0 based) of bar (Bar Size drop-down list)
Reserved. Do not edit.

Reserved. Do not edit.

Reserved. Do not edit.

Clear cover to bar (Clear Cover text box)
Reserved. Do not edit.

Reserved. Do not edit.

Reserved. Do not edit.

If Irregular Pattern (Menu Input | Reinforcement | Irregular Pattern...) is selected:

Reserved. Do not edit.

[Design Reinforcement]

This section applies to design mode only. There are 12 values separated by commas in one line in this section.
These values are described below in the order they appear from left to right.

If Side Different (Menu Input | Reinforcement | Side Different...) is selected:

N~ WNE

10.
11.
12.

Minimum number of top and bottom bars

Maximum number of top and bottom bars

Minimum number of left and right bars

Maximum number of left and right bars

Index (0 based) of minimum size for top and bottom bars
Index (0 based) of maximum size for top and bottom bars
Index (0 based) of minimum size for left and right bars
Index (0 based) of maximum size for left and right bars
Clear cover to top and bottom bars

Reserved. Do not edit.

Clear cover to left and right bars

Reserved. Do not edit.

If All Sides Equal (Menu Input | Reinforcement | All Sides Equal...) or Equal Spacing (Menu Input |
Reinforcement | Equal Spacing...) is selected:

ouhkrwNPE

Minimum number of bars

maximum number of bars

Reserved. Do not edit.

Reserved. Do not edit.

Index (0 based) of minimum size of bars
Index (0 based) of maximum size of bars
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Reserved. Do not edit.
Reserved. Do not edit.
9. Clear cover

10. Reserved. Do not edit.
11. Reserved. Do not edit.
12. Reserved. Do not edit.

[Investigation Section Dimensions]

This section applies to investigation mode only. There are 2 values separated by commas in one line in this
section. These values are described below in the order they appear from left to right.

If rectangular section (Menu Input | Section | Rectangular...) is selected:

1. Section width (along X)
2. Section depth (along Y)

If circular section (Menu Input | Section | Circular...) is selected:

1. Section diameter
2. Reserved. Do not edit.

If irregular section (Menu Input | Section | Irregular) is selected:

1. Reserved. Do not edit.
2. Reserved. Do not edit.

[Design Section Dimensions]

This section applies to design mode only. There are 6 values separated by commas in one line in this section.
These values are described below in the order they appear from left to right.

If rectangular section (Menu Input | Section | Rectangular...) is selected:

Section width (along X) Start
Section depth (along Y) Start
Section width (along X) End
Section depth (along Y) End
Section width (along X) Increment
Section depth (along Y) Increment

ok wnpP

If circular section (Menu Input | Section | Circular...) is selected:

Diameter start

Reserved. Do not change.
Diameter end

Reserved. Do not change.
Diameter increment
Reserved. Do not change.

oukwnE

[Material Properties]

There are 11 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right. (Menu Input | Material Properties...)

Concrete strength, f’c

Concrete modulus of elasticity, Ec
Concrete maximum stress, fc
Beta(1) for concrete stress block
Concrete ultimate strain

Steel yield strength, fy

Steel modulus of elasticity, Es
Reserved. Do not edit.

N~ E
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9. Standard material for concrete
0-Non-standard; 1-Standard

10.  Standard material for reinforcing steel
0-Non-standard; 1-Standard

11.  Compression-controlled strain limit

[Reduction Factors]

There are 5 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right. (Menu Input | Reinforcement | Confinement...)

Phi(a) for axial compression

Phi(b) for tension-controlled failure

Phi(c) for compression-controlled failure

Reserved. Do not edit

Minimum dimension of tied irregular sections for CSA-A23.3-14; 0-for all other cases

aprwhRE

[Design Criteria]l

There are 4 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right. (Menu Input | Reinforcement | Design Criteria...)

1. Minimum reinforcement ratio

2 Maximum reinforcement ratio

3. Minimum clear spacing between bars
4 Design/Required ratio

[External Points]

This section applies to irregular section in investigation mode only. The first line contains the number of
points on exterior section perimeter. Each of the following lines contains 2 values of X and Y coordinates
(separated by comma) of a point.

Number of Points, n
Point 1 X, Point 1 Y
Point 2 X, Point 2 Y

Point n X, Point n Y

[Internal Points]

This section applies to irregular section in investigation mode only. The first line contains the number of
points on an interior opening perimeter. Each of the following lines contains 2 values of X and Y coordinates
(separated by comma) of a point. If no opening exists, then the first line must be 0.

Number of Points, n
Point 1 X, Point 1 Y
Point 2 X, Point 2 Y

Point n X, Point n Y

[Reinforcement Bars]

This section applies to irregular section in investigation mode only. The first line contains the number of
reinforcing bars. Each of the following lines contains 3 values of area, X and Y coordinates (separated by
comma) of a bar.

Number of bars, n
Bar 1 area, Bar 1 X, Bar 1 Y
Bar 2 area, Bar 2 X, Bar 2 Y

Appendix A-8



sfeolumn

Bar n area, Bar n X, Bar n Y

[Factored Loads]

The first line contains the number of factored loads defined. Each of the following lines contains 3 values of
axial load, X-moment, and Y-moment separated by commas. (Menu Input | Loads | Factored Loads...)

Number of Factored Loads, n
Load 1, X-Moment 1, Y-Moment 1
Load 2, X-Moment 2, Y-Moment 2

Load n, X-Moment n, Y-Moment n

[Slenderness: Column]

This section contains 2 lines describing slenderness parameters for column being designed. The first line is
for X-axis parameters, and the second line is for Y-axis parameters.

There are 8 values® separated by commas in each line. These values are described below in the order they
appear from left to right. (Menu Input | Slenderness | Design Column...)

Column clear height

k(nonsway)

k(sway)

0-Sway frame; 1-Nonsway frame

0-Compute ‘k’ factors; 1-Input k factors

(ZPY/P,

(ZPY)/P,

0-Do not ignore moment magnification along column length in sway frames; 1-lgnore moment
magnification along column length in sway frames. Use for ACI 318-11 and ACI 318-08 only. For all
other codes the value must be 0.

NN E

[Slenderness: Column Above And Below]

This section contains 2 lines describing slenderness parameters for column above and column below. The first
line is for column above, and the second line is for column below. (Menu Input | Slenderness | Columns
Above/Below...)

There are 6 values separated by commas in line 1 for column above. These values are described below in the
order they appear from left to right.

0-Column specified; 1-No column specified
Column Height

Column width (along X)

Column depth (along Y)

Concrete compressive strength, f’c
Concrete modulus of elasticity, Ec

ourwNE

There are 6 values separated by commas in line 2 for column below. These values are described below in the
order they appear from left to right.

0-Column specified; 1-No column specified
Column Height

Column width (along X)

Column depth (along Y)

Concrete compressive strength, f’c
Concrete modulus of elasticity, Ec

ok whpE

8 Value No 8 introduced in spColumn v4.60.
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[Slenderness: Beams]
This section contains 8 lines. Each line describes a beam.

Line 1: X-Beam (perpendicular to X), Above Left
Line 2: X-Beam (perpendicular to X), Above Right
Line 3: X-Beam (perpendicular to X), Below Left
Line 4: X-Beam (perpendicular to X), Below Right
Line 5: Y-Beam (perpendicular to Y), Above Left
Line 6: Y-Beam (perpendicular to Y), Above Right
Line 7: Y-Beam (perpendicular to Y), Below Left
Line 8: Y-Beam (perpendicular to Y), Below Right

There are 7 values separated by commas for each beam in each line. (Menu Input | Slenderness | X-Beams...,
Input | Slenderness | Y-Beams...) These values are described below in the order they appear from left to right.

0-beam specified; 1-no beam specified
Beam span length (c/c)

Beam width

Beam depth

Beam section moment of inertia
Concrete compressive strength, fc
Concrete modulus of elasticity, Ec

Noak~kwpnpE

[EI]
Reserved. Do not edit.

[S1dOptFact]
There is 1 value in this section for slenderness factors. (Code Default and User Defined radio buttons on
menu Input | Slenderness | factors...)

0-Code default; 1-User defined

[Phi Deltal]

There is 1 value in this section for slenderness factors. (Menu Input | Slenderness | factors...)
Stiffness reduction factor

[Cracked TI]
There are 2 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right. (Menu Input |

Slenderness | factors...)

1. Beam cracked section coefficient
2. Column cracked section coefficient

[Service Loads]

This section describes defined service loads. (Menu Input | Loads | Service...) The first line contains the
number of service loads. Each of the following lines contains values for one service load.

There are 25 values for each service load in one Line separated by commas. These values are described below
in the order they appear from left to right.

Dead Axial Load

Dead X-moment at top
Dead X-moment at bottom
Dead Y-moment at top
Dead Y-moment at bottom
Live Axial Load

ook wNE
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7. Live X-moment at top
8. Live X-moment at bottom
9 Live Y-moment at top

10. Live Y-moment at bottom
11.  Wind Axial Load

12.  Wind X-moment at top

13.  Wind X-moment at bottom
14.  Wind Y-moment at top

15. Wind Y-moment at bottom
16. EQ. Axial Load

17. EQ. X-moment at top

18. EQ. X-moment at bottom
19.  EQ. Y-moment at top

20. EQ. Y-moment at bottom
21.  Snow Axial Load

22.  Snow X-moment at top

23.  Snow X-moment at bottom
24.  Snow Y-moment at top

25.  Snow Y-moment at bottom

[Load Combinations]

This section describes defined load combinations. (Menu Input | Loads | Load Combinations...) The first line
contains the number of load combinations. Each of the following lines contains load factors for one load
combination.

Number of load combinations, n

Dead 1, Live 1, Wind 1, E.Q. 1, Snow 1
Dead 2, Live 2, Wind 2, E.Q. 2, Snow_ 2

Dead n, Live n, Wind n, E.Q. n, Snow n

[BarGroupType]
There is 1 value in this section. (Bar Set drop-down list on menu Options | Reinforcement...)

0-User defined
1-ASTM615

2-CSA G30.18
3-prEN 10080
4-ASTM615M

[User Defined Bars]

This section contains user-defined reinforcing bars. (Menu Options | Reinforcement...) The first line contains
the number of defined bars. Each of the following lines contains values for one bar separated by commas.
Number of user-defined bars, n

Bar 1 size, Bar 1 diameter, Bar 1 area, Bar 1 weight

Bar 2 size, Bar 2 diameter, Bar 2 area, Bar 2 weight

Bar n size, Bar n diameter, Bar n area, Bar n weight

[Sustained Load Factors]
There are 5 values separated by commas in one line in this section. Each value respectively represents

percentage of Dead, Live, Wind, EQ, and Snow load case that is considered sustained (Menu Input | Loads |
Service...).
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Conversion Factors - English to Sl

To convert from To Multiply by
in. m (1000 mm) 0.025400
ft m 0.304800
Ib N (0.001 kN) 4.448222
kip (1000 Ibs) kN 4.448222
pIf (Ib/ft) N/m 14.593904
psi (Ib/in.?) kPa 6.894757
ksi (kips/in.”) MPa 6.894757
psf (Ib/ft?) N/m? (Pa) 47.88026
pef (Ib/ft) kg/m’ 16.018460
ft-kips kN +m 1.355818
Conversion Factors - Sl to English.
To convert from To Multiply by
m (1000 mm) in 39.37008
m ft 3.28084
N (0.001 kN) Ib 0.224809
kN kip (1000 Ibs) 0.224809
kN/m pIf (Ib/ft) 68.52601
MPa psi (Ib/in%) 145.0377
MPa ksi (kips/in®) 0.145038
kN/m* (kPa) psf (Ib/ft?) 20.88555
kg/m’ pef (Ib/ft) 0.062428
kN «m ft-kips 0.737562
Material Strength Value Limits
ACI Standard Material Non-Standard Material
Min. Max. Min. Max.
f'c 2 ksi 12 ksi 2 ksi 20 ksi
fy 10 ksi 80 ksi 10 ksi 270 ksi
CSA Standard Material Non-Standard Material
Min. Max. Min. Max.
fc 10 MPa 80 MPa 10 MPa 150 MPa
fy 100 MPa 500 MPa 100 MPa 1860 MPa
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Contact Information
Web Site: http://www.StructurePoint.org
E-mail: info@StructurePoint.org

support@StructurePoint.org

StructurePoint, LLC.

5420 Old Orchard Road
Skokie, IL 60077
USA

Phone: (847) 966-4357

Fax: (847) 966-1542
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